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1.0  OBJECTIVES
After reading this Chapter, you will be able to:

• Understand the information technology;
• History of Computer;
• Definition of information technology;
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• Significance of information technology in education.

1.1   INTRODUCTION
     Technology has been defined as “systematic knowledge and action, usually of industrial processes but
applicable to any recurrent activity”. In providing tools and techniques for action, technology at once adds to
and draws from a knowledge base in which theory and practice interact and compact. At its most general
level technology may be regarded as definable specifiable way of doing anything. In other words, we may say
a technology is a codified, communicable procedure for solving problems. Technology, Manfred Kochen
observed, impacts in three stages. First, it enables us to do what we are now doing, but better, faster and
cheaper; second, it enables us to do what we cannot do now; and third, it changes our life styles.

Information technology is a recent and comprehensive term, which describes the whole range of
processes for generation, storage, transmission, retrieval and processing of information. An attempt is made
to discuss the components of information technology and to identify elements that really matter the investigation
and implementation of new information technologies in information systems and services.

1.1.1 Concepts of Information Technology
The term “Information technology” in English is derived from the French word “Informatique” and

“Informatika” in Russian encompasses the notation of information handling. IT is a new science of
collecting, storing, processing and transmitting information.

The word “Information Technology” is a combination of two words. One is information and other is
technology. Information means knowledge, it can be a Bit or a Para or a Page. Technology is science of
information handling, particularly using computers to support the communication of knowledge in technical,
economic and social fields.

Information technology is a generic term that covers the acquisition, processing, storage and
dissemination of information. It involves the application of computers and communication technology in the
task of information handling and information flow from the generation to the utilization levels. It is restricted to
systems dependent on microelectronics based combination of computers and telecommunication technologies.

1.2    Historical Development
Information technology as a technical support for human thinking and communication, has been

evolving aver thousands of years. New developments have been rapid over the last few decades. It is only
recently that the term has been used as a collection term for the whole spectrum of technologies providing the
ways and means to acquire, store, transmit, retrieve and process information.

According Manfred Kochen, any technology develops in three stages “In the first stage, technology
enables us to do things, that we have been doing, but to do them better, cheaper and faster. In the second
stage, technology provides new capabilities and enables us to do things that we had not been able to do
previously. An in the third stage technology becomes an integral part of our activities, if affects the way we do
things and changes our life style”.Development in computer and communication technology has brought a
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new dimension to the program of information handling. The introduction of microprocessor and microcomputers
has made things easier. All these developments facilitate better and quicker services to the library user.

1.3  Definition of IT
Information technology is new technology to apply to the creation, storage, selection, transformation

and distribution of information of many kinds. The British department of industry considers information
technology as science of handling, particularly computers, used to support the communication of knowledge
in technical, economical, and social fields. It is defined as “The acquisition, processing, storage and dissemination
of vocal, pictorial, textual and numerical information by microelectronics based combination of computing
and telecommunication”.

The term ‘Information Technology’ (IT) has varying interpretations. Macmillan Dictionary of
Information Technology defines IT as “the acquisition, processing, storage and dissemination of vocal, pictorial,
textual and numerical information by a micro-electronics-based combination of computing and
telecommunications”. Two points are worth consideration about this definition:

• The new information technology is seen as involving the formulating, recording and processing and
not just transmitting of, information. These are elements in the communication process which can be
separated (both analytically and in practice) but in the context of human communication they tend to
be intertwined.

• Modem information technology deals with a wide variety of ways of representing information. It
covers not only the textual (i.e., cognitive, propositional and verbalised forms, we often think under
the head information), but also numerical, visual, and auditory representations.

UNESCO defines Information Technology as “scientific, technological and engineering disciplines and the
management techniques used in information handling and processing information, their applications; computers
and their interaction with man and machine and associated social, economic and cultural matters” (Stokes).

According to ALA Glossary:-Information Technology (IT) is the application of computers and other
technology to the acquisition, organization, storage, retrieval & dissemination of information.
Information Technology (IT) as defined by the information technology-Association of America (ITAA) is
“the study design, development, implementation, support or management of computer-based information
systems, particularly software applications and computer hardware. It deals with the use of electronic computers
and computer software to convert, store, protect process, transmit, and retrieve information”.

1.4  Need and Importance of Information Technology Need
Education is a lifelong process therefore anytime anywhere access to it is the need 
Information explosion is an ever increasing phenomena therefore there is need to get access to
this information

Education should meet the needs of variety of learners and therefore IT is important in meeting this
need
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It is a requirement of the society that the individuals should possess technological literacy
We need to increase access and bring down the cost of education to meet the challenges of illiteracy
and poverty-IT is the answer for this

     Importance

Access to variety of learning resources
Immediacy to information
Anytime learning
Anywhere learning
Collaborative learning
Multimedia approach to education
Authentic and up to date information
Access to online libraries
Teaching of different subjects made interesting
Educational data storage
Distance education
Access to the source of information
Multiple communication channels-e-mail, chat, forum, blogs etc.
Access to open courseware
Better accesses to children with disabilities
Reduces time on many routine tasks

1.5  Information Technology in Education

Information Technology in Education, effects of the continuing developments in information technology
(IT) on education. The pace of change brought about by new technologies has had a significant effect on the
way people live, work, and play worldwide. New and emerging technologies challenge the traditional process
of teaching and learning, and the way education is managed. Information technology, while an important area
of study in its own right, is having a major impact across all curriculum areas. Easy worldwide communication
provides instant access to a vast array of data, challenging assimilation and assessment skills. Rapid
communication, plus increased access to IT in the home, at work, and in educational establishments, could
mean that learning becomes a truly lifelong activity an activity in which the pace of technological change forces
constant evaluation of the learning process itself.

1.6  Significance of  IT in Education

1.6.1 Access to variety of learning resources
In the era of technology. IT aids plenty of resources to enhance the teaching skills and learning ability.

With the help of IT now it is easy to provide audio visual education. The learning resources are being widened
and widened. Now with this vivid and vast technique as part of the IT curriculum, learners are encouraged to
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regard computers as tools to be used in all aspects of their studies. In particular, they need to make use of the
new multimedia technologies to communicate ideas, describe projects, and order information in their work.

1.6.2 Immediacy to information
IT has provided immediacy to education. Now in the year of computers and web networks the pace

of imparting knowledge is extremely fast and one can be educated anywhere at any time. New IT has often
been introduced into well-established patterns of working and living without radically altering them. For
example, the traditional office, with secretaries working at keyboards and notes being written on paper and
manually exchanged, has remained remarkably stable, even if personal computers have replaced typewriters.

1.6.3 Any time learning
Now in the year of computers and web networks, the pace of imparting knowledge is very  fast and

one can be educated .One can study whenever he wills irrespective of whether it is day or night and irrespective
of being in India or in US because of the boom in IT.

1.6.4 Collaborative learning
Now IT has made it easy to study as well as teach in groups or in clusters.Online we can be united

together to do the desired task. Efficient postal systems, the telephone (fixed and mobile), and various recording
and playback systems based on computer technology all have a part to play in educational broadcasting in the
new millennium. The Internet and its Web sites are now familiar to many children in developed countries and
among educational elites elsewhere, but it remains of little significance to very many more, who lack the most
basic means for subsistence.

1.6.5 Multimedia approach to education
Audio-Visual Education, planning, preparation, and use of devices and materials that involve sight,

sound, or both, for educational purposes. Among the devices used are still and motion pictures, filmstrips,
television, transparencies, audiotapes, records, teaching machines, computers, and videodiscs. The growth
of audio-visual education has reflected developments in both technology and learning theory.

Studies in the psychology of learning suggest that the use of audio-visuals in education has several
advantages. All learning is based on perception, the process by which the senses gain information from the
environment. The higher processes of memory and concept formation cannot occur without prior perception.
People can attend to only a limited amount of information at a time; their selection and perception of informa-
tion is influenced by past experiences. Researchers have found that, other conditions being equal, more
information is taken in if it is received simultaneously in two modalities (vision and hearing, for example) rather
than in a single modality. Furthermore, learning is enhanced when material is organized and that organization
is evident to the student.
1.6.6 Authentic and up to date information

The information and data which are available on the net is purely correct and up to date.Internet, a
collection of computer networks that operate to common standards and enable the computers and the programs
they run to communicate directly provides true and correct information.

1.6.7 Online library
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Internet supports thousands of different kinds of operational and experimental services one of which

is online library. We can get plenty of data on this online library. As part of the IT curriculum, learners are
encouraged to regard computers as tools to be used in all aspects of their studies. In particular, they need to
make use of the new multimedia technologies to communicate ideas, describe projects, and order information
in their work. This requires them to select the medium best suited to conveying their message, to structure
information in a hierarchical manner, and to link together information to produce a multidimensional document.

1.6.8 Distance learning
Distance Learning, method of learning at a distance rather than in a classroom. Late 20th-century

communications technologies, in their most recent phases multimedia and interactive, open up new possibilities,
both individual and institutional, for an unprecedented expansion of home-based learning, much of it part-
time. The term distance learning was coined within the context of a continuing communications revolution,
largely replacing a hitherto confusing mixed nomenclature home study, independent study, external study,
and, most common, though restricted in pedagogic means, correspondence study. The convergence of increased
demand for access to educational facilities and innovative communications technology has been increasingly
exploited in face of criticisms that distance learning is an inadequate substitute for learning alongside others in
formal institutions. A powerful incentive has been reduced costs per student. At the same time, students
studying at home themselves save on travel time and other costs.

Whatever the reasoning, distance learning widens access for students unable for whatever reason (course
availability, geographical remoteness, family circumstances, individual disability) to study alongside others. At
the same time, it appeals to students who prefer learning at home. In addition, it appeals to organizers of
professional and business education, providing an incentive to rethink the most effective way of communicating
vital information.

1.6.9 Better access to children with disabilities
Information technology has brought drastic changes in the life of disabled children. IT provides various

software and techniques to educate these poor peoples. The integration of information technology in teaching
is a central matter in ensuring quality in the educational system. There are two equally important reasons for
integrating information technology in teaching. Pupils must become familiar with the use of information
technology, since all jobs in the society of the future will be dependent on it, and information technology must
be used in teaching in order to improve its quality and make it more effective.

1.7  Information Technology and Modern Society
The information society challenges the education system. In recent years, the speedy, effective and

global communication of knowledge has created a new foundation for co-operation and teamwork, both
nationally and internationally. The increasing role played by information technology in the development of
society calls for an active reaction to the challenges of the information society.

Already, new and greater demands are being made as to the core qualifications of individuals, as well
as to their understanding and knowledge of the consequences of the introduction of information technology
for the work and organisation of a company. Companies are no longer forced to gather all their functions in

1.1.6



   (Information Technology:Theory) (          )       (                                                      )
one place. The knowledge-intensive functions such as development and marketing can be sited in countries
where the labour market can supply highly educated employees, whilst production itself can be moved to
low wage countries. The result is the efficient handling, processing, co-ordination and administration of
company resources, which is decisive for the competitiveness of the company. In a society which is becoming
increasingly dependent on information and the processing of knowledge, great demands are therefore made
that the individual should have a solid and broad educational foundation on which to build. Educational policy
in the information society must ensure that:

IT qualifications are developed by means of their integration in all activities in the education sector
and

The individual citizen must have an active and critical attitude to developments and not passively
allow technological development to set the pace.

1.8  IT Educational Policy Must Ensure
Up-to-date qualifications in the information society

Up-to-date qualifications gained against the background of a high general level of education to
maintain competitiveness and its share of the global labour market in the information society. IT skills and
IT understanding are thus central prerequisites for the individual, both now and especially in the future.

The advantage of using information technology is that time-consuming work routines can increasingly be
performed by means of this technology and time can thus be devoted instead to communicating and informing,
to the processing of information and the production of knowledge.

1.9  Self-Check Exercise
1. What is Information Technology?

2. What are the significance of  Information Technology in Education?

3. Definition of Information Technology.
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2.1 INTRODUCTION

Information Technology has made a major impact on our lives. In everyday life, there is a small role
of Information Technology in it. For example, from our communication to our leisure time there is a small role
of IT in it. Information technology has been famous in our daily lives ever since the beginning of year 2000. IT
has many advantages and disadvantages. Things that were once done manually or by hand have now become
computerized operating systems, which simply require a single click of a mouse to get a task completed. With
the aid of IT we are not only able to stream line our business processes but we are also able to get constant
information in ‘real time’ that is up to the minute and up to date. The significance of IT can be seen from the
fact that it has penetrated almost every aspect of our daily lives from business to leisure and even society.
Before we can know about all the advantages and disadvantages of information technology, it is essential that
we know what information technology is exactly, and why it has it come to play such an important role in our
daily lives. Today information technology involves more than just computer literacy; it also takes into account
how computers work and how these computers can further be used notjust for information processing but
also for communications and problem solving tasks as well.

2.2 ADVANTAGES OF INFORMATION TECHNOLOGY
The followings are the advantages of IT

2.2.1 Globalization
IT has not only brought the world closer together, but it has allowed the world’s economy to become

a single interdependent system. This means that we can not only share information quickly and efficiently, but
we can also bring down barriers of linguistic and geographic boundaries. The world has developed into a
global village due to the help of information technology.

2.2.2 Communication
With the emergence of information technology, communication has also become cheaper, quicker,

and more efficient. We can now communicate with anyone around the globe by simply text messaging them
or sending them an email for an almost instantaneous response. The internet has also opened up face to face
direct communication from different parts of the world thanks to the helps of video conferencing.

2.2.3 Cost effectiveness
Information technology has helped to computerize the business process thus streamlining businesses

to make them extremely cost effective money making machines. This in turn increases productivity which
ultimately gives rise to profits that means better pay and less strenuous working conditions.

2.2.4 Bridging the cultural gap:
Information technology has helped to bridge the cultural gap by helping people from different cultures

to communicate with one another, and allow for the exchange of views and ideas, thus increasing awareness
and reducing prejudice.

2.2.5 More time
IT has made it possible for businesses to be open 24 x7 all over the globe. This means that a business

can be open anytime anywhere, making purchases from different countries easier and more convenient.
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 2.2.6 Creation of new jobs
Probably the best advantage of information technology is the creation of new and interesting jobs.

Computer programmers, Systems analyzers, Hardware and Software developers and Web designers are
just some of the many new employment opportunities created with the help of IT.

2.3 DISADVANTAGES OF INFORMATION TECHNOLOGY
The followings are the disadvantages of IT.

2.3.1 Unemployment
While information technology may have streamlined the business process it has also created job

redundancies, downsizing and outsourcing. This means that a lot of lower and middle level jobs have been
done away with causing more people to become unemployed.

2.3.2 Privacy
Though information technology may have made communication quicker, easier and more convenient,

it has also bought along privacy issues. From cell phone signal interceptions to email hacking, people are now
worried about their once private information becoming public knowledge.

2.3.3 Lack of job security
Industry experts believe that the internet has made job security a big issue as since technology keeps

on changing with each day. This means that one has to be in a constant learning mode, if he or she wishes for
their job to be secure.

The technology has helped to computerize the business process thus streamlining businesses to make
them extremely cost effective money making machines. This in turn increases productivity which ultimately
gives rise to profits that means better pay and less strenuous working conditions.

2.3.4 Dominant culture
While information technology may have made the world a global village, it has also contributed to

one culture dominating another weaker one. For example it is now argued that how US influences under
developed countries all over the world now act, dress and behave.

2.4 IMPLEMENTING INFORMATION TECHNOLOGIES IN LIBRARIES
According to John Bushman, the implementation of information technology requires librarians to ask

two basic questions:

** Why is the technology good for libraries, librarians, or the public?
** Where will the technology lead us?

It is the librarian’s duty to ask these questions and become involved in finding the answers. All technological
advances need to be approached critically, with the knowledge that they may have both social and political
consequences. Librarians need to be able to evaluate technologies to determine whether a given technology
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will harm or help the library and its community. Funding, getting the public involved with the change in
technology, getting them to deal with the positive and negative effects of change, and making sure the librarians
are able to handle the pressures are all ways of becoming involved with finding the answers about information
technology and the future of libraries.

2.4.1 Role of Libraries
In the modern knowledge society libraries have a new role and there are various types of library

models. In the modern society, where the use of electronic services and Web-based information sources
constantly increases, libraries are managed in a more democratic way, have more flexible communication
system and work organization, and their service development is based on the quality and user-orientation of
services. In the modern knowledge society libraries have a new role and there are various types of library
models. These are as follows:

i. traditional library as a memory institution
ii. library as a learning and research centre
iii. library as a cultural and communication centre
iv. electronic library
v. digital library
vi. virtual library as library without walls

      Libraries had been performed many important roles in the past agrarian and industrial societies. But
those roles were limited in scope. In the 21st century, libraries have to perform pivotal roles in disseminating
and sharing the culture of knowledge. In this age of knowledge libraries should be repositories of all of the
knowledge and information accumulated by human kind. They will have to store all kinds and forms of
material and information and disseminate beyond the geographical boundaries. Today’s advanced information
technology is enabling libraries to accomplish this immense task (Singh & Nazim, 2008).

2.5 CONCLUSION
While information technology may have streamlined the business process it has also crated job

redundancies, downsizing and outsourcing. IT has to be carefully managed so that the disadvantages do not
overcome the advantages. People have to use Information the right way to make maximum use
 out of it.

2.6 SELF-CHECK EXERCISES
1. What are the advantages of IT?
2. What are the disadvantages of IT?
3.Discuss the Impact of Information Technology and Role of Libraries.

REFERENCES
1. Bushman, John. “Asking the Right Questions about Information Technology.” American Libraries
            21 (December 1990): 1026 – 1030
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3.0 OBJECTIVES
After reading this Chapter, you will be able to:

• Understand the components of IT;
• Computer Hardware-Input & Output devices;
• Software-System Software & Application Software
• Also you you will come to know how these componenents are integrated with each other.

3.1 INTRODUCTION
Information and communication technology today usually means computer-based management of

data or ideas. In a broader sense, communication and information technologies are the foothold on which
humankind distinguished itself from other animals. 

The vast difference between today’s information and communications technologies and humankind’s first
simple shared concepts hints at what these technologies now mean for our world. For you, the explosion of
information and technologies exposes a wealth of new opportunities to explore. Information communication
technology has five components which are describe below:
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3.2 Hardware
The term hardware refers to the physical components of computer such as the system unit, mouse,

keyboard, monitor etc. Hardware is any physical part of a computer that you can see or touch. A computer’s
monitor, CD-ROM or DVD drive, mouse, keyboard, and printer are all different types of hardware. In
this Chapter we will takes a closer look at the physical parts that constitute a computer. This Chapter is
broken up into several sections, since there are several different categories of hardware devices. First
we’ll examine processing devices, such as computer’s CPU and memory. You’ll finally understand what
those technical sounding words megahertz and gigabyte mean. From there we’ll move on to input devices,
such as the keyboard and mouse and output devices, such as the monitor and printer. The last part of this
Chapter discusses about storage devices, such as hard drives and CD-ROM drives.

Hardware Components
3.2.1 Input Devices – “How to tell it what to do”

A keyboard and mouse are the standard way to interact with the computer. Other devices include
joysticks and game pads used primarily for games.

3.2.2 Output Devices – “How it shows you what it is doing”
The monitor (the screen) is how the computer sends information back to you. A printer is also an

output device.

1.3.2

Output  Devices Input  Devices
Keyboard

Tracker balls
Scanners

Joysticks

  Mouse
Printers

Hardware Components

Touch Pads

VDU

Plotters
Speakers
Speech Light

S t o r a g e
devices

Synthesisers
Pens
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3.3 Software

The software is the instructions that makes the computer work. Software is held either on your
computers hard disk, CD-ROM, DVD or on a diskette (floppy disk) and is loaded (i.e. copied) from the
disk into the computers RAM (Random Access Memory), as and when required.
Generally there are two types of software as followed:

Software

System Software  Application Software

Operating System

Word   Spreadsheets Database Payroll  Presentation Desktop MultimediaProcessing Tools   Publishing Applications

3.3.1 System Software:
• System software is a generic term referring to any computer software whose purpose is to help run

the computer system. Most of it is responsible directly for controlling, integrating, and managing the
individual hardware components of a computer system.

• System software is opposed to application software that helps solve user problems directly.

3.3.2 Application Software:
• Application software is a subclass of computer software that employs the capabilities of a computer

directly to a task that the user wishes to perform. This should be contrasted with system software
which is involved in integrating a computer’s various capabilities, but does not directly apply them in
the performance of tasks that benefit the user.
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• An application is a computer program designed to help people perform an activity. An application
thus differs from an operating system (which runs a computer), a utility (which performs maintenance
or general-purpose chores), and a programming language (with which computer programs are created).

3.4 Procedure
A set of instructions that performs a specific task for a main routine, requiring direction back to the

proper place in the main routine on completion of the task. Computer data processing is any process that
uses a computer program to enter data and summarise, analyse or otherwise convert data into
usable information. It involves recording, analysing, sorting, summarising, calculating, disseminating and storing
data. Because data are most useful when well-presented and actually informative, data-processing systems
are often referred to as information systems. Nevertheless, the terms are roughly synonymous, performing
similar conversions; data-processing systems typically manipulate raw data into information, and likewise
information systems typically take raw data as input to produce information as output.

3.5 Data
Data are values of qualitative or quantitative variables, belonging to a set of items. Data

in computing (or data processing) are represented in a structure, often tabular (represented by rows and
columns), a tree (a set of nodes with parent-children relationship) or a graph structure (a set of interconnected
nodes). Data are typically the results of measurements and can be visualised using graphs or images. Data
as an abstract concept can be viewed as the lowest level of abstractionfrom which information and then
knowledge are derived. Raw data, i.e., unprocessed data, refers to a collection of numbers, characters and
is a relative term; data processing commonly occurs by stages, and the “processed data” from one stage may
be considered the “raw data” of the next. Field data refers to raw data collected in an uncontrolled in
situ environment. Experimental data refers to data generated within the context of a scientific investigation by
observation and recording.

The word data is the plural of datum, neuter past participle of the Latin dare, “to give”, hence
“something given”. In discussions of problems in geometry, mathematics, engineering, and so on, the
terms givens and data are used interchangeably. Such usage is the origin of data as a concept in computer
science or data processing: data are numbers, words, images, etc., accepted as they stand.
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Though data is also increasingly used in humanities (particularly in the growing digital humanities), it has been
suggested that the highly interpretive nature of humanities might be at odds with the ethos of data as “given”.
Peter Checkland introduced the term capta (from the Latin capere, “to take”) to distinguish between an
immense number of possible data and a sub-set of them, to which attention is oriented. Johanna Drucker has
argued that since the humanities affirm knowledge production as “situated, partial, and constitutive,”
using data may introduce assumptions that are counterproductive, for example that phenomena are discreet
or are observer-independent. The term capta, which emphasizes the act of observation as constitutive, is
offered as an alternative to data for visual representations in the humanities.

The terms data, information and knowledge are frequently used for overlapping concepts. The main
difference is in the level of abstraction being considered. Data is the lowest level of abstraction, information
is the next level, and finally, knowledge is the highest level among all three.Data on its own carries no
meaning. For data to become information, it must be interpreted and take on a meaning. For example, the
height of Mt. Everest is generally considered as “data”, a book on Mt. Everest geological characteristics
may be considered as “information”, and a report containing practical information on the best way to reach
Mt. Everest’s peak may be considered as “knowledge”.

Information as a concept bears a diversity of meanings, from everyday usage to technical settings.
Generally speaking, the concept of information is closely related to notions of constraint, communication,
control, data, form, instruction, knowledge, meaning, mental stimulus, pattern, perception, and representation.
Beynon-Davies uses the concept of a sign to distinguish between data and information; data are symbols
while information occurs when symbols are used to refer to something.

It is people and computers who collect data and impose patterns on it. These patterns are seen as
information which can be used to enhance knowledge. These patterns can be interpreted as truth, and are
authorized as aesthetic and ethical criteria. Events that leave behind perceivable physical or virtual remains
can be traced back through data. Marks are no longer considered data once the link between the mark and
observation is broken.

Mechanical computing devices are classified according to the means by which they represent data.
An analog computer represents a datum as a voltage, distance, position, or other physical quantity. A digital
computer represents a datum as a sequence of symbols drawn from a fixed alphabet. The most common
digital computers use a binary alphabet, that is, an alphabet of two characters, typically denoted “0” and “1”.
More familiar representations, such as numbers or letters, are then constructed from the binary alphabet.

Some special forms of data are distinguished. A computer program is a collection of data, which can
be interpreted as instructions. Most computer languages make a distinction between programs and the other
data on which programs operate, but in some languages, notably Lisp and similar languages, programs are
essentially indistinguishable from other data. It is also useful to distinguish metadata, that is, a description of
other data. A similar yet earlier term for metadata is “ancillary data.” The prototypical example of metadata
is the library catalog, which is a description of the contents of books.
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3.6 People

Last component of information technology is user, who use computer for their personal purpose.People
use computers as they make their jobs easier. They can be used for communicational purposes (internet), to
store and calculate data and to write up massive documents multiple times while only needing to write it up
once. Others use computers for entertainmen value; to play games, watch movies and play music etc. Computers
are also more convinient and reliable than the older ways of doing things, like type writers, scales and other
counting devices.

3.7 Self-Check Exercise

1. Explain in brief components of IT.

2. What is input & output devices?

3. Enumerate the types of software packages.
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4.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the application of information communication technology;
• Concept of ICT;
• Definition of ICT;
• ICT Enabled Library Services
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4.1 INTRODUCTION

Information needs and diverse information tools have affected our daily life as well as research and
developmental activities. Latest devices for information communication have resulted in the expeditious
dissemination of information and revolutionized the information handling activities in research and academic
libraries in India. Academic libraries, mostly attached to universities and research institutions as centers of
information services, have largely benefited by the rapid changes in technology. The advent of digital computer
advances in telecommunication and audiovisual technologies has opened up new ways of collecting, organizing
and disseminating scientific and technical information. Academic libraries have already transformed their
specific functions by utilizing effectively innovative information technologies to enhance and integrate their
specific information resources and services. Eventually, library and information professionals in academic
libraries need to update their
knowledge and skills in information and communication technology (ICT) as they play the role of key
success factor in enabling the library to perform its role as an information support system for society.

4.2 Concept of ICT
ICT is technology that supports activities involving information. Such activities include gathering, processing,
storing and presenting data. Increasingly these activities also involve collaboration and communication. Hence
IT has become ICT: information and communication technology.
Some underlying principles

• Technology does not exist in isolation

• ICT contributes at various points along a line of activity

• ICT is used in activities – the ICT use depends on the activities

• The key outputs of educational activities are context are knowledge, experience and products

• The output should be useful to the users (self and others)

4.3 Definitions
Definitions of important terms are as follows:
Oxford Dictionary and Thesaurus (2001) defines impact as immediate effect or influence, or consequence.
The Webster’s New World College Dictionary (2005) defines impact as the power of an event, idea, etc.,
to produce changes, move the feelings, etc. Collins Dictionary (1987) terms it as profound effect or collision.
The term Information Technology (IT) is commonly used to mean a combination of computer and
communication technologies used for information storage and dissemination. In an academic environment,
the term ICT or Information Communication Technology is more commonly used. It is generally used both
as singular and plural nouns. There are various definitions for ICT and a few that are relevant to this study are
described here. In the UNESCO training module for ICT, Information Communications Technologies (ICT)
are described as the technologies that enable society to create, collect, consolidate, communicate, manage
and process information in multimedia and various digital formats for different purposes, i.e., computing and
telecommunications technologies like the personal computer, CDROM, cable TV, cellular phones and the
Internet (David, 2001).
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Information communication technologies can be split into three components: the technology part;

information that the technology helps deliver; and a communication process that the technology facilitates
and serves as a medium for the information. (Rhine, 2006). Hamelink (1997) classifies ICT according to five
different functionalities-capturing technologies (like input devices), storage technologies (magnetic tapes and
disks), processing technologies (systems and application software), communication technologies and display
technologies (e.g. output devices for display of digitized information).

4.4 ICT and Libraries
Libraries which were considered only as the storehouses of knowledge, have got a new outlook in

the modern Information Communication Technology era. The activities which were carried out manually in
libraries with so much of pain and strain are being carried out smoothly with the help of ICT with greater
effectiveness. Library organization, administration and other technical processing have become easier and
more quantum of work can be done in relaxed mood. ICT, which is the basis for the MBO, generates more
results at a given time.
4.5 ICT Enabled Conventional Library and Information Services

4.5.1 Online public access catalogue and user services

Library catalogue is perhaps the most important tool for locating material in the Library. Unfortunately
until recently its value has been restricted by its physical form, most commonly a large card catalogue or a set
of printed volumes. The advent of computers, with their ability to process large amounts of information and
output in a variety of formats has finally brought the library to the customer, wherever he or she may be
located, in the form of Online Public Access Catalogue (OPAC).
OPAC provides access to the catalogue through a computer terminal.  OPAC allows searching the entire
catalogue online, conveniently and quickly, using one or more search criteria. One can, for example, search
by author, title, keywords, class number or one or more of these combined together. OPAC even shows the
current status of a book, whether it is loaned out, available on the shelf or lying elsewhere. Another advantage
of OPAC is its ability to display catalogue records in a variety of formats such as AACR2, MARC etc, and
the records can be displayed in a desired order. For example one can display records arranged (sorted) by
author, title or call number. Most library management packages offer printing of bibliographies from OPAC
either on a printer or on a file. An OPAC terminal should be equipped with search software, which is usually
part of integrated library management systems such as LibSys, EasyLib, NewGenLib, SOUL, Sanjay etc.
Some integrated library management packages even use OPAC for other user services like reservation,
membership enquiry and registration, interlibrary loans etc.

4.5.2 Information Services

Some of the important changes that developments in ICT have brought about in information services are:
1. Changes in formats, contents and methods of production & delivery of information products, and a new

business model for use of information products. This requires procedural and infrastructural changes
and cost implications in Libraries.

2. Emergence of Internet as the largest repository of information and knowledge.
3. Extinction or significant transformation of some of the conventional information services such as press

clippings, contents pages, company information etc.
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4. Use of new tools and technologies for dissemination of information.
5. Transformation of role of LIS professional as the subject specialist and end-user gets directly involved

in the information work and consequent need for new skills.
6. Shift from physical to virtual services that offer convenience of time and location for access to services.

In the following paragraphs we will now briefly discuss a few types of information services viz. Reference
service, Bibliographic Service, and Current Awareness Service in ICT enabled environment. Some new
information services are described later.

4.5.3 Reference Service:
Asynchronous tools such as email, subject gateways, FAQs, and electronic libraries and interactive tools like
chat rooms, virtual reference desk, and ask-me are replacing the
conventional means of post, phone or in-person reference enquiries. Ask-a-Librarian allows the user to
click on ask-a-librarian link to send a formatted enquiry to the reference librarian. The reference librarian
either provides an answer, links to resources or link to a subject expert. Interactive tools now allow a
reference interview online.

4.5.4 Bibliographic Service:

Compilation of bibliographies, reading lists and state-of-art reports are very parts of LIS work, particularly
in research and academic libraries. Browsing through the manual indexes and abstracts is a tedious and time
consuming work, and does not always produce up to date result. Availability of databases in electronic form
on CDROM or online, offers convenient, efficient and cost effective information retrieval. Electronic databases
also provide unique search features such as searching on multiple criteria (key-word, subject, author, source,
classification code, year of publication, language etc.), and variety of display formats & styles. Advance
features like natural language query ranking the search results in also available in many databases. Web
based services facilitate full text searches and link to full text of the documents. Dialog, STN and Silver
Platter are some of the popular database companies that offer bibliographic and reference databases on
CDROM and Online platforms.

4.5.5 Current Awareness Service:

Current Awareness Services has been important means for keeping the users up to date in their areas of
interest. A current awareness service may be as simple as copy of table of contents or a bulletin containing
bibliographic records, of articles selected from the current issues of journals and other material, and usually
organized by subjects. Libraries now compile current awareness bulletins using predefined search strategy
and running on the database either on CDROM or online periodically and getting the desired output. Subject
to copyrights, the output can also be stored on a local system, and disseminated online (internet, intranet) and
offline (print, CDROM, email). Table of contents of most journals are available free from the publishers’
sites. Some publishers even offer free email update of table of contents. A large number of lectronic publishing
sites or portals now offer current information via email to registered users. For example one can register on
New York Times newspapers to receive summary of news on daily basis.

Internet has enabled a lot of innovations in contents, methods of production and distribution of
current awareness products. Tools such as Listserv, Weblog, Webzines and e-newsletters are common.
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Listserv give the latest information, hot topics, ideas and opinions, a chance to discuss issues, a source of
advice and assistance. Weblogs literally log the web. They review, select and package the latest relevant
information, in a subject area. Some examples of web based current awareness service are The NSDL
Scout Report for Math, Engineering, and Technology (http://scout.wisc.edu/Reports/NSDL/MET/Current/
) and Free Pint (www.freepint.com) are examples of web based current awareness services.

4.5.6 Document Delivery

It is not possible for libraries to have everything that its clients may need. Libraries use document delivery
services from other libraries and commercial organizations for copies of research papers etc not held by
them. Locating a source and procuring the document requires considerable time and efforts and the process
is laden with uncertainties. ICT has made the document delivery services very simple and reliable. From
searching the holdings to ordering and delivery have been benefited by the use of ICT. A large number of
libraries now host their up to date holdings on their website and can be searched on internet. Many library
networks such as INFLIBNET and DELNET maintain union catalogue of their member’s journal holdings.
One such document delivery service provider British Library Document Supply Service (BLDSC) offers a
flexible system of receiving orders and tracking. BLDSC’s email based document supply system Artmail
allows registered users to send requests through a formatted email that automatically is processed by BLDSC’s
system, which generates location of the sources. The documents can be received in print as well as electronic
format. Online and web based database services such as STN provides link to document delivery services
of their own or a third party. Some of the commercial document delivery services are Ingenta (http://
www.ingenta.com/), and BioMedNet, OCLC (www.oclc.org/) and Science Direct (http://
www.scienceDirect.com). Full text of electronic journal articles that are available in electronic form may also
be downloaded through links provided by aggregator or gateway services such as Informatics’s J-gate
(www.j-gate.informindia.co.in/). Electronic journals are discussed later in this unit.

4.5.7 Inter-Library Loans and Union Catalogues

As described earlier, no library can fulfill all the needs of its users from its collection. Resource sharing
through Inter-library loan is a necessity for the libraries. Access to the catalogue of partner libraries is crucial
to inter-library lending. Union catalogues, standardization and machine readable catalogues are aimed at
promoting resource sharing. Printed union catalogues and Computer Output on Microfiche (COM) catalogues
and CDROM are now being replaced by web OPAC and web based union catalogues. Librarians can now
access catalogues of thousands of libraries across the world using Internet. Developments in digital library
and internet technologies have made it possible to automatically update the catalogue records from member
library systems, distributed searches using a single user interface, and value added services. RedLightGreen.
(http://www.redlightgreen.com/ ) is one of the world’s largest web based union catalogues. It. contains about
130 million records from 160 member libraries of Research Libraries Group (RLG) in USA. In India,
bodies like INFLIBNET, DELNET are also developing union catalogues of books, serials and theses.

4.5.8 Audiovisual  Services

Audiovisual materials are important sources of information, education and entertainment. Many libraries
particularly media libraries and large academic and public libraries hold audio visual material such as music,
films, pictures and photographs etc. Old media of LP records and tape slide have long been replaced with
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audio and video tape. The new multimedia of audio CD, Video CD (VCD), and Digital Video Disks (DVD)
have advantage of higher storage capacity, random access and longer life than audio and video tapes and
cassettes. Many libraries allow their members to borrow these. Multimedia documents can now be played on
standard PCs, stand-alone or networked. Recent developments in storage media, compression and encryption
technology have made it possible to store large amount of multimedia documents on hard disk and disseminate
through internet. Software such as Quick Time Player, Microsoft Media Player etc are now freely available to
play or see these documents in a browser. You will learn more about various hardware, software and document
formats that are used for creation, storage, distribution and use of digital multimedia documents later in the
course.

4.6 Customer Relations and User Education
LIS being service organization, customer services and user training are important aspects of its activities.

A continuous interaction with users for feedback and information is a must to maintain the standards of
service. While the conventional means of interaction such as meetings, suggestion box, surveys and interviews
are still important, use of new means of communications such as email, web forms, bulletins boards, discussion
forums and listserv are fast replacing these. Not only these tools provide a fast, convenient and transparent
and cost effective medium, but also offer scope for innovations and greater peer participation. Some of these
tools can even be used by the libraries to involve the users in book selection etc. LIS customer relations can
be tremendously improved by innovative use of technology like virtual library tours, making interactive library
maps and floor plan available on the library web site. A highly ICT enabled environment requires appropriate
training to its users also. The contents of user training must include use of internet tools and resources.
Conventional user education programmes can be supplemented with web based instructions and guides for
use of resources. In the conventional class room based user education also ICT tools are used for presentation
and demonstration.

A library web page or Universal Resource Locator (URL) facilitates single window access to various web
enabled library services.  A URL could be as simple as a library web page listing the services with some links
to catalogue and external free and subscribed resources or may include advance features like interactive
helps and value added services such as subject gateways, self-help tools and frequently asked questions, and
information about the library such as timings, calendar, rules etc can be hosted on the library web site. Apart
from the ICt enabled conventional services, Libraries are making use of potential of internet and computing
power to provide new and innovative services. In a web enabled environment the new LIS services can be
grouped into the following three categories:
• Providing access to internet and internet based services
• Providing access to web based resources
• Providing access local or internal information resources in digital form

4.7 Internet Access
Internet is not only a medium for digital communication but also the world’s largest repository of information.
However, under developed internet infrastructure in a country like India, poses a serious challenge to growth
of ICT enabled services. Large segment of user groups may still be deprived of personal access to internet
facility. Libraries, therefore, provide free or controlled access to internet and email. Depending upon the
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availability users can be given time slots for use of internet facility. Usually a few internet enabled terminals
are provided in the library that can be used by the visitors for internet access and email etc.

4.8 Access to Web Based Resources
As already discussed, many types of library materials such as journals, books, patents, newspapers, standards,
photographs, pictures, motion pictures or music are now available in electronic or digital form. From the
user’s point of view digital resources hold many advantages such as time and place convenience, timeliness,
ability to search directly on text (as against the catalogue records), ability to link to further reading material,
and ability to disseminate and share information. From the library’s point of view digital format offers
convenience of storage and maintenance, cost advantage, ability to target global users, etc. However, digital
resources also pose human, social and technological problems, such as discomfiture in reading on the screen,
problems in internet access and speed, poor infrastructure, lack of sufficient skills to use the digital resources,
and perceptional change resulting from right to use rather than physical possession, etc. In this section, we
will briefly discuss various some types of library materials such as journal, books, theses & dissertations,
patents, course material etc.

4.8.1 E-Journals:

Libraries have been exploring easy to cope with the problems of ever increasing prices of the
journals, space requirements and decreasing level of usage as the journals get older. Nevertheless, libraries
are required to maintain back issues of the journals, usually in bound form. Electronic Journal helps the
librarians in addressing these problems to a great extent without significantly affecting the service levels.
Electronic Journals can be accessed via internet from any web enabled PC. Depending on the type of
subscription, one or more users can access the service simultaneously, either directly from an independent
web enabled PC or in a local area network through a proxy server (IP addresses based access). Electronic
journals also offer benefit of full text searching and downloading of articles. Many publishers of electronic
journals offer their journals through consortia of libraries at much lower rates. INDEST (Indian Digital
Library of Engineering, Science and Technology), and INFLIBNETare two such consortia operating in
India. Access to articles in electronic journals can also be made through aggregator services which offer
searchable databases of contents of e-journals from several publishers, and links to journal site for full text.
Emerald, OCLC and J-Gate are some of the example of e-journal aggregator services. The main disadvantage
of electronic journal is that libraries can not physically possess the journals.

have also implemented Electronic Theses and Dissertation programmes, where researchers submit theses

In addition to above meaning of reprographic there are few meanings of reprographics are given
below:

Reprographics generally refers to methods of copying or reproducing documents that include
xerography and scanning. The term applies to both soft and hard copy reproduction.

Reprographics is a general term used to refer to multiple methods of reproducing content both
physical and digital which include xerography, photography, scanning and digital printing.
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Systems Ltd, Endeavor Information Systems , Epixtech, ESP, Ex Libris ,Fretwell-Downing Informatics,
IBM, Sirsi, and SydneyPlus. Greenstone (http://www.greenstone.org ) is a leading open source digital library
management software.

4.10 Impact of Information Communication Technology  on Libraries
The Exponential rise in generation of new information, especially Scientific and Technological

information since World War II has gradually reduced the effectiveness of the traditional tools and retrieval
aids used by librarians. We are now in the age of information technology revolution along with information
explosion. Due to information explosion, automation of library service is imperative for efficiency and effective
working of library and information center. The automation is defined as a technique of making, a process or
a system operates automatically. Though generally library automation may mean use of suitable machines to
perform the activities of library mechanically without much manual or mental efforts by human beings, today
library automation signifies “mechanization of library house keeping operations predominantly by
computerization”. The most commonly known house keeping operations are acquisition control, serials
control, cataloguing and circulation control. In recent times, even the related topics such as information
retrieval, semi-automation, automatic indexing and networking of automated systems are also treated as part
of library automation. Although computers have a major role in library automation, telecommunication and
reprographic technology have an equally important role because of the extent of support they offer. Most of
the Library and Information Centres (LICs) of India have started using computers and Information
Communication Technologies in organising their collections, housekeeping operations, processing, retrieval
and dissemination of information to the end users. The use and impact of ICTs is now visible in Indian library
and information centres which may be due to the drastic reduction /escalation of the cost of hardware and
software and their easy availability in the markets with service support from the suppliers or venders.

The impact of IT is also evident on the activities of many LICs associated with universities and other
institutions of the national importance. Thanks to University Grants Commission for establishing INFLIBNET
which have been playing an important role since its inception for initiating the automation and networking
activities of library and information centres of universities, colleges, R&D laboratories, and various institutions
of higher learning. So far 142 universities have been covered under the INFLIBNET Programme which
enables the university libraries to purchase computers, modem, printer, air –conditioner, software (Operating
and application software) and get telephone connectivity etc. The recurring grant is also provided for meeting
the expenses of data support work, salary of Information Scientist, telephone charges for accessing INFLIBNE
Databases through Internet and maintenance charges for first five years from the date of installation of
systems.

4.11 Self-Check Excerise
1. Explain the concept of ICT.

2. Describe ICT enabled library services.

3. Write any two definitions of ICT.
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1.0 OBJECTIVE
After reading this Chapter, you will be able to:

• Understand the basics of network technology;
• Components of computer network;
• Types of networks;
• Cagegories of network.
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1.1 INTRODUCTION

A network is actually a set of independent computers that talk with one another over a common network
medium. A computer network is a combination of two or more connected computers. With the help of this
connected network, people can share files and peripherals such as modems, printers, tape backup drives, or
CD-ROM drives. When networks at many locations are connected using services available from phone
companies, people can send e-mail, share links to the global Internet, or conduct video conferences in real
time with other remote users. An open source network can be managed properly with online collaboration
software. Nowadays, companies rely heavily on applications like electronic mail and database management
for core business operations thus making computer networking indispensable.

1.2 Components of Computer Network
A computer network comprises the following components:

• A minimum of at least 2 computers

• Cables that connect the computers to each other, although wireless communication is becoming more
common (see Advice Sheet 20 for more information)

• A network interface device on each computer (this is called a network interface card or NIC)

• A ‘Switch’ used to switch the data from one point to another. Hubs are outdated and are little used
for new installations.

• Network operating system software

1.3 Types of Networks
A network is a means of sharing computerized information among people residing across geographically

distant places. Based on this basic need of the network, you can classify networks according to the geographical
area within which they can transmit data. The area size determines the cabling requirements and the speed of
data transmission within the network. The different types of networks based on the scope of the physical area
are:

• Local Area Network (LAN)
• Metropolitan Area Network (MAN)
• Wide Area Network (WAN)
• Storage Area Network (SAN)

1.3.1 Local Area Network (LAN)
LANs are networks usually confined to a smaller geographic area, such as a single building or a

college campus. LANs can be linking as few as three computers, but often link hundreds of computers used
by thousands of people. The pace of  development of standard networking protocols and media is really high.
Nowadays LANs are  omnipresent particulary in  business and educational organizations
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1.3.2 Metropolitan area Network (MAN)
A MAN is bigger than LAN and covers the distance b/w 5-50km in diameter. It functions within the

physical area larger then LANs but similar to WANs e.g. MAN can be utilized to connect the branches of an
organization which is spread within the 50km area of a city. Therefore, MAN includes LANs to form a large
network. Usually, the cabling requirements and other equipments of MAN are owned by a group of people
or by a service provider
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1.3.3 Wide Area Network (WAN)

Wide area networking combines multiple LANs that are geographically separate. This is accomplished
by connecting the different LANs using services such as dedicated leased phone lines, dial-up phone lines
(both synchronous and asynchronous), satellite links, and data packet carrier services. Wide area networking
can be as simple as a modem and remote access server for employees to dial into, or it can be as complex as
hundreds of branch offices globally linked using special routing protocols and filters to minimize the expense
of sending data over long distances.

Figure.3 Wide Area Network
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1.3.4 Storage Area Network (SAN)

SAN is a type of Network that is referred to a Network of different storage media or devices. It is
implemented for facilitating huge data storage and retrievals and is a part of the enterprise network. In SANs,
remote computer storage devices, such as arrays of disc, tapes and optical storage devices are connected to
high speed data servers in the enterprise network. They are connected in such a manner that it provides an
illusion of being connected locally to the other workstations, Operating Systems and the peripheral devices.
Therefore, SANs are dedicated storage networks, which effectively handle only the I/O traffic among the
storage resources and servers.

SANs are sometimes referred to as the System Area Networks. These networks involve a collection
of high performance computers used for handling distributed applications in a network that requires quick
processing.  A distributed application refers to an application running on more than one computer on a
network

Figure.4 Storage Area Network

1.4 Categories of Network:

Network can be divided in to two main categories:

• Peer-to-peer

• Server–based

2.1.5 NETWORK TECHNOLOGY-CONCEPTS
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1.4.1 Peer-to-Peer

In peer-to-peer networking there are no dedicated servers or hierarchy among the computers. All of
the computers are equal and therefore known as peers. Normally each computer serves as Client/Server and
there is no one assigned to be an administrator responsible for the entire network.

Peer-to-peer networks are good choices for needs of small organizations where the users are allocated
in the same general area, security is not an issue and the organization and the network will have limited growth
within the foreseeable future.

Figure.5 Peer-to-Peer Network

1.4.2 Client-Server
The term Client/server refers to the concept of sharing the work involved in processing data between the
client computer and the most powerful server computer.
The client/server network is the most efficient way to provide:

• Databases and management of applications such as Spreadsheets, Accounting, Communications and
Document management.

• Network management.

• Centralized file storage.

The client/server model is basically an implementation of distributed or cooperative processing. At

the heart of the model is the concept of splitting application functions between a client and a server processor.

The division of labour between the different processors enables the application designer to place an application
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function on the processor that is most appropriate for that function. This lets the software designer optimize

the use of processors—providing the greatest possible return on investment for the hardware.

Client/server application design also lets the application provider mask the actual location of application

function. The user often does not know where a specific operation is executing. The entire function may

execute in either the PC or server, or the function may be split between them. This masking of application

function locations enables system implementers to upgrade portions of a system over time with a minimum

disruption of application operations, while protecting the investment in existing hardware and software.

Figure.6 Client Server Network

1.5  Self-Check Exercise
1. What is network technology?

2. Exapain components of network technology.

3. Describe types of networks.
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2.0 OBJECTIVES

After reading this Chapter, you will be able to:

• Understand the meaning of resource sharing;

• Need and scope of resource sharing;

• Resource sharing through network;

• Steps to promote resource sharing through network.

Resource Sharing         2.2.1
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2.1 INTRODUCTION

Resource sharing, a well-established practice among libraries in most developed countries, cannot be
taken for granted in all libraries. Barriers to sharing include underdeveloped infrastructures, institutional
restrictions on cooperation and lack of staff expertise. Even those with the luxury of excellent interlibrary loan
(ILL) systems occasionally use a personal connection or manipulate the established system to get an item
quickly or track down the obscure item. Professional networks and personal contacts can be useful for rush
requests or finding specialized, un-cataloged resources but this process takes time and even the best personal
network can fail. Members of an organization may rely on an email discussion list to alert colleagues of their
needs. However, discussion lists can be flooded with interlibrary loan requests to the detriment of professional
discussion. Established interlibrary loan processes are appropriate for the bulk of resource-sharing requests
for those with access to such processes; yet there remains a need for efficient use of professional networks to
supplement traditional ILL services and, in the case of colleagues in the developing world, to establish resource-
sharing options. A professional organization builds the capacity, or self-sufficiency, of all members by endorsing
a resource-sharing system for its network.

2.2 Overview of Resource Sharing
Library co-operation is age old and can be traced to 200BC when Alexandria Library shared its resources

with Pergamon Library. According to Kraus, there existed library co-operation among monastery libraries in
the 13th century. There were exchanges of agreements among the universities of Lund, Abo and Greifswald
as early as 1740. The other examples of library cooperation include a projected union catalogue of the
libraries of Weimar and Jean and a proposal for a co-ordinated acquisition scheme for Walfenbuttel and
Gottengen. The ‘Catalogue of Manuscripts in various parts of India’ complied by Whitney Stokes in 1868,
and in 1863 Part I of Sanskrit manuscripts in private libraries of North-west provinces covering Varanasi was
published. The first major union list entitled ‘A Catalogue of Scientific and Technical Periodicals’ was complied
by Henry C.Bolton in 1885. With the advent of the 20th century, the Library of Congress started co-operative
cataloguing projects and began working on the National Union Catalogue. Thereafter, in the 20th Century the
compilations and publications of union catalogues of different types increased in number in most countries.
The first library cooperation activity in India is reported to be the Catalogue of Manuscripts complied by
Whitney Stokes in 1868. Union catalogue development was one of major cooperative efforts in Indian
libraries up to the 1960s. We can look at the following union catalogue development activities:

1918: - Catalogue of Scientific Serial Publications in the Principal Libraries in Calcutta complied by Stanley
Kemp, Asiatic Society of Bengal.
1931: - List of Scientific Periodicals in the Bombay Presidency. Royal Institute of Science, Bombay.
1953: - Catalogue of Periodicals in CSIR organizations corrected up to December 1953 CSIR, New Delhi.
Union Catalogue of Learned Periodical publications in South Asia, vol.1: Physical and Biological sciences
compiled by S.R. Ranganathan and others. ILA, Delhi.
1956:- Catalogue of Medical Periodicals in Indian Libraries corrected up to December 31, 1955.4th ed.
Director General of Health Services, Delhi.
1968:- A Union List of Learned American Serials in Indian Libraries. Indian Council for Library Development.
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The 1960s also saw a large number of ILA and IASLIC national seminars devoted to the concept of library
cooperation. However, with the advent of computers in library work, a change occurred. It is reported that
the first use of computer in library work for the production of the Union List of Serials in 1964 using the IBM/
602 machine at INSDOC. Since then library automation has been a matter of primary importance in Indian
Libraries. With the establishment of the National Informatics Center (NIC) in 1975 and the development of
NICNET in 1977, networking and communication technology in India received a major boost. This as a
whole had a major influence in resource sharing among various libraries and information centers through
networks. In 1984, the working group of the Planning Commission headed by Dr. N. Seshagiri recommended
modernization of library services and inter linking of library systems in the seventh plan.

The 1990s are said to be the golden period of library networking in India. There has been a plethora of
publications and seminars on library networking during this period. Today besides INFLIBNET, there are
various local library networks in India such as ADINET, BONET, BALNET, CALIBNET, DELNET,
MALIBNET, MYLIBNET, and PUNENET etc.

We therefore notice that the efforts made for library cooperation in the 20th century began with the
compilation of union catalogues, as no co-operation could be effective without the knowledge of the resources
of other libraries. The scope of co-operations soon took big leap. It became diversified and incorporated the
various activities of the libraries such as Abstracting and Indexing, Acquisition, Bibliographic access, cataloguing,
Circulations development, continuing education for staff and users, literature searching, management and
accounting, microfilming, photo coping, processing, referral services, storage and union lists.

2.3 Resource Sharing: Meaning
Resources sharing is sharing of library resources such as document collection, staff members, technical

facilities and mechanical aids among the participating libraries on the basic principle of cooperation, “All for
one and one for all”. In this respect it is possible to consolidate the document collection of participating
libraries, exchange their technical capabilities and share their services. In this way it is possible to share the
resources to provide on access to the vast amount of library and information sources to a larger user community
at the least-cost. The objective of resource sharing is obviously to make the greatest amount of best information
available to the most users at the reasonable cost.

Thus Resources sharing is a need-based concept founded on the sound principles of give and take. It is
not the quantum of exchange but the real desire to do so, that is essential to become part and parcel of the
important programme of resource sharing activities.

2.4 Need
There has been a voluminous growth of published documents in the recent part. As a result no library in

able to procure, process or store all documents that its users demand. According to Kent “ it is difficult to
anyone single library to acquire even one percent of the total document published in the world” due to one or
more of the following reasons:

     2.2.3 Resource  Sharing
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(i) Growth of Knowledge in different subjects
(ii) Rapid increase of literature and growth of publication
In the second half of the 20th century, the growth of new publication became unmanageable for traditional
libraries. Its impact was felt primarily in major programs and later by the smaller libraries. In the field of
Science and Technology alone about three million documents are published each year which includes articles,
conference papers, books, technical reports and these the rate doubles every eight to ten years according
to V.A. Kamath. There has been an alarming growth lately in journal articles.
According to Faxton Company in USA, the number of journal titles rose from 38,079 in 1974 to 1,04,714
in 1989 an increase of 175 percent
According to Conen, Two articles are generated in the sciences alone every minute or over 10 lakh articles
a year. Also fast production of literature takes in different places in different formats and in different subjects
(iii) Increasing trend of new born subjects and specialization
(iv) Limitations of funds
(v) Increase in the cost of publications
According to Faxton company in USA, the average price per serial title paid by college and university
libraries in 1979 was $50.11; by 1959 it has risen to $ 125.87. Scientific and technological libraries pay an
average of $ 234 per serial title a year.
The average price for foreign tittles has risen from $41.34 per title in 1976 to $143.09 in 1989
According to Bowker Annual 1989-90, the average prices of a monograph rose from $32..43 to $38.39
from 1986 to 1988
(vi) Increase in the number of members of user community teachers, scholars and students in universities.
(vii) The information needs of academic community being wide in scope and varied in nature
(viii) Such information needs being often repetitive and recurring
(ix) Lack of environment to make use of available computer and communication technology for efficient and
production use in libraries.
Therefore some resource sharing is necessary between one library and another library to acquire more
information in a specific subject with low cost as published records are increasing at on incredible rate and
their prices are keeping pace, is such circumstances library cooperation will assume a pivotal role and
resources sharing will become the focal point of cooperation.

2.5 Scope of Resource Sharing
The idea of resource sharing for a long time was restricted to the area of lending of books and periodicals
now it has become diversified and incorporated the various activities of the libraries such as abstracting and
indexing, acquisition, bibliographic access, Cataloging circulation, collection development continuing education
for staff and user, literature searching management and accounting, microfilming photo coping , processing,
referral services, storage and union lists. The resource sharing in modern times is helpful in the following four
main activities.
Acquiring books – selection, ordering and purchase, etc
Recording books- cataloging and classification
Making them available –their own books by consultations and lending books not held by them by borrowing
from elsewhere
Storing books – for present and future uses
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2.5.1 Shared acquisition:
The shared acquisition involves procurement of books, periodicals and other materials from publishers

and booksellers of foreign and own country through mutual agreement among the participating libraries. By
the process of shared acquisition the saving of money and time, avoiding wasteful duplications and building
up a sound and large cumulative collection is possible. The savings on this count may be utilized for further
utilization of documents to enrich the library collection.

All the acquisition activities such as placing order, reminding the suppliers, passing bills and other activities,
besides book selection can be reduced to a great extent through co-operative acquisition of documentation.
This may bring down cost, care discount and save time and labor of individual libraries participating in the
system. The various problems associated with subscribing foreign journals can be avoided through cooperative
acquisition.

2.5.2 Shared cataloguing:
The processing of library materials is claimed to be the highest shares of bottleneck in library work.

Serious attentions being paid to document processing under the concept or resource sharing. The shared
cataloguing projects of USA, UK, Australia and Canada have shown how processing work could be done
very effectively, and economically, saving lot of time, effort and money. The on-line computer Library center
(OCLC) project and the library of congress shared cataloging projects have shown how shared processing
of library documents can undertaken and how the individual libraries can save their time and lab our.

2.5.3 Future Scenario:
The future scenario of resources sharing could be termed as ‘Global resources sharing interconnections’

Not only are these interconnection going to grow because of INTERNET and electronic publishing, but
their growing trends are felt at various regional groupings two. There will be a gradual move towards greater
integration of services and resources sharing.

2.6 Resource Sharing through Network
As indicated earlier, the past few decades have witnessed knowledge and information explosion the

world over and inadequate financial resources to do the best in terms of dissemination of knowledge and
information. Under these circumstances, resource sharing and cooperative functioning of libraries and
information centres through networking becomes vital. Efficient resource sharing can be achieved by using
recent advances in Information Technology, i.e. networking of libraries and information centres through
Local Area Networks, Metropolitan Area Networks, Wide Area Network and so on.

Network of information/Resource sharing is to use the computer and telecom link for transmission of
information or data from one library to another. Keeping this concept in view, various library networks have
been established for cooperation and resource sharing among libraries. They have grown mostly during the
last thirty years in different geographical environments in order to cater to the specific needs of users. In the
United States, there has been a proliferation of them. Library networks in other countries are also growing.
Several models have emerged that provide specific services. Not all networks conform to the essential
functions of library networks. However, it is noted that the essential functions should include: promotion of
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resource sharing, creation of resource sharing tools like bibliographic databases such as union lists of serials,
union catalogue of books, periodicals, bibliographic databases of articles and other types of materials such
as CDs, Video recording, sound recording, theses, dissertations etc., rationalization of acquisition, adoption
of international standards for creation of records uniformly, delivery of documents, etc.

2.7 India
In India, as elsewhere, economic pressures, enormous growth of publications and emergence of subject

specialization have compelled the libraries and information centres to think of sharing the information resources
and optimizing the use of existing resources within India as well as from abroad through various networking
systems. Some of the notable networks in India are NICNET, ERNET, SIRNET, INDONET and INET. In
addition, there is a major initiative from the University Grants Commission called INFLIBNET, interconnecting
universities, colleges and resource institutions countrywide.

2.7.1 National Level Resource Sharing
As stated earlier, INFLIBNET, a national level resource sharing of university libraries was set up in

1986 under Professor Yashpal Kapoor, the Chairman of UGC, INFLIBNET is a multiple functions/service
network with focus on resource sharing and cooperation through computer communication links. It is very
useful to all libraries and their readers. For this purpose, it is possible to create data banks in different
subject fields, produce a number of bibliographical tools and information services. It is also possible to
conserve a lot of library resource avoiding duplication at the national level.

But under the present conditions, it is not congenial to initiate a network of libraries at the national level,
because all universities in India depend on the finance from central and state governments. The various
universities have their own district characteristics based on factors such as geographical, linguistic and
political. Each university library is following its own pattern and procedure in its routine work. For this
reason, there is no uniformity and standardization. However, such a networking can be initiated in a limited
environment, regional or state level.

2.7.2 State Level Resource Sharing
In India, formation of a network of university libraries in all states is possible only if the concerned administrative
and professional staff and supporting agency make a sincere attempt in this direction. They should plan to
co-ordinate programmes of all universities in the state to form a uniform academic calendar. They have to
establish a body like Council of Higher Education to initiate a network of libraries in the state say
KAULIBNET (Karnataka State University Library Network) in the interest of larger academic community.
They should bring all the affiliated colleges within the fold of state level library network and extend the
services to colleges.

It is not difficult to bring uniformity and adopt a standard procedure in all participating libraries within
the state. After achieving the success in running the network at the state level, it is possible to link all such
state level networks to the national level network. Further, it will not be difficult to link university libraries
network with specialized networks in the field of library and information in India, using sophisticated modern
technology and satellite facilities.
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2.7.3 City Level Resource Sharing
Specialized library networks have come up for individual cities like DELNET, CALIBNET,

MALIBNET, PUNENET, BALNET, ADINET, BONET, MYLIBNET, etc. These networks are meant
essentially for providing a centralized database of library information to be accessed by its user libraries,
mostly in a particular city for the purpose of resource sharing.

In the present day of limited resources, it is imperative that an integrated view of these networks and
National Information Systems and Centres on the possibility of sharing resources among them should be
taken to explore avoiding duplication of efforts, materials and resources and maximizing the utilization as
they form the base for successful networking. Access through any network in the globe can be obtained
virtually through INTERNET which is widely used international network.

2.8 Criticism of Resource Sharing
Resource sharing, despite its various advantages, has certain disadvantages too. The critics voice

concern on the following points:
If all libraries depend on resource sharing, no library will have books to lend;
If co-operative acquisition doesn’t operate well, serious gaps in the collection of a library will
result;
Without the sophisticated technology, resource sharing would have very limited  value;
Cost consideration may not permit resource sharing;
The reaction of the publishing trade, if their sale gets reduced;
Large libraries have to share a greater burden of lender rather than borrower which is not beneficial
to them.

 The criticism of resource sharing is no doubt sound and partially valid. But there seems to be no alternative
to this. INSDOC’s document supply service is an example which has been continuing for over the last four
decades. INSDOC sources approximately 28,000 orders annually.
We may conclude that Library co-operation is the key to the successful functioning of a library and without
it, it cannot provide effective service to its users. Without cooperation, it is impossible to start sharing of
resources. We notice that the sharing of resources can help:

acquire library materials;
share holdings;
provide researchers with an increased number of research materials;
avoid duplicate purchases;
ensure collection of special material and services;
establish efficient communication systems;
prepare union catalogue; and
develop an information marketing mechanism through cooperation and control of the quality of
collections.

2.9 Steps to Promote Resource Sharing through Network
As we have seen networking of libraries is essential for sharing of library resources, the same should

be promoted at local, regional, national and international level. Following steps are to be taken to promote
resource sharing through networks:
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o Important libraries, information centres and institutions get their catalogues and     bibliographies

prepared in machine readable form to provide computer aided information services to users and promoting
automation of the functions in their libraries such as cataloguing, circulation, preparation of bibliographies,
union catalogue, etc.

o To promote sharing of resources among the libraries in India by developing and disseminating
information and by offering computerized services to the users.

o To optimize information resources utilization through shared cataloguing, interlibrary loan services,
catalogue production, collection development and avoiding duplication in acquisition to the extent possible.

o Encourage cooperation among libraries, documentation centers and information centers so that
pooled resources can augment weaker resources centers.

o The promotion of non-bibliographic databases in India, especially by National Informatics Center
has enabled institutions to perfect computer and networking technology.

o In house functions like acquisition, cataloguing, classification, serial control, circulation, SDI, current
awareness services, etc; the network should support these library operations and the libraries should use
the data in the central port for this purpose.

o The participating libraries should follow the rules and regulations of the network and be willing to
create bibliographic records according to standards laid down.

o Anglo-American Cataloguing Rules (AACR-2) should be used as the code for cataloguing. It will
help in creation of standard records.

o Library of Congress Subject Headings (LCSH) should be used as a guide for creating subject
descriptors. Other thesauri available on specialized subjects could also be used whenever needed in
specialized libraries.

o The network should provide technical assistance to participating libraries in the creation of bibliographic
databases.

o A panel of experts should be maintained for providing assistance to libraries.
o A central host machine should be installed for creating a union catalogue, combining catalogues of all

participating libraries.
o As libraries in India use mainly Dewey Decimal Classification (DDC), Universal Decimal Classification

(UDC) and Classified Catalogue Code (CCC) for classification of books, it would not be within the
means and worth the effort to have one classification scheme in all participating libraries.

o The network should promote inter-library service and sharing of foreign periodicals should be
attempted. As far as possible, foreign exchange should be saved on avoidable duplication titles. A courier
service should be established to support the sharing of resources.

o All serials should also be published in electronic format and the availability of serials in electronic
format, either outline or CD-ROM.

o Most of the abstracting and indexing services have cumulated the entries forming into databases,
which can be searched online.

o Networking activities should increase in India. Government should take an interest in this field.
Some of the important networks established are NICNET, I-NET, ERNET, SIRNET, INFLIBNET.

Thus we see that with this network, we can pool together all resources of all libraries, resources of all
universities, colleges, research institutions, various departments and also the resources of individuals. It will
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be possible for us to acquire a greater number of information sources taken together in all the libraries in the
country. These can inter-connect people, i.e. students, teachers, researchers, users, etc. It is, therefore,
assumed and expected that in order to have quick access by educated or creative member of the society to
whatever is happening in their own country or the world over, networks are considered as a boon.

2.10 Self Check Excerise
1. What do you mean by resource sharing?

2. Write definition of resource sharing.

3. Explain steps to promote resource sharing through network.
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3.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the topology;
• Types of Topology;
• Configuration of topology;
• Use of topology in computer network.

3.1 Introduction

A topology refers to a network layout that identifies how the computers and other devices would be
connected with each other. It is a logical arrangement of notes that determines the manner in which the data
would be transmitted between any two network nodes. There are five major types of network topologies as
given below:

1. Bus
2. Star
3. Ring
4. Mesh
5. Hierarchical

2.3.1 Network Topology
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3.1.1 Bus Topology

It uses a common cable to connect all the computers and devices in a network. This means that a
single cable functions as the shared communication medium for all the network devices. In this topology, the
data is transferred using the broadcasting method of transmission. In this method, the source node sends a
broadcast message on to the cable, which is visible to all other nodes. However, only the target destination
node actually processes the message. As soon as the transmissions begin, the transmission signal travels
through the cable from one end to another of the topology. A device called terminator is attached to the both
ends.
The bus topology, however allows limited devices to form a part of the network. Therefore, it is suitable for
small networks. If any problem occurs in the main cable, the whole network stops functioning. Bus topology
provides various advantages like:

• Easy setup
• Cheap as it requires less number of cables
• Support for easy expansion of the network

Bus topology has some limitations, which include:
• Slow speed due to heavy traffic
• Support of message transmission by only a single computer at a time
• Difficult to troubleshoot

Figure.1 Bus Topology

3.1.2 Star Topology
It is the most popular topology for home and office network. In this topology, each computer in the

network is connected to a central device forming a shape of the star. Besides hub, switch or a router is also
used as a central device.

Similar to bus topology, star topology also implements the broadcasting method of transmitting data.
Here the message transmitted from source node passed to the central device before reaching the destination.

The main advantage of star topology over bus topology is that the network continues to function
even if one of the network nodes fails. However, if the central device fails, the whole network will automatically
collapse. Star topology provides various advantages, which include
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• Simple Setup
• Support for easy modification in the network by adding or removing computers without affecting

the rest of the network
• Easy detection of network faults by monitoring the central device.

Star topology has certain limitations viz.
• More cable requirements than bus topology
• Expensive due to more cabling requirements

Figure.2 Star topology

3.1.3 Ring Topology
It refers to a network layout node in which each node is connected to exactly two other nodes.

This connection continues until the last node is connected to the first node, which forms a circular path. In
this topology, the data flow is unidirectional where each node transmits data to the next node until the
transmitted data reaches the destination node.

Therefore, unlike bus topology, ring topology is referred to as an active network and does not
have terminator. Ring Topology implements the token passing method for transmitting the data through the
network. A token refers to a small packet that continuously loops through the network. When a node
wants to send a message as a data package, it requires the token and attaches the data packet to it. The
destination node transmits the packet back with an acknowledgement of the received packet. Finally, the
source node places the token back on the network. However, if there is any problem with any node or
cable in the network, the entire network will automatically collapse. Ring Topology provides various
advantages, which include:
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• Support for big networks
• Good performance under heavy network load

Ring Topology however, has certain limitations viz.
• Negative impact on network performance while moving and adding nodes
• Slower under normal network load

                                                      Figure.3 Ring topology

3.1.4 Mesh Topology
It is a network layout where more than one connection exists between any two nodes. Here each

node is connected to all the remaining nodes using a separate cable. Such an arrangement is referred to as
a fully connected Mesh Topology. However it is possible to setup the topology where only few nodes are
connected to more than one node in the network. This arrangement is referred to as the partially connected
network. This means that mesh topology allows setting more than one path between any two network
nodes.

The mesh arrangement is useful when a specific path fails to transmit data due to the failure of a node
existing in the path. In this case, one of the paths from the remaining paths can be selected to transmit data.
Mesh topology transmits data by selecting the shortest available path that is identified using the router.
Router remains a table of paths from which it selects the shortest path from the required source node to the
destination node. Mesh topology provides various advantages which includes

• Reliability and efficiency
• Support for easy network expansion without affecting the functioning of network.

Mesh topology has certain limitations viz.
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      • More cabling requirements
      • Difficult implementation of the network
      • Expensive due to full connection requirements among the nodes

Figure.4 Mesh topology

3.1.5 Hierarchical Topology
It refers to connecting the network nodes in a hierarchical order. Here, a route node existing at the

top of the hierarchy connects to the other nodes existing at one level lower in the hierarchy. The position of
the root node is known as the root level and the subsequent levels are referred to as the second level, third
level and so on. Nodes in the second level are further connected to the nodes in the third level. In this manner,
multiple levels exist in this network structure. The root node is responsible for monitoring and controlling the
entire network. Any failure in root node will bring down the network. This topology is also referred as the
tree topology.

  Hierarchical topology provides various advantages which include:
• Easy maintenance as adding nodes at any level does not affect the network.
• Easy troubleshooting

  Hierarchical topology has certain limitations viz.
• Expensive
• Difficult configuration
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Figure.5 Hierarchical Topology

3.2  Self-Check Exercise
1. What is topology?

2. How topology is useful in computer network?

3. Enumerate the types of topology.

3.3 REFERENCES

1. http://www.bukisa.com/articles/363211_ring-topology-diagram-advantages-and-disadvantages
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  4.0 OBJECTIVES
After reading this Chapter, you will be able to:

• Understand the library networks;
• Types of network;
• Networks connecting to library in India;
• Implications of networking in library;
• Understand the network transmission;
• Baseband or broadband;
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• Types of network transmission;
• Network transmission media

.4.1 INTRODUCTION
The rapid and exponential growth of information has made it necessary for librarians andinformation

professionals to take up new techniques to deal with with the massive proliferation of literature in all subjects
fields Research in the science and social sciences has led to high productivity in document publications. To
bring this vast amount of information under bibliographic control and to render it useful and accessible to
potential users is a task of great magnitude which the information people face. So through the application of
communication techniques and electronic data processing, library and information centers have now begun
to realize the need of computers and associated facilities as indispensable for steady and accurate storage,
processing, retrieval and dissemination of information and above all sharing resources among libraries.
For libraries to use their resources more efficiently and effectively for the users is a great task. This task can
be solved to a great extent by resource sharing and cooperative functioning among libraries. And for this,
networking of libraries, applying latest modern techniques is a must.In India, networking of libraries is even
more necessary than in the developed nations. 

The important factors that may be considered for networking of resources (Libraries holding resources)
in India are:

It is not possible for all the organizations and agencies to design a system to cater to its resource
needs because their main aim is to provide resources rather than designing the system for providing
resources. So they have to purchase an appropriate latest system to cater to their needs. Generally,
it is very difficult or rather impossible to find a system which could entirely satisfy its needs. In India,
manually such technologies are purchased from abroad and afterwards people face a number of
maintenance problems. So while opting for networking, annual hardware maintenance, some initial
training is required.
The cumulative collection of scientific serials held by many important libraries in India is quite poor
when compared to USA, UK and other developed countries while in India, some libraries have a
very good collection, the majority of libraries suffer from very inadequate collection. There is a great
need to consider the entire resources of the country as a single entity that can be available to the
entire user community of the country. Networking the libraries is the best way to make resource
sharing very effective in order to ensure equitable availability of required information.
Literature being generated as a result of research activities being carried out is doubling every five
years. Over 10 million journal articles are published every year besides news items, editorials and
articles appearing in popular print media. It is not possible for all the libraries and information
centers to acquire all the bibliographic material at one place due to storage problem as well as
paucity of funds. Even to maintain a reasonable level of acquisition of journals, books and reports,
calls for heavy budgets in libraries. Therefore, networking with other institutions, libraries, information
centers, etc. is easy and economical way to get what a particular center does not have in its capacity.
Budget to the libraries/information centers/institutions and restriction on staffing has also forced
institutes to opt for networking in the country and this is on the increasing trend. As for example, it
is not possible to give a laser printer to each individual in many of the organizations, so best way to
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provide printing facilities to each of them is put the printer in the network and let all the computers
users share it by way of networking operating system.
Similar methods can be adopted to share other hardware resources like Modem, CD-ROM drive,
etc.
India is a vast country with caste, cultural and linguistic diversities. Planning for their development is
done at the center only. Planning for such a big country by sitting in the capital requires an extremely
fast flow of information from all parts of the country to the center. This can be done effectively by
networking all the information centers in the states with the center. Poor infrastructure is a hindrance
in this flow of information. With the introduction of better telecom facilities like optical fibers, satellite
communication, powerful computer, this is likely to increase but still many parts of the country do
not have these facilities.

Because of the above mentioned reasons, resource sharing and cooperative functioning through networking
have become inescapable for libraries and information centers in this country.

4.2 National Efforts and Status of Networks

4.2.1 National Efforts
There have been many attempts in the country in the last two decades in computer application to library and
information activities. During last so many years, libraries and information centres have become more earnest
to computerize their operations and services. While NISSAT (National Information System for Science &
Technology) has been promoting an integrated approach in library automation in the country, the efforts have
been by and large, at the institutional level. Some of the major organizations engaged in computerized
information handling are:

BARC - Bhabha Atomic Research Centre, Mumbai

DESIDOC - Defence Scientific Information and Documentation Centre,Delhi

DRTC - Documentation Research and Training Centre, Bangalore

IISc - Indian Institute of Science, Bangalore

IIT - Indian Institute of Technology (Delhi, Chennai, Kanpur)

INSDOC - Indian National Scientific Documentation Centre, New Delhi

NIC - National Informatics Centre, New Delhi

NISSAT - National Information System for Science and Technology, New Delhi

PRL - Physical Research Laboratory, Ahmedabad

TIFR - Tata Institute of Fundamental Research, Mumbai
Besides the above, University Grants Commission (UGC), Department of Electronics, Department of
Telecommunication, Planning Commission and other various Departments of Government of India have also
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been engaged in establishing various networks. There are possibilities of mounting bibliographical databases
on these networks for providing online access-to-access.
The growth of Indian Library Networks may be traced to the efforts made during the last forty years. The
chronology is given below:
1958 : 1958 Scientific Policy Resolution. It was adopted at the instance of Pt. Jawaharlal Nehru. It
emphasized the fostering of scientific temper in people. In pursuance of this agenda, several committees
and commissions were appointed to look into specific issues and come up with necessary
recommendations.
1959 : Sinha Committee Report
1965 : Ranganathan Report to University Grants Commission (UGC)
1972 : V A Kamath Report
1977 : Establishment of NICNET by NIC (1975)
1983 : Technology Policy Statement. It emphasized the need for a technology information base.
1984 : Working group of the Planning Commission headed by Dr N Seshagiri recommended to the
govt. the need for modernization of library services and information during Seventh Five Year Plan
(1985-90)
1986 : NISSAT initiated the establishment of CALIBNET, Calcutta
1988 : The National Policy in Library and Information System submitted in 1988. It recommended
using of information technology on a national level.
1988 : The UGC established INFLIBNET
1992 : NISSAT supported the establishment of DELNET, DELHI
1993 : NISSAT supported the establishment of ADINET, Ahmedabad.
1993 : INSDOC supported the formation of MALIBNET, Chennai.
1994 : NISSAT supported the establishment of MYLIBNET, Mysore
1995 : NISSAT supported the establishment of BALNET, Bangalore

4.3 Planning Commission Efforts
The Planning Commission, Government of India, has been taking considerable interest in library

resource sharing and library networks. Its efforts in these areas have increased since the Seventh Five Year
Plan covering 1985-90. The Commission appointed a working group on modernization of Library Services
and Informatics in November, 1983. In July 1984, the working group submitted its report. It recommended
among others, interlinking of library systems through library networks. This report was to be considered for
the Seventh Plan.

The Commission appointed another Working Group which submitted its report in May, 1989. It
again recommended among others interlinking of library systems in the country.
The Planning Commission appointed in Feb, 1995, a Core Task Group to prepare an approach paper for
enhancing inputs of Science and Technology for library resource sharing.
The Commission again constituted a working group on Libraries and Informatics under the Department of
Culture, Ministry of Human Resource Development, Govt. of India, which report was to be considered for
the Ninth Plan for the period 1997-2002. The report of the Working Group of the Commission includes
many important recommendations for the networking and modernization of libraries in the country.
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All these initiatives by NISSAT, UGC, Planning Commission and other departments of Govt. of India have
led to increased efforts to the establishment of library networks and library automation in the country.  

4.4     Networks in India
Current computer Networks in India can be decided into three categories:

4.4.1 Networks connecting Educational and Research Institutions all over the country

4.4.1.1 ERNET – Education and Research Network
It was launched by the Department of Education (DOE), Govt. of India in late 1986 with financial

assistance from UNDP (United Nationals Development Programme) to provide academic and research
institutions with electronic mail facilities. It is currently used by DSIR Labs, research centres and academic
institutions.
4.4.1.2 SIRNET – Scientific and Industrial Research Network

It was established by INSDOC in late 1989 to interconnect all the CSIR aboratories and other
R&D institutions in India. Its main objective is to harness the vast S&T information resources available with
national laboratories and inculcate the habit of resource sharing among themselves. Its ultimate aim is to link
the entire scientific community of the nation with the national library system and the international links to
achieve efficient scientific communication.
4.4.1.3 OPNET – Open Education Network

Open University Network – Many institutions are venturing into the field of  education and are
offering professional and technological courses by using communication technologies. They are using television,
computer communication, email and network to reach the students. Indira Gandhi National Open University
(IGNOU), which is an apex body for open and distance education, is engaged in the task of developing a
network of open universities in India called OPNET. This is a network of physical, intellectual and academic
resource organized under the aegis of the Distance Education Council (DEC), an independent arm of 
IGNOU and distance education in India. All the open universities are partners of OPNET. The resources
that are pooled together include academic programmes, norms and sharing programmes, delivery mechanisms
and interactive software for student services. The OPNET will be an umbrella network with the subnet of
every partner university for delivery of their own courses. 

4.4.2 Networks connecting the libraries in the country

4.4.2.1INFLIBNET: established by UGC in 1988, operations began in 1991. It is a network of university
and college libraries. It has also provided financial assistance to a large number of university libraries in India.

4.4.2.2 CALIBNET:  established by NISSAT in 1986. NISSAT decided to establish a network of scientific
libraries in Calcutta. At a meeting in 1986 in Calcutta, DSIR initiated action for preparation of a feasibility
study for networking about 40 libraries in Calcutta. CALIBNET was the first library network visualized. At
present, it has now become the center for CD-ROM databases which are acquired from outside sources.
Libraries can access these CDs. The basic purpose of the library network is to share the resources available
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in participating libraries. However, no resource sharing is done as there are no union catalogues prepared.
This activity, is however, in progress.

4.4.2.3 DELNET: established in 1988 by India International Center with the initial financial support of
NISSAT and later officially registered as a society in June 1992. Its main objective is to promote sharing of
resources among the libraries located in Delhi and outside Delhi. It is the first operational library network in
India.

4.4.2.4 MALIBNET: The need for interconnecting libraries and information centres in Chennai was visualized
by INSDOC in 1991. INSDOC undertook a feasibility study which was completed in March 1992.
MALIBNET was registered as a society in Chennai in Feb. 1993.

4.4.2.5 PUNENET in Pune in 1992 

4.4.2.6 ADINET in Ahmedabad in 1993

4.4.2.7 BONET in Mumbai in 1994

4.4.2.8 MYLIBNET in Mysore in 1994

4.4.2.9 BALNET in Bangalore in 1995
All these networks are supported by NISSAT. They have not, as yet, created their value added

databases such as union catalogues, though work is in progress. They are, at present, mostly offering Email
and CD-ROM facilities

4.4.3 Other Networks

4.4.3.1  NICNET
It was established by National Informatics Centre (NIC) in 1977 and started in the late 87’s. It was

launched basically for getting and providing information from/to district levels to facilitate planning process.
It links for regional nodes at Delhi, Pune, Bhubneswar and Hyderabad and has established 32 nodes at state
and union territory levels and 439 nodes at district headquarters. By 1991, NICNET has achieved success
in the creation of databases and networking. It also provides E-mail and other facilities to users using its
already existing infrastructure.
4.4.3.2  INDONET

India’s first data communication and computer network was started in March 1986 by CMC Ltd. It
was launched as a solution to the growing need for providing timely well processed data to various institutions.
In the First phase, they have mainly networked Mumbai, Calcutta and Chennai. Later, Delhi and Hyderabad
were also linked as additional stations. INDONET presently has an international gateway which provides
access to world wide pocket switched networks like USA’s Global Networks Systems (GNS) and Internet.
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4.5 Present Scenario of Library Networking in India
The present status of library networking in India is that most of the libraries covered by some network

are creating databases of their holdings and in automating the library activities. Generally, the periodical
holdings are attempted first in building up the databases as it takes less time than for the other types of library
documents. This is followed by the databases of holdings of books, reports, dissertations, standards, etc. The
Library Network Centres, i.e., the coordinating agencies of the networks also are concentrating on acquiring
them to provide the user with access to the total records. They provide such access either by email or online
through the telephone network. In addition, these centres also try to provide a common software for database
development and automation of library activities and services.

Table below gives the details of status of some important library networks in the country.

2.4.8

 Starting
Promoting
Agency

Whether

a society
registered as  Name

 Year of
other activities

Database development &

ADINET
Ahmedabad

1993 Society,
INFLIBNET
& NISSAT

  •   Library holding database in progress
• Library automation in progress
•  Training programme
•  Database of current   periodicals
    in member  Llibraries

BALINET
(Bangalore)

     1995        NISSAT               Yes

Yes

•  Activity will start after
   getting financial support
   from NISSAT

BONET
(Mubai)

1994 NCST &
NISSAT

No

• Online union catalogue of periodicals
•  Online request system for ILL
•   E-mail and Internet access
•   Online searching of foreign database

   •  Database on computer and as are
       software

•   CD-ROM database searching
•   Database of contents of
    Indian periodicals
•  Software for OPAC
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However, this scenario networks doesn’t provide a growth of ideal library networks in India. From the above
table, it can be seen that except DELNET and INFLIBNET, most of the other library networks have yet to
develop databases of library holdings in a significant way. Even these two networks have to go a long way, to
cover in their databases, the entire holdings of all the participating libraries. Unless this is achieved, the
networks would not be able to achieve significant resource sharing as well as rationalization in library acquisitions.
Most of the networks are, however, making efforts towards this end by conducting training programmes for
the staff of the participating libraries in data capturing, database development and automation of library
activities and services.

•   Access to Internet and Dialog

•   CD-ROM database searching

DELNET
(Delhi)

1990
(1988)

Society, NIC
& NISSAT

Yes        •  Books database
       •  Multi-lingual book database
       •   E-mail service
       •   Union list of current periodicals
       •  Database of Indian specialists
       •  Online searching of foreign databases

INFLIBNET 1991
(1988)

UGC Yes          •  Union catalogue of 50,000 records
         •  Database of periodicals (30,000 records)
         •   Contents with Abstract Services (COPSAT)

•   Training programme for university library staff

MALIBNET
(Chennai)

1993 Society &
INSDOC Yes •  Current serials database

•  Journal contents database (1,00,000) records
•  All INSDOC databases on MALIBNET
•   Automative engineering database (4,500 records)
•   Access to Internet and Knight Ridder
    (Dialog) database
•   CD-ROM database searching

MYLIBNET
(Mysore)

1994 Society,
Mysore Library
Consotium &
 NISSAT

Yes •  Library automation in progress

                                            PUNENET
(Pune) 1992

2.4.70

CALIBNET
(Calcutta)

1992
(1986)

NISSAT Yes •   Library automation in progress
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4.6 Networking of Public libraries
The public libraries in the west have developed into a true community information and reference systems with
such computerized data access and facilities for providing a variety of information to the general public from
housing and social security to legal and medical aid and temperature and travel schedule.

In India, development of public libraries has not been a priority and their growth as a result has been uneven.
Public libraries which could serve as the backbones of literacy mission, suffer for want of adequate funds,
trained staff, modern equipment, good and adequate collections, proper reading rooms and stacking and
user facilities. In order to provide to the public, access to the latest information and educate them, public
libraries have to be technologically advanced so that they have access to INTERNET and international
databases and networks.

According to UNESCO public library Manifesto 1994 (Revised)
“The public library acts as a living force for education, culture and information and as an essential agent for
the fostering of peace and spiritual welfare through the minds of men and women”The Manifesto recommends
that”The public library network must be designed in relation to national, regional, research and special
libraries as well as libraries in schools, colleges and universities”.

So there is a need to establish a public library network which is in conformity with the other networks in the
country. Due to lack of up-d-date, actual number of public libraries could not be ascertained, however,
nearly about 60,000 exist in the country. They can’t be called libraries in the real sense as most of them are
simply reading rooms. Most of them are without computers and the librarians working in the distances in
general, are not conversant with the application of computers in libraries. Training of library staff in the
computer applications for library operations and services becomes one of the basic requirements of automation
and networking. In the rural areas, as rural settlement are generally scattered and their libraries are neither
up-to-date nor well staffed. Since the level of users is not of a high standing and also various problems in
information infrastructure, it is not possible in the first phase to connect rural libraries with the public libraries
network for networking purposes.  However, with the wide use of telecommunication technology, it is possible
for institution located in remote area to join the network. Therefore, we notice that if the public libraries are
to really reach the public and achieve the status of national network system, the adaptation of new sophisticated
techniques and technologies is a highly important pre-requisite. We must change with the times and learn
from the latest trends in the west. For this, we have to develop the infrastructure of public libraries and give
attention to the manpower development, training given in the use of computers, AACR-II, use of MARC
format Library Congress subject headings, handling of software, etc. and use of electronic mail and INTERNET.

4.7 Problems of Library Networks
As we have seen in the previous Chapters, Library Networks help us in the dissemination of information in
cooperative manner where all the concerned libraries pool their resources, and use them , thus ensuring the
optimum utilization of resources. But behind setting up a library network and utilize its services, there is a lot
of problems facing the Library/Information professionals. Some recent studies have shown the following as
major problems to be considered:
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 4.7.1 Status of Libraries
The status of Libraries, especially in developing countries like India is not so good. No much importance is
given to libraries and library professionals compared to other fields. There is lack of growth of libraries in our
country due to negligence on the pat of the Government as well as lack of will on the part of the library staff.

4.7.2 Lack of education and training
Library Networks need educated and trained staff to sustain and run smoothly. Due to attitude of certain
traditional library staff, they hesitate to learn new technology which is essential in this age. Library automation
is pre requisite for starting a Library Network. Library automation can not be achieved without learning new
technology

4.7.3 Technical and training facilities problem
There is problem of availability of training facilities. Every Library/Information staff should be given training in
the field of networking and library automation. In our country, every library/information center should be
provided with adequate training facility which is not so in the present context.

4.7.4 Lack of finance
Initially Library Networking needs resources for the development and contacts with other institutions for its
expansion, which is lacking in the country.

4.7.5 Problems at center
Even if an institution manages some funds there is problem of resource allocation. Often imbalance resource
and personnel creates problem for further development of the networks.
Software problems, language problems in shared cataloguing systems, database design problems,etc.

4.7.6 Compatibility among systems/database
Actually various networks employ different techniques for the construction of the database of their

holdings. They do not follow any common approach. So there is problem of compatibility among various
systems and databases.

4.7.7 Problems with standardization
In India, due to presence of various regional languages, there is problem of standardization. Any

standard can not be so much effective.

Problems in acquiring information from international inter government organizations
In several countries, various government organizations do not show willingness in providing information. It
might be due to internal security problem or simply hide the information from others in Science and Technology
fields.

4.7.8 Problems while searching on-line
The world over, various networks are established in different languages. There are multiple command

languages.One has to study various systems and databases for searching purpose.
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4.7.9 Independent development of major networks

This is a major problem in our country. The development of Library networks in isolation creates
the problem of standardization and coordination among various networks. Also a new library network has
to spend much more resources in developing a network. If a new starting-network employ the methodology
of an already developed and successful network, it can certainly minimize the cost for developing the network.
With mutual understanding they can themselves consult each other in their respective fields of expertise.
 
4.8 Implications of Networking

The implications of Resource Sharing Networks can be categorized into five types. They pertain
to staff, activities, cost, technology and time.

4.8.1 Implications pertaining to Staff
Networking means sharing of special staff skills in specific areas for training, answering of information

requests, bibliographical assistance, processing, etc. It emphasizes the importance and need for higher level
of reference assistance to readers. For this to achieve, it implies the need for training and retraining of
reference librarians to meet the demands of networking and sharing.Networking will surely demand from
librarians and library administrators more time , skill and patience than are presently required of them. In
addition, it requires a change in the attitudes of librarians and other staff.

4.8.2 Implications pertaining to activities in Libraries
Collaborative development of resources including provision for cooperative acquisition of rare and

research materials, and for strengthening local resources for currently used material is expected for successful
running of a network. The development of multimedia resources is essential. There is need for identification
of primary patron groups and provision for assignment of responsibility for information service to all within
the network. Identification of levels of service that provide basic as well as special needs of patron groups,
and distribution of each service type among the needs is required.

There must be provision for “referral” as well as “relay” and for “document” as well as “information”
transfer. Critical implications of growth of networks would lead to questions of limits of size and growth,
optimal size for computerized bibliographical network,etc. Development of evaluation criteria and procedures
to provide feedback from users and operators and means for network evaluation and modification to meet
specified operational utility needs to be developed.

4.8.3 Implications pertaining to Cost
Networking goal of improved access implies that it involves real cost and , therefore, it cannot be

viewed as a panacea or easy means to reduced expenditure of member libraries.It means sharing of cost of
telecommunications networks and of common functions of network by the member libraries.

4.8.4 Implications pertaining to Time
Availability through Networking implies delay in obtaining a particular item not held locally. Access

to larger and larger resource/collection would cause access/search time to go up. However, this access time
is much lower than the traditional manual search within a library.
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4.8.5 Implications pertaining to Technology
After all a technology helps a person in getting or developing a new-one in a comfortable manner in

less time and with less cost, not sacrificing the accuracy. So, a Networking System should be simple to use
if electronic excommunication by an unforgiving operating system is to be avoided.

4.9Network Transmission

4.9.1  Introduction
The internet consists of millions of digital passages that carry signals all over the world. These conduits,
which connect us to the world wide web (www), come in many shapes, sizes, and modes. The bewildering
assortment and seemingly endless conduits, more commonly referred to as communication media, that are
used to connect computers together can be boiled down to two types: conductive cable and wireless.
Conductive media is simply a hard-wired connection, which requires someone to physically join network
devices with some type of cable. The three major types of cable are coaxial, twisted pair, and fiber optic.
The focus of this Chapter will be on conducted communications media. Wireless communication is the
alternative to conducted communications media. This is accomplished using a variety of broad-cast
transmission technologies, including terrestrial microware and satellite communications. To aid in understanding
conductive communications media, a short explanation of network transmission basics will be discussed.

4.9.2 Network Transmission Basics
When computer communicate over the Internet or on private networks, they must follow certain
communication protocols. In easy way, each computer that connects to a network must follow rules that
govern the type of hardware and software that is used for access to the network. The protocols consist of
signal types and speeds, cable layouts, and communications access schemes.

4.9.3 Baseband or Broadband

Bandwidth is the range of frequencies that a particular network transmission media can carry. It also reveals
the maximum amount of data that can be carried on the medium. A baseband transmission is a single, fixed
signal that uses the entire available bandwidth. Baseband signals use a single channel to communicate with
devices on a network, which allows computers to transmit and receive data on one cable (Tittel & Johnson,
2001). Baseband communications are typically used for local area network (LANs). This environment is
ideal for baseband transmissions because it is self-contained within a single location, where network traffic
can be easily mentiored and controlled. When LANs expand into a metropolitan area network (MAN) or
a wide area network (WAN), baseband systems do not provide the bandwidths that are adequate for these
larger networks. A MAN consists of several LANs within a metropolitan area. WANs are similar to MANs
in that they cover a wider, possibly international, geographical area.

Network connections that attach several LANs together, such as MANs or WANs, or that allow remote
access from external users or networks to local server often require multichannel bandwidths because of
increased signal traffic flow. Broadband transmissions help to meet these needs. In Contrast to the discrete
digital signals produced in baseband communications, broadband transmission generates an analog carrier
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frequency, which carries multiple digital signals or multiple channels. This concept is much like cable television
systems that carry many channels on one cable.

The decision to use baseband or broadband is determined by the application. If the network consists of a
single LAN, baseband would be the best choice. If an organization has computer networks that spread
over several geographical areas, there might be a need for multiple channels of communications between
locations, which can be achieved only it is not necessarily the transmission media that determines whether a
signal is baseband or broadband. It is the function of the devices that connect to the cable.

 4.9.4 Types of Network Transmission

There are different types of network transmission, for the most part, networking comprises of two types of
data transmission, namely serial and parallel transmission.

4.9.4.1 Serial Transmission

This is a relatively simple method, where bits are transferred along a single wire to the destination one bit at
a time. This method is commonly used where transmission is over long distances, this is a slower method
however more efficient relatively. They are usually used to transfer data along different computer systems or
to an external device some distance away.

4.9.4.2 Parallel Transmission

Here bits are sent along several individual wires at a time to the destination, bits are transferred simultaneously.
This method is evidently faster as several bits are transferred at a time however this method is suitable when
transferring data along short distances only as over long distances the bits tend to muddle up resulting in a
failed transfer. Parallel transmission is usually used to transfer data within a computer system (short distance)
or maybe to an external device which is at a relatively short distance away.

In a network both methods are effectively utilized to provide maximum efficiency and speed with data
transfer, their use is based on the average distance of data transfer, also at certain points along the network,
a serial-to-parallel (and vice versa) conversion may occur. That’s pretty much it when it comes to types of
data transmission in a network, there are other aspects like modes and topologies (the sequence at which
they are connected) which I will cover later on Computer Realm.

4.10 Network Transmission Media

Various physical media can be used to transport a stream of bits from one device to another. Each has its
own characteristics in terms of bandwidth, propagation delay, cost, and ease of installation and maintenance.
Media can be generally classified as guided (e.g. copper and fibre cable) and unguided (wireless) media.
The main categories of transmission media used in data communications networks are listed below (please
note that wireless transmission media will be dealt with elsewhere).

• Twisted pair copper cable

• Coaxial copper cable
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• Optical fibre

• Wireless transmission

]4.10.1 Twisted pair cable
Twisted pair copper cable is still widely used, due to its low cost and ease of installation. A twisted pair
consists of two insulated copper cables, twisted together to reduce electrical interference between adjacent
pairs of wires.

This type of cable is still used in the subscriber loop of the public telephone system (the connection between
a customer and the local telephone exchange), which can extend for several kilometres without amplification.
The subscriber loop is essentially an analogue transmission line, although twisted pair cables are also be
used in computer networks to carry digital signals over short distances.

The bandwidth of twisted pair cable depends on the diameter of wire used, and the length of the transmission
line. The type of cable currently used in local area networks has four pairs of wires. Until recently, category
5 or category 5E cable has been used, but category 6 is now used for most new installations. The main
difference between the various categories is in the data rate supported - category 6 cable will support
gigabit Ethernet.

 The main disadvantage of UTP cables in networks is that, due to the relatively high degree of attenuation
and a susceptibility to electromagnetic interference, high speed digital signals can only be reliably transmitted
over cable runs of 100 metres or less.

Figure.1 Unshielded twisted pair cable

5.5.1.2 Shielded Twisted Pair (STP) cable was introduced in the 1980s by IBM as the recommended cable
for their Token Ring network technology. It is similar to unshielded twisted pair cable except that each pair
is individually foil shielded, and the cable has a braided drain wire that is earthed at one end during installation.
The popularity of STP has declined for the following reasons:
• High cost of cable and connectors
• More difficult to install than UTP
• Ground loops can occur if incorrectly installed
• There is still a cable length limitation of 100 metres
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                                                        Figure.2 Shielded twisted pair cable

4.10.1.1 Unshielded twisted pair cable
4.10.1.2 Shielded Twisted Pair (STP)
4.10.2 Coaxial cable

A coaxial cable has a central copper wire core, surrounded by an insulating (dielectric) material.
Braided metal shielding surrounds the dielectric and helps to absorb unwanted external signals (noise),
preventing it from interfering with the data signal travelling along the core. A plastic sheath protects the cable
from damage. A terminating resistor is used at each end of the cable to prevent transmitted signals from
being reflected back down the cable. The following diagram illustrates the basic construction of a coaxial
cable.

                               

                                          Figure.3 Construction of coaxial cable

Coaxial cable has a fairly high degree of immunity to noise, and can be used over longer distances (up to 500
metres) than twisted pair cable. Coaxial cable has, in the past, been used to provide network backbone
cable segments. Coaxial cable has largely been replaced in computer networks by optical fibre and twisted
pair cable, with fibre used in the network backbone, and twisted pair used to connect workstations to
network hubs and switches.

Thicknet cable (also known as 10Base5) is a fairly thick cable (0.5 inches in diameter). The 10Base5
designation refers to the 10 Mbps maximum data rate ,baseband signalling and 500 metre maximum segment
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length . Thicknet was the original transmission medium used in Ethernet networks, and supported up to 100
nodes per network segment. An ethernet tranceiver was connected to the cable using a vampire tap , so
called because it clamps onto the cable, forcing a spike through the outer shielding to make contact with the
inner conductor, while two smaller sets of teeth bite into the outer conductor.

Transceivers could be connected to the network cable while the network was live. A separate drop cable
with an attachment unit interface (AUI) connector at each end connected the tranceiver to the network
interface card in the workstation (or other network device). The drop cable was typically a shielded twisted
pair cable, and could be up to 50 metres in length. The minimum cable length between connections ( taps )
on a cable segment was 2.5 meters.

                                                 

             Figure.4 Thicknet (10Base5) coaxial cable

Thinnet cable (also known as 10Base2) is thinner than Thicknet (approximately 0.25 inches in diameter)
and as a consequence is cheaper and far more flexible. The 10Base2 designation refers to the 10 Mbps
maximum data rate , baseband signalling and 185 (nearly 200) metre maximum segment length . A T-
connector is used with two BNC connectors to connect the network segment directly to the network
adapter card. The length of cable between stations must be at least 50 centimetres, and Thinnet can support
up to 30 nodes per network segment.

Thinnet cable (also known as 10Base2) is thinner than Thicknet (approximately 0.25 inches in diameter)
and as a consequence is cheaper and far more flexible. The 10Base2 designation refers to the 10 Mbps
maximum data rate , baseband signalling and 185 (nearly 200) metre maximum segment length . A T-
connector is used with two BNC connectors to connect the network segment directly to the network
adapter card. The length of cable between stations must be at least 50 centimetres, and Thinnet can support
up to 30 nodes per network segment.
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Figure.5 Thinnet (10Base2) coaxial cable

4.5.3 Optical fibre
Optical fibres are thin, solid strands of glass that transmit information as pulses of light. The fibre has

a core of high-purity glass, between 6ìm and 50ìm in diameter, down which the light pulses travel. The
core is encased in a covering layer made of a different type of glass, usually about 125 ìm in diameter,
known as the cladding. An outer plastic covering, the primary buffer, provides some protection, and takes
the overall diameter to about 250 ìm. The structure of an optical fibre is shown below.

                                                      

                              Figure.6 The basic construction of an optical fibre

The cladding has a slightly lower refractive index than the core (typical values are 1.47 and 1.5
respectively), so that as the pulses of light travel along the fibre they are reflected back into the core each
time they meet the boundary between the core and the cladding. Optical fibres lose far less of its signal
energy than copper cables, and can be used to transmit signals of a much higher frequency.

More information can be carried over longer distances with fewer repeaters. The bandwidth achievable
using optical fibre is almost unlimited, but current signalling technology limits the data rate to 1 Gbps due to
time required to convert electronic digital signals to light pulses and vice versa. Digital data is converted to
light pulses by either a light emitting diode (LED) or a laser diode. Although some light is lost at each end of

2.4.18



   (Information Technology:Theory) (          )       (                                                      )
the fibre, most is passed along the fibre to the receiver, where the light pulses are converted back into
electronic signals by a photo-detector.
As the ray passes along the fibre it meets the boundary between the core and the cladding at some point.
Because the refractive index of the cladding is lower than that of the core, the ray is reflected back into the
core material, as long as the angle of incidence ( è i ) is greater than the critical angle ( è c ). The critical angle
depends on the refractive indices of the two materials. In the case of an optical fibre, the values are chosen
so that almost all of the light is reflected back into the fibre, and there is virtually no loss through the walls of
the fibre.
This is called total internal reflection . The critical angle for a particular fibre can be calculated using Snell’s
Law. This states that:
n 1 sin è 1 = n 2 sin è 2
where è 1 is the angle of incidence, è 2 is the angle of refraction, and n 1 and n 2 are the refractive indices
of the core and cladding respectively. The effect

               

            Figure.7 Light transmission in an optical fibre

In step-index fibres, the refractive index of both the core and the cladding has a constant value,
so that the refractive index of the fibre steps from one value to the next.

                       

Figure.8 A step-index fibre

If the core diameter of the fibre is such that it allows light to enter at different angles and follow
multiple paths, it is said to be a multi-mode fibre. The number of times the light is internally reflected will vary
according to the angle at which the light initially enters the fibre, which will in turn determine the path length
of the light as it travels along the fibre.

    2.4.19 Library Networks



(Centre for Distance Education) (Acharya Nagarjuna University)(           )
Over long distances, there will be a significant difference in path length between light rays that enter the
fibre at different angles. They will, as a consequence, arrive at slightly different times, causing distortion of
the transmitted signal – an effect known as modal dispersion .
 For this reason, multi-mode fibres are only used for short-haul applications such as LAN backbone
connections, where the distances involved are likely to be considerably less than one ilometer.

            

    Figure.9 A multi-mode step-index fibre

If the core diameter of the fibre is made small enough, the angle at which light can enter the fibre
can be limited such that most of the light travels down a single path, effectively eliminating modal dispersion.
This type of fibre is called a mono-mode fibre, and is commonly used for long-haul applications such as
long distance telecommunications. Distances of many ilometers are possible with mono-mode fibre before
a repeater is needed.

       

Figure.10 Multi-mode and mono-mode fibres

One way to improve the performance of multi-mode fibre is to use a graded index fibre instead of a step
index fibre. The refractive index of this type of fibre varies across the diameter of the core in such a way
that light is made to follow a curved path along the fibre (see below).
Light near the edges of the core travels faster than light at the centre of the core, so although some rays
follow a longer path than others, they all tend to arrive at the same time, resulting in far less modal dispersion
than would occur in a step-index multi-mode fibre.
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Figure.11 A graded index fibre

Figure.12 Light paths in a graded index fibre

4.11 Self-Check Excerise

1. What do you understand by network transmission?
2. Expain types of network transmission.
3. Enumerate the network transmission media.

.
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CHAPTER-1
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1.0 OBJECTIVES
After reading this Chapter, you will be able to:

• Understand the world wide web (www);
• Importance of the web;
• Features of the web;
• How does the web works.

1.1 INTRODUCTION

The Internet and web hold tremendous potential for a whole array of activities including online
distance education, global digital library, e-commerce, Internet telephony, electronic publishing, electronic
journals, virtual museums, etc. It has particularly established itself as a powerful medium for self-education
for people in isolated or remote areas for its ease-to-use, familiarity with masses, availability of tools and
wider accessibility. The web has become the most successful networked multimedia hyper-text-based system
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of our time. HTML, the de facto language of the web, is extremely simple yet powerful to use. Further, the
static HTML web pages can be transformed into vibrant, dynamic and interactive web creations using ever
evolving web technologies like CGI Script, Perl, Java, Javascript, ASP, DHTML, XML and open database
connectivity (ODBC) drivers. The rapid growth in the web technology and its ever increasing usage has
given librarians and educators with unprecedented opportunities to provide information to the students not
within the four-walls of libraries and class rooms but also in the comforts of their home all over the globe.
The changes, mainly driven by the new technological innovations and the new learning environment, has
presented a scenario where students have access to a vast array of information in many fields from experts
all over the world.

The Internet allows us to share information and resources such as, government documents, electronic
journals, electronic books, media publishing, human anatomical images, computer software, bibliographic
and full-text databases, speeches, live concerts, audio and video clippings. The dynamic nature of Internet
is derived from scientists, other researchers and general public contributing their time, resources and energies
to each other. Typical users consult electronic resources at near and distant libraries, download computer
shareware and software upgrades, read and print publications, make travel arrangements and purchase
goods and services. Electronic mail and news groups assist users to communicate with each other on
topics of mutual interest. The discussion forum and listserv provides a platform to people with common
interest to engage in thoughtful discussions. A few popular modes of usage of Internet are as follows:
Retrieving information from reference sources like dictionaries, encyclopaedias, etc. available on the web,
for use in day-to-day work;
Retrieving information from databases of various libraries like the Library of Congress, the British Library,
and those of Indian Institute of Science, IITs and several other institutions;
Searching commercial and non-commercial databases like MEDLINE, INSPEC, COMPENDEX, etc.;

• Accessing electronic books, e-journals and other e-documents available on the websites of
commercial and non-commercial publishers, as required for research work;

• Referring social, economic and statistical data, such as, census, daily exchange rates, and government
budgets and reports;

• Getting documents on fine arts and music, including digital images of art, video and audio;
• Exchanging messages with people across the world;
• Searching for computer shareware, freeware, and commercial software;
• Sending or receiving sound, animation and picture files across the Internet;
• Setting up temporary or permanent discussion or work-oriented groups;

1.2 World Wide Web
The World Wide Web, known as WWW, W3 or simply, the web, is one of the several Internet

resources developed to help people publish, organise and provide access to information on the Internet.
The web was first developed by Tim Berners Lee in 1989 while working at CERN, European Particle
Physics Laboratory in Switzerland, and has since become the most powerful, and popular, resource discovery
tool on the Internet. The WWW can be defined as a hypertext, multimedia, distributed information system
that provides links to hypertext documents, as well as too many other Internet tools and databases.
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1.3 Importance of the Web
The World Wide Web is important for libraries because it provides an extremely powerful method

of organising and providing access to information. The Web can provide a single interface to a large variety
of information resources and systems including textual (unformatted or formatted) documents, images, sound
and video files. The web can be used to provide interface to other Internet services like TELNET, FTP and
Gopher. It can also be interfaced to online databases. There are several features unique to the web that
makes it the most advanced hypertext-based information system on the Internet.

1.4 These features are briefly discussed below:
The Web is a Hypertext System: The web is a hypertext system, in contrast to the hierarchical menu

system used by earlier internal tools such as, Gopher. The user on the web moves from one document to
another related document through embedded links (called hyperlinks) and a hyperlinked word or phrase,
when clicked, calls for another document on that topic. Instead of moving from menu to menu, as in Gopher,
users of the web can jump directly from document to document by clinking on hypertext links.

1.4.1 The Web is a Multimedia System
The web is the most successful networked, multimedia, hypertext-based system of our times. media

types besides structured text. A good multimedia interactive document is a product consisting of structured
text, video clips, animation, pictures, graphics, diagrams, programs, sound, etc. With the advent of graphical
browsers, the web has become a multimedia system, combining different types of media into one document.
Before the advent of graphical web browsers (e.g., Netscape, Internet explorer), most of the information
available on the Internet was in the form of simple text devoid of any elements common to the printed page,
such as, text in bold and italics, pictures and other graphical contents.
The web documents may contain the following:

• Normal text;
• Features such as, large fonts, bold, italics, indents;
• Images such as, pictures, graphics, logos, illustrations;
• Audio content such as, sounds, music, commentary, voice messages; and
• Video content such as, movie clips, animations, or computer generated simulations;

1.4.2 The Web is a Distributed System
The web is a distributed system for delivering linked documents over the Internet. It is called a

distributed system because information can reside on different computers around the world, yet it can easily
be linked together using hypertext. The web uses hypertext to create links from one resource to another.
From the perspective of users, one set of related documents may appear to reside in one location, but in
reality, the successive pages they read may have been requested from anywhere in the world.

1.4.3 The Web incorporates other Internet Tools:
The web incorporated the capabilities of most of the earlier tools, and added the ability to handle

various media types. The web can provide links to other types of Internet tools, such as, WAIS, Gopher,
FTP and TELNET. A web page can provide links to other relevant information resources on the network,
regardless of whether that information is available on a Gopher, through TELNET, or at an FTP site. In this
way, the web and its browsers become a method to seamlessly provide access to information available
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through many different Internet tools. The web provides an Interface to other database systems: A particularly
powerful feature of the web is that it can act as an interface to database systems connected to the Internet.
There are three elements that are needed to create this interface.
i) Forms: Forms are used to collect information through web browser. Forms are a method of creating input
boxes on a web page into which users can type information, or select among alternatives.
ii) Database System: RDBMS system such as, MS Access, MS SQL, MySQL, Oracle or PostGres can be
used as back-end database.
iii) Control Gateway Interface (CGI): The CGI sits between the web browser and database. It takes the
information gathered from the web browser and passes it to the database. Once the request is processed,
the CGI passes the result back to the web browser in a format that it can display. Computer and communication
technology with its capabilities of parallel processing,
multitasking, parallel consultation and parallel knowledge navigation, put together, creates a semblance of
artificial intelligence and interactiveness necessary for developing an interactive learning interface. Coincided
with availability of software, hardware and networking technology, the advent of World Wide Web, its ever
increasing usage and highly evolved browsers have paved the way for creation of a global digital library. The
increasing popularity of the Internet and developments in web technologies act as catalyst to the development
of highly interactive library services.

1.5 How does the web work?
The most important concepts and underlying mechanism that make the web work are client-server

architecture, the Hypertext Transfer Protocol (HTTP), Hypertext Mark-up Language (HTML) and Universal
Resource Locators (URLs). These concepts are described below:

1.5.1 Client-Server Architecture
The Client-Server Architecture is based on the principle where the ‘client’ program installed on the user’s
computer (called client) communicates with the ‘server’ program installed on the host computer to exchange
information through the network. The client-server model involves two separate but related programs, i.e.,
client and server. The client program is loaded on the PCs of users hooked to the Internet where as the
server program is loaded on to the ‘host’ (usually a PC with large storage capacity and RAM, a mini-
computer or a main-frame computer) that may be located at a remote place. The concept of client / server
computing has particular importance on the Internet because most of the programs are built using this
design. The client server architecture is discussed in detail in Block 4, Unit 12 of this consre.

1.5.2 Hypertext Transfer Protocol (HTTP)
The Hypertext Transfer Protocol (HTTP) is a set of rules for exchanging files (text, graphic images, sound,
video, and other multimedia files) on the World Wide Web. As its name implies, the essential concept of
HTTP is the idea that files can contain links or references to other files whose selection would lead to
transfer of requests from one file to another. Any web server machine contains, in addition to the HTML and
other files it can serve, an HTTP daemon, a program that is designed to wait for HTTP requests and handle
them when they arrive. The web browser is an HTTP client, sending requests to server machines. When a
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user requests for a file through browser by either ‘opening’ a web file (typing in a Uniform Resource
Locator) or clicking on a hypertext link, the browser builds an HTTP request and sends it to the Internet
Protocol address indicated by the URL. The HTTP daemon in the destination server machine receives the
request and, after any necessary processing, the requested file is returned. HTTP protocol is Pleae refer to
Block 4, Unit 12 of this course.

1.5.3 Hypertext Links: Uniform Resource Locators (URL)
Hypertext links are words, phrases, symbols, maps or any other item in a web document that are linked to
a different place in the same document or to another Internet resource. Hypertext links may be underlined,
highlighted in colour, or appear as icons, to distinguish them from the surrounding text. The link must be
‘selected’ by clicking on it with a mouse so as to call upon another document or part of a document. The
hypertext inks embed an URL into an object (such as, text or an image). The URL is a compact string
representation for a resource available on the Internet. Links are based on a standard called a Uniform
Resource Locator (URL). URLs contain all of the information needed for the client to find and retrieve a
HTML document. An example of a link to the
URL is:
HTML Tag for Linking
Hypertext Link
<a href=‘‘http://www.iitd.ac.in/acad/”>IIT Delhi</a> HTML Tag (end)
Internet Address
Protocol (http)
The link shown above has four parts:
i) The protocol used to connect to the remote server. In this example, the protocol is HTTP; the protocol is
used to connect to web servers. The protocol could also be Gopher, FTP or TELNET, indicating that the
link is to one of these Internet tools;
ii) The Internet address of the server where the document resides. In this case, the address is http://
www.iitd.ac.in;
iii) The directory on the server where the document is located, called the document path. In this case, the
path is /acad/; and
iv) The filename of the document itself. In the example, it is index.html (default file) where the html extension
indicates that the document is marked-up with HTML tags.

1.6 WEB SERVERS
The Internet works on client-server model. A server is a computer system that is accessed by other

computers and / or workstations at remote locations. Usually, a server contains data, datasets, databases
and programs. The server computer is also called ‘host’ since it is configured to host datasets, files and
databases, receive requests for it from the client machines and serve them. The term ‘host’ means any
computer that has full two-way access to other computers on the Internet. All computers that host websites
are host computers or servers since they ‘host’ information and ‘serve’ client machines. Clients and servers
are two ends of the web, each with its own supporting software. A web server is a software application that
uses the Hyper Text Transfer Protocol.
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There are many web server software applications, including public domain software from Apache,

and commercial applications from Microsoft, Oracle, Netscape and others. A web server may host or
provide access to content and respond to requests received from web browsers. Every web server has an
IP address and usually a domain name, e.g. www.iitd.ac.in. Server software runs exclusively on server
machines, handling the storage and transmission of documents. In contrast, client software such as, Netscape,
Internet Explorer, etc.Runs on the end-user’s computer accessing, translating and displaying documents.
Web servers process HTML documents for viewing by web browsers. The server enables users on other
sites to access documents that it hosts. Web servers can run from any hardware platform. There are
servers that are specifically designed for Macintosh computers, PCs, Silicon Graphics, and various other
platforms. The most important software is the web server itself. Just like a web server can run on a number
of hardware platforms, it can also run under several operating systems, including MS Windows, Windows
NT, Unix, Linux and Macintosh.

A web server is responsible for document storage and retrieval. It sends the document requested
(or an error message) back to the requesting client. The client interprets and presents the document. The
client is responsible for document presentation. The language that web clients and servers use to communicate
with each other is called the Hypertext Transfer Protocol (HTTP). All web clients and servers must be able
to communicateHTTP in order to send and receive hypermedia documents. For this reason, web servers
are often called HTTP servers, or HTTP Deamons (HTTPD).

Web documents are written in a text-formatting language called Hypertext Mark-up Language
(HTML). The HTML is used to create hypertext documents for use on the web. Basically it is a set of
‘mark-up’ symbols or codes inserted in a web file that tells the web browser how to display a web page
for the user. HTML is a language, neither an application nor a software package. It is simply a data set of
text and instructions that requires a web browser to be used.

1.7 Self-Check Excerise
1. What is world wide web (www)?

2. Expalin the features of www.

3. Why the web has become important in this era?
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2.0 OBJECTIVES
After reading this Chapter, you will be able to:

• Understand the Internet;
• How Internet was started;
• Types of services offered through internet;
• Advantages and disadvantages of Internet.
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2.1 INTRODUCTION
The Internet has emerged as one of the most powerful media of communication. The Internet and

associated technologies have created a global environment that has transformed the world into a global
village defying the limitations of geographical boundaries. About two decades ago, most of the world knew
very little or nothing about the Internet. Originating from a network owned by the US Defence project, the
Internet, till 1970s connected a limited number of computers accessible only to computer scientists and
researchers in USA and allied countries for the purpose of defence research. Initially, it became accessible
to universities and research institutions to facilitate easier and faster communication between scientists and
researchers. With winding of operations of ARPANET in 1990, the combined infrastructure of ARPANET
and NSFNET became available commercially.

The Internet, since then, is growing at leaps and bounds around the world and broadband is rapidly
becoming a large part of the growth. The number of hosts is considered an accurate measure of the size of
the Internet. The Domain Survey, sponsored by the Internet Systems Consortium that discovers every
server on the Internet reports that Internet host count has reached over 233 million and has grown by 35
percent in the past year. The InternetWorldStats.com reports that there are more than 745 million Internet
users worldwide, with an average of 3.2 users per host. With the high quality of service in the United States
there are approximately 2.4 Internet users per host, whereas in some developing countries such as China
and India, there are more than 100 Internet users per host. The Internet statistics can be used as a barometer
of the global economy. For example, in case of India, the total number of users increased from 5 million in
the year 2000 to 16.58 million in the beginning of 2004. This 231.6% increase in the growth of number of
users in four years is an indication of Internet-based economic activity in India as well as overall economic
changes in the country.

The Internet has completely revolutionised the modes and methods of the computer and
communications world like never before. The Internet is an integration of several functions and services
rolled into one. It is a world-wide broadcasting facility, a mechanism for information storage and dissemination,
a media for electronic publishing of scholarly literature and a medium for collaboration and interaction
between individuals and their computers without barriers of geographic location. The Internet represents
one of the most successful examples of the benefits of sustained investment and commitment to research and
development in information infrastructure. Beginning with the early research in packet switching, the
government, industry and academia have been partners in evolving and deploying this exciting new technology.

2.2 Internet
The internet in simple terms is a network of the interlinked computer networking worldwide, which

is accessible to the general public. These interconnected computers work by transmitting data through a
special type of packet switching which is known as the IP or the internet protocol.
Internet is such a huge network of several different interlinked networks relating to the business, government,
academic, and even smaller domestic networks, therefore internet is known as the network of all the other
networks. These networks enable the internet to be used for various important functions which include the
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several means of communications like the file transfer, the online chat and even the sharing of the documents
and web sites on the WWW, or the World Wide Web.

It is always mistaken said that the internet and the World Wide Web are both the same terms, or are
synonymous. Actually there is a very significant difference between the two which has to be clear to understand
both the terms. The internet and World Wide Web are both the networks yet; the internet is the network of
the several different computers which are connected through the linkage of the accessories like the copper
wires, the fiber optics and even the latest wireless connections. However, the World Wide Web consists of
the interlinked collection of the information and documents which are taken as the resource by the general
public. These are then linked by the website URLs and the hyperlinks. Therefore World Wide Web is one
of the services offered by the whole complicated and huge network of the internet.

The use of IP in the Internet is the integral part of the network, as they provide the services of the
internet, through different layers organization through the IP data packets. There are other protocols that are
the sub-classes of the IP itself, like the TCP, and the HTTP.

2.3 History of Internet
The Internet was the result of some visionary thinking by people in the early 1960s who saw great

potential value in allowing computers to share information on research and development in scientific and
military fields. J.C.R. Licklider of MIT first proposed a global network of computers in 1962, and moved
over to the Defense Advanced Research Projects Agency (DARPA) in late 1962 to head the work to
develop it. Leonard Kleinrock of MIT and later UCLA developed the theory of packet switching, which
was to form the basis of Internet connections. Lawrence Roberts of MIT connected a Massachusetts
computer with a California computer in 1965 over dial-up telephone lines. It showed the feasibility of wide
area networking, but also showed that the telephone line’s circuit switching was inadequate. Kleinrock’s
packet switching theory was confirmed. Roberts moved over to DARPA in 1966 and developed his plan
for ARPANET. These visionaries and many more left unnamed here are the real founders of the Internet.

The Internet, then known as ARPANET, was brought online in 1969 under a contract let by the
renamed Advanced Research Projects Agency (ARPA) which initially connected four major computers at
universities in the southwestern US (UCLA, Stanford Research Institute, UCSB, and the University of
Utah). The contract was carried out by BBN of Cambridge, MA under Bob Kahn and went online in
December 1969. By June 1970, MIT, Harvard, BBN, and Systems Development Corp (SDC) in Santa
Monica, Cal. were added. By January 1971, Stanford, MIT’s Lincoln Labs, Carnegie-Mellon, and Case-
Western Reserve U were added. In months to come, NASA/Ames, Mitre, Burroughs, RAND, and the U
of Illinois plugged in. After that, there were far too many to keep listing here.

The Internet was designed to provide a communications network that would work even if some of
the major sites were down. If the most direct route was not available, routers would direct traffic around the
network via alternate routes.

The early Internet was used by computer experts, engineers, scientists, and librarians. There was
nothing friendly about it. There were no home or office personal computers in those days, and anyone who
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used it, whether a computer professional or an engineer or scientist or librarian, had to learn to use a very
complex system.

E-mail was adapted for ARPANET by Ray Tomlinson of BBN in 1972. He picked the @ symbol
from the available symbols on his teletype to link the username and address. The telnet protocol, enabling
logging on to a remote computer, was published as a Request for Comments (RFC) in 1972. RFC’s are a
means of sharing developmental work throughout community. The ftp protocol, enabling file transfers
between Internet sites, was published as an RFC in 1973, and from then on RFC’s were available
electronically to anyone who had use of the ftp protocol.

Libraries began automating and networking their catalogs in the late 1960s independent from
ARPA. The visionary Frederick G. Kilgour of the Ohio College Library Center (now OCLC, Inc.) led
networking of Ohio libraries during the ’60s and ’70s. In the mid 1970s more regional consortia from New
England, the Southwest states, and the Middle Atlantic states, etc., joined with Ohio to form a national,
later international, network. Automated catalogs, not very user-friendly at first, became available to the
world, first through telnet or the awkward IBM variant TN3270 and only many years later, through the
web.

2.4 Internet Tools
   Some of the important and popular tools on the Net are discussed below. These includes

Information retrieval tools

Communication tools

Multimedia information tools

Information search tools

2.4.1 Information Retrieval Tools
FTP

File transfer protocol (ftp) which was one of the first tools on the Internet, allows users to move
files, such as text, graphics, sound, and so on, from one computer to another. It is a  command that
activates a type of client-server relationship. FTP works as follows: The user  first uses the software on his
or her machine called the client, to gain access to the remote  machine, called the server. The user’s client
program communicates with a program on the remote computer, to either upload, or send to the remote
computer or download certainrequested files from it.

Another popular way to retrieve files is by using what is called an anonymous ftp server. In this case, the
user logs on to the server using the special user ID anonymous. If the server then asks for a password, the
user types in his or user ID. Freeware and sharewareprograms that are available at no cost on the Net –
can be obtained through anonymous ftp servers. Although it is easy to retrieve the information once the site
is located, sometimes it isdifficult to locate on ftp site or identify the files available on that site.
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Gopher
The second type of information retrieval tool available on the Internet is Gopher, a menubased interface that
provides easy access to information residing on special servers, called Gopher sites. Although Gopher
performs primarily the same tasks as the ftp command, its interface is much more user-friendly and it provides
additional functions, such as links to other Internet services. By selecting an item on the Gopher menu, users
can move, retrieve, or display files from remote sites. The menu also allows users to move from one Gopher
site to another, where each site provides different information. The entire Gopherspace can be easily expanded
by adding more servers.

2.4.2 Communication Tools
Communication tools facilitate written communications and in this section we discuss three types of
communication tools: E-mail, Telnet and Usenet.
E-mail
E-mail, which refers to sending messages or files electronically, was one of the first Internet tools.
Telnet
Telnet is a command that connects the user to a remote machine which may be locatedanywhere on the
Internet and the user can then type commands to the remote machine, for example to change directories in
search of certain files. While the ftp only allows users to move or transfer files, the services that Telnet
provides depend on the services provided by the hose machine, which may include much more than simple
file transfers. For example, some servers are dedicated to the playing of board games, such as chess or go.

Usenet
The Usenet is a network that provides users with discussion groups or forums. A user posts an article to a
chosen newsgroup on the Usenet, where each newsgroup is devoted toparticular topic such as politics, the
environment, gun control, surfing, and so on. The article is routed only to those sites that have expressed an
interest in receiving information on the topic. Many find the Usenet to be helpful for gathering information on
a variety of topics. For example, vendors monitor the technical forums on the Usenet closely to answer
technical questions that customers may have and to stomp out any misinformation or rumors about their
company or its products. For instance, the calculation error in Intel Corp’s Pentium microprocessor was first
discussed on an Internet Usenet newsgroup. Another popular application on Usenet is downloading new or
upgraded software from vendors and obtaining quotes for products and services. IS managers are also
tapping into the Usenet to search for potential employees. One IS manager posts particularly thorny technical
problems on the Usenet in the relevant discussion groups and then makes an offer to individuals who gave
some of the best replies.

2.4.3 Multimedia Information Tools
World Wide Web. The World Wide Web (www) is one of the newest and most popular hypertext-based
Internet tool. It allows users to access and display documents and graphics stores on any server on the
Internet. In 1989, Tim Berners-Lee, a computer scientist at the CERN particle physics lab in Switzerland,
designed WWW as a tool to help and international group of physicists exchange findings and information
related to their research. It became popular only in late 1993, when WWW software was delivered for
desktops that used popular operating systems, such as Windows, allowing users easy and friendly access to
the Internet. Some WWW terms are shown as follows:

Internet : Basics 3.2.5



(Centre for Distance Education) (Acharya Nagarjuna University)(           )
CGI Common gateway interface. A specification for a communication interface between external
systems and a Web server.

HTML Hyper-Text Markup Language. A text formatting language used to create Web pages.

HTTP Hyper-Text Transport Protocol. The communications protocol between a Web server and
a client.

Image Map A text file that defines regions using graphics files that users can click on to

navigate.

MIME Multipurpose Internet Mail Extensions. An Internet standard for sending and

receiving multimedia E-mail.

Server-Side A Web server feature that lets HTML pages be parsed “on the fly”, filling in parts of
the page with information from external files.

S-HTTP Secure Hyper-Text Transport protocol. An extension of HTTP that provides

communication and transaction security for Web clients and servers.

SSL Secure socket layer. A transport mechanism developed by Netscape Communication for
transmitting secure data over a network.

URL Uniform resource locator. An address that specifies the location of a Web page.

There are many interfaces to the WWW, such as Mosaic, a GUI – based hypertext browser, and
Netscape, that allows users to easily navigate the Internet and access it many services. These
easy-to-use interfaces are playing an important role in popularizing user of these interfaces to
create their own Web pages. According to Michael J. Walsh, president of Internet Info., in Falls
Church. Virgina, the number of companies with .com addresses is expected to double within the
next year, primarily because it is now easy to use the Internet and gain 24-hour access to customers
all over the world.

Home page
The World Wide Web has also spawned new services, known as service providers that provide a

multitude of services on the Web. For example, a Web service provider can help a company establish a
home page on the Net, an electronic description of the company and its products and services, similar to
a catalog or a brochure. Just as catalogs should be attractive and grab the interest of customers, the home
page should also be attractive and encourage the user to further explore the company and its products.

Basic requirements to set up a home page include an Integrated Services Digital Network (ISDN)
line, software to generate Hypertext Markup Language (HTML), which is thegraphical interface to the
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internet, and a PC or Unix Server that has between 16M bytes and 32 M bytes of RAM and runs at 100
Mhs or more.

Many companies are setting up home pages to attract new customers. For example, GEPlastics
found that as soon as it set up a Web page, it was getting approximately 12,000 potential inquires each
month its products. Before the page was set up, it took nearly 3 days to respond to customer queries: now
customers can get information within a few minutes. The company firmly believes that setting up a Web page
has given it a competitive advantage. Further, the cost of setting up a Web page was much lower than that of
printing pamphlets and mailing catalogs to customers. The advantages of a Web page are so great that, as
one spokesperson said, “You simply can’t lose. There is nothing equivalent to the Net”. Security APL is an
example of another company that relies on the internet to enhance internal and external communications.

In 1995, when statewide elections were held in California, tens of thousands of votersaccessed a
World Wide Web Server that contained poll reports culled every five minutes fromthe state’s Election Web
Server. Clinton’s 1992 presidential campaign was notable for making his E-mail address public, and the
White House recently established its own World-Wide Web Home Page(try whitehouse.gov).

United Parcel Service (UPS) is another company Spokesperson says, “Our competitors aren’t
online yet, and that gives us an edge where we can generate some allegiance to our service”.
Although there are many advantages to a home page, some experts are worried that theInternet may simply
become a “de facto national post office”, and may become heavily commercialized. As more and more
businesses start using the Net to sell their products and
services, the Net may not be capable of handling the expanded volume of traffic. Ray Hoving,
chairman of the Society for Information Management’s (SIM) National Data Highways Advisory Council, is
concerned about the technical, administrative, and security issues that
will arise as traffic on the Net continues to increase.

2.4.4 Information Search Tools
Archie
The tools discussed in this section help users locate information on the Net. For example, Archie, one of the
first information search tools developed on the Internet, periodicallysearches anonymous ftp servers that
participate in the Archie database and identifies all files
on these servers. It then creates a central index of all files available on anonymous ftp sites
and creates a central database that users can access to locate information.
least part of the filename in order to be able to search for the file. When the desired file islocated, the servicer
idenfies the file’s address and the user can use the ftp command to access  and retrieve the file. Though
Archie is a very useful tool for locating files, it must be noted that not all anonymous ftp sites participate in the
Archie database, and therefore, the database is not a comprehensive one.

Veronica
Veronica is a search tool designed specifically to locate all files on Gopher sites and it is listed

under Other Gopher and Information Servers on the Gopher menu. Users who have access to
a Gopher server and a Veronica server can then access the database. Note however, that some
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Gopher serves may choose not to participate in the Veronica Service. One of the biggestadvantages of
Veronica over Archie is that the user does not have to know the filename; hrases descriptive of the search
area will do.

WAIS
WAIS (Wide Area Information Server). Pronounced “ways”, is a search system that accesses

servers all over the world to locate requested files. The WAIS database has an index of keyboards that helps
users to locate files in topic areas of interest to them. When given the
keywords, WAIS returns the addresses where the files are located. The user can then user one of the other
services discussed above to download the files. If a particular file is not found
on a given WAIS server, the server will automatically direct the query to other WAIS servers
on the Net.

2.5 Advantages of  Using the Internet
In the history of mankind, the Internet is the greatest development in the domain of communication industry.
Internet has tremendous potential and a lot to offer in terms of services. We can notice advantages and
disadvantages of using Internet.

2.5.1 Faster Communication
The foremost target of Internet has always been speedy communication and it has excelled way

beyond the expectations. New innovations are only going to make it faster and more reliable. Now, you can
communicate in a fraction of second with a person who is sitting in the other part of the world. With the help
of such services, it has become very easy to establish a kind of global friendship where you can share your
thoughts and explore other cultures.

2.5.2 Information Resources
Information is probably the biggest advantage that Internet offers. Internet is a virtual treasure trove

of information. Any kind of information on any topic under the sun is available on the Internet. The search
engines like Google, Yahoo are at your service on the Internet. There is a huge amount of information
available on the Internet for just about every subject known to man, ranging from government law and
services, market information, new ideas and technical support. Today, it is almost required that students
should use it for research or the purpose of gathering resources.

2.5.3 Entertainment
Entertainment is another popular reason why many people prefer to surf the Internet. In fact, the

Internet has become quite successful in trapping the multifaceted entertainment industry. Downloading games
or just surfing the celebrity websites are some of the uses people have discovered. Even celebrities are using
the Internet effectively for promotional campaigns. 

2.5.4 Social Networking

3.2.8



   (Information Technology:Theory) (          )       (                                                      )
One cannot imagine an online life without Facebook or Twitter. Social networking has become so

popular amongst youth that it might one day replace physical networking. It has evolved as a great medium
to connect with millions of people with similar interests. Apart from finding long-lost friends, you can also
look for a job, business opportunities. 

2.5.5 Online Services
The Internet has made life very convenient. With numerous online services you can now perform all

your transactions online. You can book tickets for a movie, transfer funds, pay utility bills, taxes etc., and
right from your home.
2.6 Disadvantages of  Using the Internet

2.6.1 Theft of Personal Information
If you use the Internet for online banking, social networking or other services, you may risk a theft to

your personal information such as name, address, credit card number etc. People can access this information
through unsecured connections or by planting software and then use your personal details for their benefit.
Needless to say, this may land you in serious trouble. 

2.6.2 Virus Threat
Internet users are often plagued by virus attacks on their systems. Virus programs are inconspicuous

and may get activated if you click a seemingly harmless link. Computers connected to the Internet are very
prone to targeted virus attacks and may end up crashing. 

2.6.3 Pornography
Pornography is perhaps the biggest disadvantage of the Internet. Internet allows you to access

and download millions of pornographic photos, videos and other X-rated stuff. Such unrestricted access
to porn can be detrimental for children and teenagers. 

2.6.4 Social Disconnect
Thanks to the Internet, people now only meet on social networks. More and more people are

getting are drifting apart from their friends and family. Even children prefer to play online games rather than
going out and mingling with other kids.With all its drawbacks the internet has the potential to make your life
simple and convenient, as well as cause destruction in your life.

2.7 Self-Check Excerise

1. Describe the tools of Internet.

2. How Internet is useful for Students?

3. What are the advantages & disadvantages of internet?
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3.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the Intranet;
• How Internet works;
• Types of services offered through intranet;
• Hardware & Software configuration for Intranet.

3.1 INTRODUCTION
An intranet is a computer network that uses Internet Protocol technology to share information,

operational systems, or computing services within an organization. The term is used in contrast to internet,
a network between organizations, and instead refers to a network within an organization. Sometimes, the
term refers only to the organization’s internalwebsite, but may be a more extensive part of the organization’s
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information technology infrastructure, and may be composed of multiple local area networks. The objective
is to organize each individual’s desktop with minimal cost, time and effort to be more productive, cost
efficient, timely, and competitive.

An intranet may host multiple private websites and constitute an important component and focal
point of internal communication and collaboration. Any of the well known Internet protocols may be found in
an intranet, such as HTTP (web services), SMTP (e-mail), and FTP (file transfer protocol). Internet
technologies are often deployed to provide modern interfaces to legacy information systems hosting corporate
data.

3.2 Intranet
An intranet can be understood as a private analog of the Internet, or as a private extension of the

Internet confined to an organization. The first intranet websites and home pages were published in 1991 and
began to appear in non-educational organizations in 1994. Intranets are sometimes contrasted to extranets.
While intranets are generally restricted to employees of the organization, extranets may also be accessed by
customers, suppliers, or other approved parties. Extranets extend a private network onto the Internet with
special provisions for authentication, authorization and accounting (AAA protocol).

In many organizations, intranets are protected from unauthorized external access by means of a
network gateway and firewall. For smaller companies, intranets may be created simply by using private IP
address ranges, such as 192.168.0.0/16. In these cases, the intranet can only be directly accessed from a
computer in the local network; however, companies may provide access to off-site employees by using
a virtual private network, or by other access methods, requiring user authentication and encryption.

3.4 Intranet Hardware
An intranet is a client / server system. The server is a computer that has two main functions.

It runs the intranet server software.

It usually stores some or all of the content that is available to users.

   For an intranet, the requirements for the server computer depend mainly on how many connections per
hour it will be expected to handle.

A typically equipped modern personal computer – single Pentium 120 MHz processor, 32MB of random-
access memory, 2GB hard disk – would be sufficient to handle a small intranet  load. The load could be up
to, say, a few hundred connections per hour. When the connection load on the server gets too high, users will
find themselves waiting a long time to get a page.
Eventually, their requests wil time out (the browser will get tired of waiting and give up) because the server
can’t get to their request fast enough.

When the server becomes overloaded, there are a number of things you can do to improve its
performance.
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Add more memory to the server

Add more processors to the server

Add more servers and split the content among them

    Almost any computer can be a client. All the client needs to do is run the World Wide Web
browser software, which does not require a lot of processor power or memory. Clients can
also be based on any technology, such as a Macintosh, Intel, or Sun, as long as the platform is
capable of running TCP / IP.

Although it is true that browser software is relatively “light” in terms of its demands on
the client computer, that situation is changing. Newer browsers, such as Microsoft’s

3.5 Intranet Software
The software that runs on the server computer and provides services such as World Wide Web

(also known as HTTP) publishing, FTP file retrieval, and indexing and searching facilities is known as server
software. Server software is available free on the Internet, and commercial packages such as Microsoft’s
Internet Information Server and Netscape Navigator are also available. Server software is available for a
variety of operating systems, such as UNIX and Windows NT Server.

The software that runs on the client is called a browser. We use the browser to access and
view Web pages. Because our intranet will use the same protocols as the Web, we can use any
of the well-tested Web browsers already available – either free of charge or at a reasonably
low cost on the commercial market. Perhaps the best-known Web browser is Netscape Navigator. Netscape
provides the user with a variety of features, such as bookmarks, e-mail
automation, and “hot” lists for storing the addresses of our favorite Web sites, Navigator is
available commercially and, at most times, Netscape Communications Corporation allows
downloading of a recent version.
The Internet is a gold mine of free software. We can find everything we need to run a fullfeatures intranet.
One word of caution: if you use software from the Internet, you may be on
your own when it comes to getting it set up right and solving the inevitable problems that
come up. Unless we’re the adventure some soft and feel comfortable poking around in the
innards of computer applications, we might be better off spending a few dollars for welldesigned, tested, and
supported software.

3.6 Intranet Services
All of Internet services are still available on the Internet. Chances are, however, we won’t

want or need all of them on our intranet.
Here’s the suite of services and facilities you’ll probably want:

• World Wide Web publishing

• FTP
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• Some kind of indexing and searching service

• Some facility to run scripts.

3.6.1 Web (HTTP) Publishing
The World Wide Web is by far the most popular service on the Internet. In fact, for many

people, the Web is the Internet. The World Wide Web is based on HTTP, HTTP defines how browsers and
servers communicate and move information back and forth.

There’s that word again: protocol. Now we have three layers of protocols: the HTTP uses the
Internet Protocol over a network that has some kind of network communication protocol. One would think
Internet was invented by the State Department. HTTP uses a “request and response” process. The browser
on the client computer sends a request to the server for a particular page of information. The server receives
the request,finds the requested page (file), and sends it to the browser. HTTP then forgets about the whole
transaction. The browser and the server maintain a connection only long enough to process the request.

Let’s clear up some potential confusion here. As stated, the server and the client maintain a logical
connection only long enough to process a request. However, they remain physically connected over the
network. If we connect to our intranet remotely over a telephone line, the telephone connection remains
open until you quit the session, even though the server and browser aren’t talking to each other.

HTTP is usually used to send HTML files to the browser, but it can send any kind of file. If the browser
cannot display the file, it will start another application (called a helper application) to display it, if possible. If
it can’t find as helper application, it will give the user option of saving the file to disk.

3.6.2 Hyper-Text Markup Language
The primary language used to create Web pages is HTML. HTML uses commends called tags embedded in
a text file to tell the browser how to display the file. HTML started out as fairly simple markup language but,
like everything else in the computer world, it’s getting more complex all the time. An official HTML standard
is published by the World Wide Web Consortium, but companies that produce browser software like to add
unique extensions to the set of tags their browsers understand, to give them a competitive edge.

For example, Microsoft’s Internet Explorer lets we use a special tag in an HTML document to
create marquee in which a line of text crawls across the page from one side to the other. A browser that does
not support this tag will not display the marquee effect. This example illustrates one of the irritating “gotchas”
in the Web: All browsers do not support all the same extended HTML tags, so you can’t count on them all
to display the same page in the same way. For our intranet, it would be a good idea to standardize on one
browser to be used by everyone, so we will always know what tags it can understand.

In the early days of the Web, creating a document in HTML format meant typing the content in a text
editor and then adding HTML tags by hand. Nowadays, there are authoring tools,  such as Navigator Gold,
FrontPage, and bothers, that are very much like word processors.They let you create documents and add
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formatting and effects without ever having to touch an HTML tag. Instead, the tools add the tags behind the
scenes as you create the document.

3.6.3 Hypertext
Hypertext – links that can take user to new page with a single click of the mouse button is a defining

feature of the World Wide Web. Hypertext is what gives we the capability to manage information on the
Web in new, highly effective ways. If we have used the World Wide Web, we have used hypertext. It shows
up usually as colored text – a label, a section title, a word or two in a sentence, or even a portion of an
image. When we move the mouse pointer over hypertext, the pointer changes to a pointing hand. When we
click the hypertext with the mouse, something happens. Usually, we go to another page.

3.7 Communication Systems

3.7.1 E-Mail
Electronic mail or E-mail, as it is popularly called, is a system that allows a person or a group to

electronically communicate with others through a network. A user sends an electronic message over a
network; the message is stored in the electronic mailbox of the receiver. The electronic mailbox is usually a
file on a server; the messages in it can be retrieved when the recipient is ready to receive them. Users can
also edit, sort, save, and classify messages and forward them to other individuals on the network. If two
users are logged onto the network at the same time, then they can converse through E-mail. Some E-mail
systems have multimedia capabilities allowing E-mail users to send not only text, but also voice and still
pictures.

There are many kinds of E-mail software; depending on the characteristics of each type used, mail
can be sent between different computers or may be restricted to users on one computer. If an organization
has different types of systems, say IBM, Digital, and so on, these systems must be linked together for E-mail
to be successful. E-mail has many benefits. First, it allows organizations to be responsive to customer needs.
For example, when Freddie Mercury died, his fans around the world sent E-mail messages to his music
company. EMI Records, to order his music. As a tribute to his memory, radiostations around the world
began to play his once neglected songs. The box-office blockbuster film Wayne’s World features one of
Freddie’s old hits and MTV began showing his music videos. The dead star was suddenly hot. EMI
subsidiaries around the world were floodedwith E-mail orders for the star’s music. The Queen albums in
EMI’s catalog were particularly popular with the E-mail users. The result EMI sold 3 million Queen albums
in 1 month,generating $30million to $15million of the year’s profits for the $2-billion company.

The “big 3” credit reporting agencies – TRW, Equifax, and Trans Union, use E-mail to respond
quickly to customers’ concerns and queries. Before the system was installed, consumes who were trying to
rectify errors in their credit reports often felt harassed by the credit agencies. Consumers were forced to
write to all three agencies about any errors in their credit reports. Each agency had to write to retailers and
lenders about the corrections. This paper-driven process was nightmarish for some consumers; there were
enormous delays in rectifying errors. There were mail delays and internal processing delays in getting the
paper forms to the right people, with the result that dispute resolution could take from 30 days to 8 months.
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Today, all three agencies use E-mail systems to correspond with retailers and lenders. This not only
saves the agencies time and money, but has greatly alleviated the problems thatconsumers face when there
are errors in their credit records. Most disputes are resolved in under 5 days – a big improvement over the
old system.

Another advantage of E-mail is that it provides instantaneous access to and dissemination of
information, thereby eliminating the time lag involved in using the postal service. E-mailmessages do not get
lost or reach the wrong party.

In spite of its many benefits, E-mail should be used carefully. John Beamish, senior systems analyst
at the Ministry of Education in Toronto, tells this E-mail story; “At my last place of employment, the unwritten
rule was; If you drink the last of the coffee, make a fresh pot.Unfortunately, not many people did. In response,
an angry coffee drinker sent a ragging fivepage E-mail message regarding his dissatisfaction. The message
was so long and went to so many people, it used all the memory of at least one dist, and no one could access
their E-mail messages”.

Finally, E-mail systems must be carefully selected, since a poor package may not only deter users
from using E-mail but can also result in poor communications. Some factors to consider before selecting an
E-mail package are: What hardware and operating system platforms must the mail system support? How
many users do we currently have? How many users will we have in 2 years? In 5 years? Will remote users
at multiple sites need to use the system? Must users access external services, such as Compuserve? Can
messages be sent between different platforms (say, from a UNIX machine to a Macintosh or an IBM PC)?
Is the package capable to meeting the growing needs of the organization? Will the vendor provide training
andtechnical support if necessary? These and other related questions must be carefullyaddressed.

3.7.2 Fax:
Fax.or facsimile transmission, is another type of electronic publishing and processing system. Fax

technology uses telephones, modems, and scanners to transmit text and graphics to individuals and organizations
all over the world who have access to telephones. Note that a computer is not required to send a fax. all that
is needed is a fax machine at either end of a telephone connection. The idea itself is very simple and elegant.
A scanner in the fax machine scans the document at one end and a built-in modem sends it; in the fax machine
at the other end, a build-in modem receives the message, a scanner scans the document, and a printer prints
it.

In a short time, the fax, sometimes viewed as a “long-distance copier”, has become part of the home
office, the work office, and even of war zones! Journalists reporting the war in Bosnia used fax machines to
transmit was stories because editors preferred to see the stories in handcopy form. It is estimated that there
are 24.5 million fax machines in the world today. The Japanese, in particular, rely heavily on fax communication
because their language, with its thousands of ideographs, is easier to write in longhand than to type on
cumbersome Japanese word processors.
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Fax machines can send the same document to multiple users. They can also be integrated with

applications such as word processors, so that faxes can be edited without being rekeyed into the computer.
Fax machines can be programmed to send faxes when telephone rates are lowest. A portable fax machine
allows users to retrieve documents using a touch-tone phone’s keypad. An interesting development is the fax
modem, which allows users to send or receive faxes using their PCs.

3.7.3 Voice Mail:
Voice Mail facilities oral communication. This way it works is illustrated in below figure, thesender

dictates a message over the telephone. A special device, called a codec, converts the analog signal of the
sender’s voice into a digitized message. The message is transmitted over the network and stored in a server
at the receiver’s end. A blinking light on the receiver’shone indicates that he or she has a voice message.
When the receiver chooses, the digitizedmessage is retrieved from the server, reconverted into alalog form,
using a codec at the receiver’s end, and the receiver receives it over the phone.

Although voice mail is a simple idea, it eliminates a number of problems, such as “phone tag”. It also
ensures that a message reaches the right party even when that party is not available. Some voice mail systems
can send the same message to several people, reroute a message to another phone, save messages for future
reference, and retrieve messages from any telephone, anywhere in the world. In some systems, uses need a
password to access voice messages, making voice mail a secure medium for confidential messages.

An intranet is an internal, network-based infrastructure. In reality it is the same architecture as the
Internet and has the same document and content standards as the World Wide Web. Corporate networks
that use the same networking/transport protocols and locally based web servers to provide access to vast
amounts of corporate information in a cohesive fashion. Documents must be stored in HTML, and clients
need web browser software.

3.8 Self-Check Excerise

1. What is Intranet?
2. Explain about Intranet software and hardware.
3. What are Intranet services?
4. Explain about extranet.
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CHAPTER-4
ADVANTAGES AND DISADVANTAGES OF INTERNET

4.0 Objective
After reading this Chapter, you will be able to understand:
• Advantages of Internet  and
• Disadvantages of Internet.

Structure
4.1 Advantages of  Using the Internet
4.1.1 Faster Communication
4.1.2 Information Resources
4.1.3 Entertainment
4.1.4 Social Networking
4.1.5 Online Services
4.2. Disadvantages of  Using the Internet

4.2.1 Theft of Personal Information
4.2.2 Virus Threat
4.2.3 Pornography

4.2.4 Social Disconnect
4.3 Self-Check Exercise
4.4 References

4.1 Advantages of  Using the Internet
In the history of mankind, the Internet is the greatest development in the domain of communication

industry.   Internet has tremendous potential and a lot to offer in terms of services. We can notice advantages
and disadvantages of using Internet.

4.1.1 Faster Communication
The foremost target of Internet has always been speedy communication and it has excelled way

beyond the expectations. New innovations are only going to make it faster and more reliable. Now, you can
communicate in a fraction of second with a person who is sitting in the other part of the world. With the help
of such services, it has become very easy to establish a kind of global friendship where you can share your
thoughts and explore other cultures.
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4.1.2 Information Resources

Information is probably the biggest advantage that Internet offers. Internet is a virtual treasure trove
of information. Any kind of information on any topic under the sun is available on the Internet. The search
engines like Google, Yahoo are at your service on the Internet. There is a huge amount of information
available on the Internet for just about every subject known to man, ranging from government law and
services, market information, new ideas and technical support. Today, it is almost required that students
should use it for research or the purpose of gathering resources.

4.1.3 Entertainment
Entertainment is another popular reason why many people prefer to surf the Internet. In fact, the

Internet has become quite successful in trapping the multifaceted entertainment industry. Downloading games
or just surfing the celebrity websites are some of the uses people have discovered. Even celebrities are using
the Internet effectively for promotional campaigns.

4.1.4 Social Networking
One cannot imagine an online life without Facebook or Twitter. Social networking has become so

popular amongst youth that it might one day replace physical networking. It has evolved as a great medium
to connect with millions of people with similar interests. Apart from finding long-lost friends, you can also
look for a job, business opportunities.

4.1.5 Online Services
The Internet has made life very convenient. With numerous online services you can now perform all

your transactions online. You can book tickets for a movie, transfer funds, pay utility bills, taxes etc., and
right from your home.

4.2 Disadvantages of  Using the Internet

4.2.1 Theft of Personal Information
If you use the Internet for online banking, social networking or other services, you may risk a theft to

your personal information such as name, address, credit card number etc. People can access this information
through unsecured connections or by planting software and then use your personal details for their benefit.
Needless to say, this may land you in serious trouble.

4.2.2 Virus Threat
Internet users are often plagued by virus attacks on their systems. Virus programs are inconspicuous

and may get activated if you click a seemingly harmless link. Computers connected to the Internet are very
prone to targeted virus attacks and may end up crashing.

4.2.3 Pornography
Pornography is perhaps the biggest disadvantage of the Internet. Internet allows you to access and

download millions of pornographic photos, videos and other X-rated stuff. Such unrestricted access to porn
can be detrimental for children and teenagers.
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4.2.4 Social Disconnect
Thanks to the Internet, people now only meet on social networks. More and more people are

getting are drifting apart from their friends and family. Even children prefer to play online games rather than
going out and mingling with other kids. With all its drawbacks the internet has the potential to make your life
simple and convenient, as well as cause destruction in your life.

4.3 Self-Check Excerise
1. Describe how Internet is useful for Students?
2. What are the advantages & disadvantages of internet?

4.4 REFERENCES:
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CHAPTER-1
INFORMATION COMMUNICATION TECHNOLOGY

Structure
1.0 Objectives
1.1 Introduction
1.2 Concept of Information Technology
1.3 Meaning of Information Techology (IT) :
1.4 Definition of Information Technology:
1.5 Characteristics of Information Technology:
1.6 Concept of Communication Technology
1.7 Information Communication Technology in Education
1.8  Definitions
1.9 Characteristics of ICT in Education
1.10 Uses in Education
1.11 Advantages of the use of ICT in Education:

1.11.1 Quick access to information
1.11.2 Easy availability of updated data:
1.11.3  Connecting Geographically dispersed regions:
1.11.4 Catering to the Individual differences:
1.11.5 Wider range of communication media:
1.11.6 Wider learning opportunities for pupils:

1.12 Self-Check Exercise
1.13 References

1.0 OBJECIVES

After reading this Chapter, you will be able to:
• Understand the information communication technology;
• Definition of ICT;
• How ICT is being used in education;
• Advantages of ICT use in education.
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1.1 INTRODUCTION
Globalization and technological change processes that have  accelerated in tandem over the past

years have created a new  global economy  Powered by technology, fueled by information and driven by
knowledge. The emergence of this new global economy has serious implications for the nature and purpose
of educational institutions. As you know the half life of information continues to shrink and access to information
continues to grow exponentially,  schools can not remain mere venues for the transmission of a prescribed
set of information from teacher to student over a fixed period of time. Rather Schools must promote Learning
to Lear i.e. the acquisiton of knowledge and skills that make possible continous learning over the lifetime.
The illiterate of the 21st century according to futurist Alvin Toffler,  ¯ Will not be those who can not  read and
write, but those who can not learn, Unlearn & relearn, Concerns over educational relevance and quality co-
exist with the imperative of expending educational oppertunities to those made most vulnerable by globalization
- developing countries in general, low income groups, girls and women and low skilled workers in particulars.
Global changes also put pressure on all groups to constantly acquire and apply new skills. The international
Labour organization defines the requirements for education and training in the new global economy simply as
a Basic education for all,Core work skills for all and Lifelong learning for all.

In this connection, Information and communication technologies (ICTS) which include radio and
television, and theInternet - have been touted as potentially and powerful enablingtools for educational
change and reform. When used appropriately, different ICTS are said to help expand access to education,
Strengthen the relevance of education to the increasingly digital workplace, and raise educational quality by,
among others, helping make teaching and learning into an engaging, active process connected to reallife.

However, the effective integration of ICTS into the educational system is a complex, om ultifaceted
process that involves not just technology, indeed, given enough initial capital,getting the technology is the
easiest part - but also curriculum and pedagogy, Institutional readiness, teacher competencies and longterm
financing, among others.In this module we will get an overal idea about the concept of ICTS. We will also
dicuss the need & significance of ICTS in Education with specific reference to historical perspective and
emerging trends.

1.2 Concept of Information Technology
Today‘s world is a world of information explosion. This information explosion is taking place in such

a fast speed that even a literate person is feeling as if he or she is illiterate being not able to cope up with such
an information explosion. Here the question arises how is one to cope up with it? The answer is, information
technology (IT) that can help in coping with the informationexplosion. So, we can say that Information
Technology is nothing but coping up with explosion of Information. Information technology (IT) is the
acquisition, processing, storage and dissemination of vocal, pictorial, textual and numerical information by a
micro-electronics - based combination of computing and telecommunication. The term in its modern sense
first appeared in a 1958 article published in the Harvard Bussiness Review, in which authors Leavitt and
whisler commented that the new technology does not yet have a single established name. we shall call it
information technology. It spans a wide variety of areas that include but are not limited to things such as
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processes, computer software, computer hardware, Programming Languages and data constructs. In short,
anything that renders data, information or perceived knowledge in any visual format whatsoever, via any
multimedia distributionmechanism, is considered part of the domains space known as Information Technology.

1.3 Meaning of Information Techology (IT) :
Information Technology consists of two words Information and Technology. If you know the two

words you can understand the word information technology together. The term Information  refers to any
communication or representation of knowledge such as facts, data or opinions in any medium or for, including
textual, numerical, graphic Cartographic, narrative or audiovisual forms.

Technology is the practical form of scientific knowledge or the science of application of knowledge
to practical. Information Technology is any equipment or interconnected system or sub system of equipments
that is used in the acquistion, storage manipulation, management transmission or reception of data or
information.

1.4 Definition of Information Technology:
Information Technology is a scientific, technological and engineerning discipline and management

technique used in handing the information, it‘s application and association with social, economical and
cultural matters (UNSECO).

Information technology is a systemic study of artifacts that can be used to give form to facts inorder
to provide meaning for decision making, and artifacts that can be used for organization, processing,
communication and application of information (Darnton and Giacoletto).

From the above discussion we can conclude that information technology refers to the information
processing of the software application on operating systems or hardware applications that includes computers,
videos, telephones and related equipments of telecommunications, tapes, CDs etc.
1.5 Characteristics of Information Technology:
 Information Technology has the following Characteristics:

Acquistion, Storage, manipulation, management, transmission or reception of data or information.

Real time access to information.

Easy availability of updated data

Connecting Geographically dispersed regions

Wider range of communication media.

1.6 Concept of Communication Technology
Communication Technology is also comprised of two words like Communication & Technology.

We have already discussed that technology is the science of the application of knowledge to practical
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purposes. You also know that information means any communication or representation of knowledge in any
form. Now we will know what communication is?

Communication  is an integral part of human existence. It is communication that decides the very
identity of human beings Modern society is turning into an information society and communication is the
exchange of information. It is the process & transfering information form a Sender to a receiver with the use
of a medium in which the communication information is understood by both sender and receiver.

Communication Technology  implies the knowledge, skills and understanding needed to exchange
information verbally or non-verbally. It is processing of information interms of accessing information, decoding
information and sending it via a medium and changer to the receivers. Medium or channel can be written or
oral or gesture form of information through speech, action or any electronic machine.

Communication Technology is the electronic systems used for communication between indeividuals
or groups. It faciliates communication between individuals or groups. Who are not physically present at the
same location. Systems such as telephone, telex, Fax, radio, T.V. and Video are included, as well as more
recent computer based technologies, including electronic data interchange and e-mail.
In short, communication technolgoy is the activity of designing and constructing and maintaining communication
systems.

1.7 Information Communication Technology in Education
“Globalization and technological changes have created a new global economy powered by technology,

fueled by information and driven by knowledge.”The emergence of this new global economy has serious
implications for the nature and purpose of educational institutions. As the access to information continues to
grow rapidly, schools cannot be contented with the limited knowledge to be transmitted in a fixed period of
time. They have to become compatible to the ever expanding knowledge and also be equipped with the
technology to deal with this knowledge.

Information and communication technologies (ICTs)  which include radio and television, as well as
newer digital technologies such as computers and the Internet  have been proven as
potentially powerful tools for educational change and reform. When used appropriately, different ICTs can
help expand access to education, strengthen the relevance of education to the increasingly digital workplace,
and raise educational quality by helping maketeaching and learning into an active process connected to real
life.

1.8 Definitions
“ICT stand for information and communication technologies and is defined, as a “diverse set of

technological tools and resources used to communicate, and to create, disseminate, store, and manage
information.””ICT implies the technology which consists of electronic devices and associated human interactive
materials that enable the user to employ them for a wide range of teaching - learning processes in addition to
personal use.”

These technologies include computers, the Internet, broadcasting technologies (radio and television),
and telephony.”ICT is that technology which uses the information to meethuman need or purposes including
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processing and exchanging.””Information and communications technology (ICT) in education is the processing
of information and its communications facilities and features that variously support teaching, learning and a
range of activities in education.”All these definitions combine Communication technology and Information
technology that have thin line between them but cannot do away without each other. When these technologies
are applied in the field of education, it is termed as ICT in education. The term too can be used as the
connotation to the term Educational; technology because it also uses any hardware and software approaches
that can enhance yield better learning outcomes. In the era of Computer technology the term ICT mainly
focuses on the infrastructure, devices and sources of computer technology and thus it is imperative to
discuss about the use of ICT in education by focusing mainly on Computer based technology.

1.9 Characteristics of ICT in Education
ICT in education is any hardware and software technology that contribute in the educational

information processing. In thecontext of present era, ICT mainly comprises of Computer
technology with its hardware, like, Personal computer machine, infrastructure required for setting up Internet
facility and alsosoftware like, CD ROM including various programme packages, Elearning strategies etc.

ICT in education is any Information Technology that focuses on the acquisition, storage, manipulation,
management, transmission or reception of data required for the educational purpose. For example, the
information about students’ records, their admissions, updates of their auricular and co-curricular activities.

ICT in education is any technology that deals with the exchange of information or in other’words
communication in the teaching learning process. Uses of Electronic learning technology like, Teleconferencing,
power point presentations, CD ROM are Communication Technology which is the part of ICT.

ICT in education is any educational technology that is applied in the educational process. It
encompasses Hardware approach like use of machines and materials, Software approachlike use of
methodologies and strategies of teaching learning and Systems approach that uses the management technology
that deals with the systematic organization of the hardware and the
software. Different software packages for the use in different department of education; e.g. library software,
administration software, software related to managing the entire teaching learning process.

ICT in education is the support material in the hands of the human resource involved in the educational
process in order to enhance the quality of education.ICT in education comprises of the application of
science of On-line, Offlineleaming with the help of the computer technology.

1.10 Uses in Education
ICT is being utilized in every part of life. Due to the increasing importance of the computer, students-

the future citizens cannot afford to keep themselves aloof from this potential medium.
In education, use of ICT has become imperative to improve the efficiency and effectiveness at all levels and
in both formal and nonformal settings. Education even at school stage has to provide computer instruction.
Profound technical knowledge and positive attitude towards this technology are the essential prerequisites
for the successful citizens of the coming decades.
It can be used for the following purposes:
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• To broadcast material, online facility or CD-ROM can be used as sources of information in

        different subjects;

• To facilitate communication for pupils with special needs;

• To use electronic toys to develop spatial awareness and psychomotor control;

• To use the Online resource like, email, Chat, discussion forum to support collaborative  writing

            and sharing of information.

• To facilitate video-conferencing or other form of Tele conferencing to involve wide range of

            students from distant Geographic areas.

• For Blended learning by combining conventional classroom learning with E-leaming learning systems

• To process administrative and assessment data.

• To exchange and share ideas -among teachers for the professional growth.

• To carry out internet-based research to enhance , educational process

1.11 Advantages of the use of ICT in Education:
ICT encompasses all those gadgets that deal with the processing of information for better and effective

communication. In education, communication process takes place between teachers,
students, management and administrative personnel which requires plenty of data to be stored for retrieval as
and when required, to be disseminated or transmitted in the desired format. The hardware and software like
OHP, Television, Radio, Computers and related software are used in the educational process. However
ICT today is mostly focused on the use of Computer technology for processing the data. In this context,
advantages of ICT in education can be
listed down as follows :

1.11.1 Quick access to information
Information can be accessed in seconds by connecting to the internet and surfing through Web

pages.

1.11.2 Easy availability of updated data:
Sitting at home or at any comfortable place the desired information can be accessed easily. This

helps the students to learn the updated content. Teachers too can keep themselves abreast of the latest
teaching learning strategies and related technologies.

1.11.3  Connecting Geographically dispersed regions:
With the advancement of ICT, education does not remain restricted within four walls of the educational

institutions. Students from different parts of the world can learn together by using online, offline resources.
This would result in the enriching learning experience. Such collaborative learning can result in developing.
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• Divergent thinking ability in students,
• Global perspectives
• Respect for varied nature of human life and acculturation.
• Facilitation of learning

ICT has contributed in shifting the focus on learning than teaching. ICT helps students to explore
knowledge to learn the content through self study. Teacher can help the students by
ensuring the right direction towards effective learning. Situational learning, Programmed learning, many
Online learning courses are some of the example of self learning strategies that are being utilized with the
help of ICT.

1.11.4 Catering to the Individual differences:
ICT can contribute in catering to individual needs of the students as per their capabilities and

interest. Crowded class rooms have always been a challenge for the teacher to consider the needs of every
student in the class.

1.11.5 Wider range of communication media:
With the advent of ICT, different means of communication are being introduced in the teaching

learning process. Offline learning, on line learning, blended learning are some of the resources that can be
used in educational institutions. Collaborative learning, individualized learning strategies can enhance the
quality of group as well as individual learning. with the real society. This can ensure the applicability of
knowledge.

1.11.6 Wider learning opportunities for pupils:
Application of latest ICT in education has provided many options to the learners to opt for the

course of their choices. Many Online courses are available for them to select any as per their
aptitude and interest. Students can evaluate their own progress through different quizzes, ready to use
Online tests. This can ensure fulfillment of the employment required in the job market thus minimizing the
problem of unemployment. It can also provide more efficient and effective citizens to the society as per the
changing needs.

1.12 Self-Check Exercise

1. Define Information Technology
2. What is Information Technoogy? Explain its‘ Charateristics.
3. What is communication Technology?
4. What is Educational Technology?
5. What is ICT? Explain any two benefits of ICT in Education.
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In addition to above meaning of reprographic there are few meanings of reprographics are given
below:

Reprographics generally refers to methods of copying or reproducing documents that include
xerography and scanning. The term applies to both soft and hard copy reproduction.

Reprographics is a general term used to refer to multiple methods of reproducing content both
physical and digital which include xerography, photography, scanning and digital printing.
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2.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the telecom technology;
• History of Indian telecom industry;
• Objecives of the National telecom policy;
• Future opportunities of India telecom sector.

2.1 INTRODUCTION
Globalization, liberalization and privatization are the three most spoken words in today s world.

These initiatives paved way for all-round reforms, especially in developing economies, like India. These
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countries realized that development of effective and efficient means of communications and information
technology is important to push them onto the path of development. The growth of the telecom sector in
India during  post-liberalization has been phenomenal. This research aims to throw light on the factors that
contributed to growth in the segment and presents an insight on the present status of the industry

2.2 History of Indian Telecom Industry
The history of the Indian Telecom sector goes way back to 1851, when the first operational landlines

were laid by The British Government in Calcutta. With independence, all foreign telecommunication companies
were nationalized to form Post, Telephone and Telegraph, a monopoly run by the Government of India.

The Indian Telecom Sector, like most other infrastructure sectors is controlled by the state. The
Department of Telecommunications (DoT), reporting to the Ministry of Communications (MoC) is the key
body for policy issues and regulation, apart from being a basic service provider to rest of country. By an act
of Parliament, the Telecom Regulatory Authority of
India (TRAI) was formed to be the regulatory agency.

2.2.1 Ministry of Communication:
All the operations of this sector come under the control of MoC. It is responsible for all major

policy changes, planning, supervision, spectrum  control, etc.

2.2.2 Department of Telecommunications:
DoT was formed in 1985 when the Department of Posts and Telecommunications was eparated

into Department of Posts and Department of Telecommunications. Till 1986, it was the only  telecom service
provider in India. It played a role beyond service provider by acting  as a olicy maker, planner, developer as
well as an implementing body. In spite of being profitable, non-corporate entity status ensured that it did not
have to pay taxes. DoT depends on Government of India for its expansion plans and funding. Its pivotal role
in the Indian telecom sector has got diluted after formation of TRAI- Telecom Regulatory Authority of India.

2.2.3 Telecom Regulatory Authority of India:
TRAI was founded to act as an independent regulatory body supervising  telecom development in

India. This became important, as DoT was a regulator and a player as well. Founded by an Act of Parliament,
the main  functions of the body was to finalize toll rates and settle disputes between players. An independent
regulator is critical at the present situation as the sector witnesses competition. The operations of this sector
are determined as under the Indian Telegraph Act of 1885 – A document buried in the sands of time. The
next major policy document, which was produced, was the National Telecom Policy of 1994, a consequence
of the ongoing process of liberalization.

2.2.4 The Telecom Commission:
The Telecom Commission was set up by the government of India vide Notification dated April 11,

1989 with administrative and financial powers of the government of India to deal with various aspects of
Telecommunications. The Telecom Commission and the DoT are responsible for policy formulation, licensing,
wireless spectrum  management, administrative monitoring of PSUs, research and development and
standardization or validation of equipment, etc. The multi-pronged strategies followed by the Telecom
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Commission have not only transformed the very structure of this sector, but also have motivated all the
partners to contribute in accelerating the growth of the sector. The other entities in the sector under the
control of MoC are the two public sector telecom  equipment manufacturers, namely Indian Telephone
Industries (ITI) and Hindustan Teleprinters Ltd. (HTL). Both these companies are facing financial problems
because of product obsolescence, poor management and over staffing. Telecommunications Consultants
India Ltd. (TCIL), another PSU was founded in 1978 to undertake consultancy services in the field of
telecom. (Source; www.dotindia.com.)

2.3 Objectives of the National Telecom Policy

    The objectives of the NTP 1999 are as under:
Access to telecommunications is of most importance for achievement of the country s social and

economic goals. Availability of affordable and effective communication for the citizens is at the core of the
vision and goal of the telecom policy.

Strive to provide a balance between the provision of universal service to all uncovered areas, including
the rural areas, and the provision of high-level services capable of meeting the needs of the country s
economy.

Encourage development of telecommunications facilities in remote, hilly and tribal areas of the country.

Create a modern and efficient telecommunications infrastructure taking into account the convergence
of IT, media, and telecom and consumer electronics and thereby propel India into coming an IT superpower.

Convert PCOs, wherever justified, into Public Tele information centers having multimedia capability
like ISDN services, remote database access, government and community information systems, etc.

Transform in a time bound manner, the telecommunications sector to a greater competitive
environment in both urban and rural areas providing equal opportunities and level playing  field for all
players.

Strengthen research and development efforts in the country and provide an importance to build
world-class manufacturing capabilities.

Achieve efficiency and transparency in spectrum management.

Protect defense and security interests of the country.

Enable Indian telecom companies to become truly global players.

2.4 Telecommunication Services

Today tariff for telecommunication services in India is one of the lowest in the world. The Indian consumer
has immensely benefited from such lower tariffs which has also been a major factor for explosive growth in
the sector.  Following is the list of services offered by both GSM and CDMA operators:
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• Telephone services

• NSD/ISD services

• Computerized trunk services

• Pay phones

• National & international leased lines circuits

• Telex

• Telegraph services (manual & automatic)

• X-25 based Packer Switched Data Network (NET)

• Gateway Packet Switched Data Services (GPSS)

• Gateway Electronic Data Interchange Service (GEDIS)

• Gateway E-Mail and Store & Forward FAX Service (GEMS-400)

• Concert Packet Service (CPS)

• Satellite based remote area business message network

• Electronic Mail

• Voice

• Audio-text

• Radio paging

• Cellular mobile telephone

• Public mobile radio trunked service

• Video-text

• Video conferencing

• V-SAT

• Internet

• ISDN

• INMARSAT mobile service
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• INMARSAT data service

• Home country direct service

• Intelligent Network (IN) services

2.5 Global Telecom Industry: An Overview
With the awareness spreading around the world on the Information and Communications Technology

(ICT), in the later part of the 20th century countries, especially the developing ones, began to realize the
importance of an efficient telecommunication network for the development of the economy.
At the dawn of the 21st century, the developing countries started to make full use o f the technology revolution
taking place around the world, with many countries liberalizing the existing stringent policies and regulations.
To improve information and telecommunication technology, 189 countries of the UN met at the Fifty-Fifty
General Assembly on September 2000. A millennium declaration was made, according to which the countries
reaffirmed their commitment to improve the living conditions of poor and downtrodden in the world by
adopting intense poverty programmes. One of the targets of this declaration was adherent to “In co-operation
with the private sector make available the benefits of new technologies, especially information and
communication”. The indicators that were to be used for monitoring the progress were:

• Telephone line and cellular subscribers, per 100 units of population.

• Personal computers in use for 100 units of population.

• Internet user per 100 units of population.

Even before the declaration, many developing countries had started liberalizing their internal policies
to enable efficiency as to affordability as and reach ability of telecommunication system. By 1995, most of
the low income developing countries of the world, made their economies global, by liberalizing the domestic
licensing and important policies on the whole, to facilitate inflow of foreign capital into the infrastructure
sector, especially in the telecommunication sector. This resulted in a telecom revaluation, with countries
adopting liberalization initiates, experiencing a „never-before  growth in the telephone network, including the
penetration levels. Developing countries today account for Developing countries today account for 49% of
the total telephone network in the world. While in East Asia (including China) the total teledensity grew at a
rapid pace to reach 27.4 in 2002 the teledensity grew at a slower pace in south Asia (Including India), to
reach 4.5 in 2002.

This is due to imperfections in government regulatory and licensing policies in the „90s in most of the
South Asian countries. While there was imbalanced development in ICT among the developing countries in
individual growth in telecom, country-wise also showed a partial development, where the development in
other segments apart from cellular was snail-paced. This was due tophenomenal growth in the cellular segment,
whose major contribution was toward urban telephony. By the end of 2006, the telecommunication industry
had experienced continuous growth, as well as rapid progress in policy and technology development, resulting
in an increasingly competitive and networked world. It is true and encouraging that overall, the digital divide
has been reduced and continues to shrink. ITU statistics show that over the last
10 years, the digital divide between the developing and the developed countries has been narrowing in terms
of fixed telephone lines, mobile subscribers and Internet users. In contrast to the slow fixed line growth,
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phenomenal growth rates in the mobile sector particularly, have been able to reduce the gap that separates
the developed from the developing countries from 27 in 1996, to 4 in 2006. The fixed line gap has been
reduced from 11 to 4 during the same period.

2.6 Technology
Global system for Mobile communication (GSM around 80-85 % market share) Code Division

Multiple Access (CDMA, AROUND 10-15 % market share are two prevalent mobile communication
technologies.both technologies have to solve the same problem: to dive the finite Radio Frequency spectrum
among multiple users. India primarily follows the GSM mobile system, in the 900MHz and 1800MHz band.
The 900MHz band has greater transmission characteristics, thereby enabling lower capex cost for expansion
of coverage area, as the number of towers and the base stations required would be lesser than in the 1800MHz
band.

2.6.1 TDMA (Time Division Multiple Accesses:
Underlying technology used in GSM’s G) does it by chopping up the channel into sequential time

slices. Each user of the channel takes turns to transmit and receive signals. In reality, only one person is
actually using the channel at a specific moment. This is analogous to time-sharing on a large computer server.

2.6.2 CDMA (Code Division Multiple Access:
Underlying technology used in GSM’s 3G and IS-95’s 2G) on the other hand, uses a special type of

digital modulation called spread spectrum which spreads the voice data over a very wide channel in
pseudorandom fashion. The receiver undoes the randomization to collect the bits together and produce the
sound.

 2.7 Advantages of 2G GSM

• GSM is mature and has a more stable network with robust features.

• Less signal deterioration inside buildings.

• Talk time is generally higher in GSM phones due to the pulse nature of transmission.

• The availability of Subscriber Identity Modules allows users to switch networks and handsets at will.

• GSM covers virtually all parts of the world so international roaming is not a problem.

• The much bigger number of subscribers globally creates a better network effect for GSM handset
makers, carriers and end users.

2.8 Advantages of CDMA

Capacity is CDMA’s biggest asset. It can accommodate more users per MHz of bandwidth than
any other technology.

• CDMA has no built-in limit to the number of concurrent users.
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• CDMA consumes less power and covers large areas so cell size in CDMA is larger.

• CDMA is able to produce a reasonable call with lower signal (cell phone reception) levels. CDMA
uses „soft handoff , reducing the likelihood of dropped calls.

• CDMA s variable rate voice coders reduce the rate being transmitted when speaker is not talking,
which allows the channel to be packed more efficiently.

2.9 Disadvantages of 2G GSM

• Pulse nature of TDMA transmission used in 2G interferes with some electronics, especially certain
audio amplifiers. 3G uses W-CDMA now.

• Intellectual property is concentrated among a few industry participants, creating barriers to entry for
new entrants and limiting competition among phone manufacturers.

• GSM has a fixed maximum cell site range of 35 km, which is imposed by technical limitations.

2.10 Disadvantages of CDMA

• Most technologies are patented and must be licensed from Qualcomm.
• Breathing of base stations, where coverage area shrinks under load.
• As the number of subscribers using a particular site goes up, the range of that site goes down.
• CDMA may not perform well in hilly terrain because CDMA towers interfere with themselves; they

are normally installed on much shorter towers.
• CDMA covers a smaller portion of the world, and CDMA phones are generally unable to roam

internationally.
• Manufacturers are often hesitant to release CDMA devices due to the smaller market, so features

are sometimes late in coming to CDMA devices.
• The phones are not portable across providers (Source; www.itu.int.)

2.11 Future Growth Opportunities of Indian Telecom Sector

As per TRAI, two other associated aspects for market growth are availability of spectrum and
availability of resources for network rollout and expansion.  The government is currently looking into these
two areas. The 79% hike in FDI has been cleared by the government to ensure continuous flow of investments
to expand the reach of the mobile operators. To realize full market potential and achieve the forecasts,
telecom operators have to work on a segmented approach and focus on the five key strategies given below:

• Mobile in the hand of every urban youth (age group 15 to 24 years).
• Mobile in the hand of every executive/businessman/ skilled worker.
• Mobile in every household with income above Rs. 4000.
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• Mobile penetration in every town/village, with a population of over 3,000.
• Mobile Phones affordable and available wherever mobile services available.

2.12 Self-Check Excerise
1. Discuss about telecom Technology.
2. What are the services provided by telecom?
3. What are the objectives of national telecom policy
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3.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the satellite technology;
• Definition of satellite;
• Types of satellite;
• Indian satellite technology.

3.1 INTRODUCTION
Over the last several years small satellites have emerged as a viable option to carry out any number of

missions as technological advances have enhanced the capabilities of spacecraft weighing a few hundred
kilograms or less.  In recent years, there have been many advances in the miniaturization of electronic and
mechanical technologies for space applications. This paper describes the current status and the future
trends of small satellite technology. Examples of small satellites making use of current small satellite
technologies and future evolutions of small satellite technologies are presented.

Satellites can provide global, ubiquitous and multipoint communications. Not surprisingly, satellite
technology has become a flexible and cost-effective solution for domestic and international networks,
irrespective of the user’s geographic location. Wireline and wireless
lack this ability to leap across continents and oceans, often linking some of the world’s most remote spots.
Satellite technology can thus become a solution for some of the most  complicated access problems,
connecting cities across a large landmass, where copper or fiber would be cost prohibitive. Bringing
broadband to the “last mile” of residences and businesses.Overcoming regulatory issues that make alternative
carriers dependent on incumbents. Satellites also have a major role to play in designing, developing and
expanding a network. With a satellite and Earth Stations, you can create a network on a permanent or
interim basis much more rapidly than “laying cable.” An interim station will even let you test a market
or provide emergency service prior to a major infrastructure investment. You can also rapidly scale and re-
provision a satellitebased network to meet increasing and changing needs. The benefits of satellite
communications have steadily expanded its usage.

Today, satellites’ diverse purposes encompass wide area network communication, cellular backhaul,
Internet trunking, television broadcasting and rural telephony. Satellites are also on the frontiers  of such
advanced applications as telemedicine, distance learning, Voice over Internet Protocol (VoIP) and video
on demand (VOD). Intelsat has created this Primer to provide an introduction to the technology used in
satellite networks. Our intention is help you understand, in general terms, why and how satellite technology
might meet your needs. For more information, we invite you to talk to our experts and discuss your specific
requirements. We hope this introductory material will be useful to you in meeting the challenges ahead in
your network
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3.2 What is a Satellite?

An object in an orbit is called a satellite. A satellite can be natural, like the Moon, or human (or
extraterrestrial?) -made. Satellites can travel around planets or around stars such as our Sun. All the
planets are satellites around the Sun. Almost every ship launched from Earth can be considered a satellite,
as it is orbiting either the Earth or the Sun. Even though a space probe is going “out” from the Earth to
Jupiter, it is still in orbit around the Sun, so it is still a satellite.

Communications satellites receive, amplify, and transmit radio signals between dish antennas that may be
hundreds of miles apart.

3.3 Definition of Satellite
A small body in orbit  around a larger body. See Note at moon. An object launched to orbit

Earth or another celestial body. Satellites are used for research, communications, weather information,
and navigation. The first artificial Earth satellite was Sputnik 1, launched by the Soviet Union in October
1957; the first successful American satellite was launched in January 1958.

3.4 Types and Uses of Satellites
Satellites can be classified by their functions. Satellites are launched into space to do a specific job.

The type of satellite that is launched to monitor cloud patterns for a weather station will be different than a
satellite launched to send television signals across Canada. The satellite must be designed specifically to
fulfill its function.

Below are the names of nine different types of satellites.
1. Astronomy satellites - Hubble Space Telescope
2. Atmospheric Studies satellites - Polar
3. Communications satellites - Anik E
4. Navigation satellites - Navstar
5. Reconaissance satellites - Kennan, Big Bird, Lacrosse
6. Remote Sensing satellites - Radarsat
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7. Search and Rescue satellites - Cospas-Sarsat
8. Space Exploration satellites - Galileo
9. Weather satellites - Meteosat

3.4.1 Astronomy Satellite
An astronomy satellite is basically a really big telescope floating in space. Because it is in orbit

above the Earth, the satellite’s vision is not clouded by the gases that make up the Earth’s atmosphere,
and its infrared imaging equipment is not confused by the heat of the Earth. Astronomy satellites,
therefore, can “see” into space up to ten times better than a telescope of similar strength on Earth. Can
you guess what kinds of things an astronomy satellite would be looking at?

These are some pictures taken by the astronomy satellite Hubble of stellar phenomena like
supernovas, distant galaxies, black holes, and quasars:

                     Supernova         Distant galaxies         Black hole            Quasar

By analyzing the electromagnetic spectrum, the different wavelengths of light (for example,
ultraviolet, x-ray, visible spectrum, microwaves, and gamma rays) make a picture of something far away
in space. So, the pictures that come from Hubble and other astronomy satellites are not photographs from
a regular camera, but images created from the analysis of electromagnetic waves - the waves that make
up the light spectrum.
Astronomy satellites have many different applications:

• they can be used to make star maps

• they can be used to study mysterious phenomena such as black holes and quasars

• they can be used to take pictures of the planets in the solar system

• they can be used to make maps of different planetary surfaces

Astronomy satellites are different from space exploration satellites because they collect their data
from Earth orbit. Space exploration satellites are really probes that are sent out into deep space.The
Hubble Space Telescope is an example of an astronomy satellite.
3.4.2 Atmospheric Studies satellites – Polar

Atmospheric studies satellites were some of the very first satellites launched into space. They
generally have pretty low Earth orbits so that they can study the Earth’s atmosphere.
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Alouette, the first satellite launched by Canada, was also the world’s first atmospheric studies satellite.

The purpose of Alouette was to study the Earth’s ionosphere (a charged layer of the atmosphere). Canadian
scientists were trying to learn more about the aurora borealis, or northern lights - disturbances of the ionosphere
in the atmosphere which create brilliant lights in the northern skies at night, but disturb radio communications.
A more recent example of a satellite studying the atmosphere is NASA’s Polar satellite.

3.4.3 Communications satellites - Anik E
It is difficult to go through a day without using a communications satellite at least once. Do you know

when you used a communications satellite today? Did you watch T.V.? Did you make a long distance phone
call, use a cellular phone, a fax machine, a pager, or even listen to the radio? Well, if you did, you probably
used a communications satellite, either directly or indirectly.

Communications satellites allow radio, television, and telephone transmissions to be sent live anywhere
in the world. Before satellites, transmissions were difficult or impossible at long distances. The signals, which
travel in straight lines, could not bend around the round Earth to reach a destination far away. Because
satellites are in orbit, the signals can be sent instantaneously into space and then redirected to another
satellite or directly to their destination.

The satellite can have a passive role in communications like bouncing signals from the Earth back to
another location on the Earth; on the other hand, some satellites carry electronic devices called transpondersfor
receiving, amplifying, and re-broadcasting signals to the Earth.

Communications satellites are often in geostationary orbit. At the high orbital altitude of 35,800
kilometers, a geostationary satellite orbits the Earth in the same amount of time it takes the Earth to revolve
once. From Earth, therefore, the satellite appears to be stationary, always above the same area of the Earth.
The area to which it can transmit is called a satellite’s footprint. For example, many Canadian communications
satellites have a footprint which covers most of Canada.

Communications satellties can also be in highly elliptical orbits. This type of orbit is roughly egg-
shaped, with the Earth near the top of the egg. In a highly elliptical orbit, the satellite’s velocity changes
depending on where it is in its orbital path. When the satellite is in the part of its orbit that’s close to the Earth,
it moves faster because the Earth’s gravitational pull is stronger. This means that a communications satellite
can be over the region of the Earth that it is communicating with for the long part of its orbit. It will only be
out of contact with that region when it quickly zips close by the Earth.

3.4.4 Navigation satellites – Navstar
Satellites for navigation were developed in the late 1950’s as a direct result of ships needing to know

exactly where they were at any given time. In the middle of the ocean or out of sight of land, you can’t find
out your position accurately just by looking out the window.

The idea of using satellites for navigation began with the launch of Sputnik 1 on October 4, 1957. Scientists
at Johns Hopkins University’s Applied Physics Laboratory monitored that satellite. They noticed that when
the transmitted radio frequency was plotted on a graph, a pattern developed. This pattern was recognizable
to scientists, and it is known as the doppler effect. The doppler effect is an apparent change of radio
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frequency as something that emits a signal in the form of waves passes by. Since the satellite was emitting
a signal, scientists were able to show that the doppler curve described the orbit of the satellite.

Today, most navigation systems use time and distance to determine location. Early on, scientists
recognized the principle that, given the velocity and the time required for a radio signal to be transmitted
between two points, the distance between the two points can be computed. The calculation must be done
precisely, and the clocks in the satellite and in the ground-based receiver must be telling exactly the same
time - they must be synchronized. If they are, the time it takes for a signal to travel can be measured and
then multiplied by the exact speed of light to obtain the distance between the two positions. The Navstar
satellites are examples of satellites that use this principle.

3.4.5 Reconaissance satellites - Kennan, Big Bird, Lacrosse
These days, you hear a lot about satellites for communications and scientific research. Some

satellites, though, have far less public uses. Reconnaissance satellites are used to spy on other countries.
They provide intelligence information on the military activities of foreign countries. These satellites can even
detect missile launches or nuclear explosions in space. Reconnaissance satellites can pick up and record
radio and radar transmissions while passing over a country. Finally, they can be used as an orbital weapon
by placing warheads on a low orbit satellite to be launched at a ground target. (This is not a recommended
or frequent use of satellites.)

There are basically four types of reconnaisance satellites. First, there are the optical-imaging satellites
that have light sensors that detect missile launches and “see” enemy weapons on the ground. Next are the
radar-imaging satellites. They are able to observe the Earth using radar technology through cloud cover.
Third, there are signals-intelligence or ferret satellites that are essentially super-sophisticated radio receivers
that capture the radio and microwave transmissions emitted from any country on Earth. Finally, there are
the relay satellites that make military satellite communications around the globe much faster by transmitting
data from spy satellites to stations on Earth.

Starting in the 1960’s, the United States began launching many series of reconaissance satellites.
The first series was called Discover, and as these satellites circled the Earth in polar orbits, they took
pictures. The next series of U.S. spy satellites was given the code name Keyhole, or KH for short. They
mostly did routine surveillance or weapons targeting. In a low, 80-mile orbit, they either took wide-area
pictures of large land masses or took close-up pictures of special interest objects.

KH-9 was a noteworthy satellite from that series. Weighing 30, 000 pounds, it was nicknamed
Big Bird because of its extraordinarily large size. Big Bird, however, was unable to penetrate the thick
cloud cover that often obscured the areas it was targeting. Sophisticated for its time, the camera used by
Big Bird took area-surveillance images and close-up photos.
In 1976, KH-11, code-named Kennan, was launched. From Kennan’s sun-synchronous orbit, the sun
was at a constant angle with respect to objects on Earth. This choice of orbit helped to detect the movement
and size of objects observed by Kennan by using the shadows recorded from space. Kennan also used a
special piece of technology called a charge-coupled device (CCD) to obtain images.
3.4.6 Remote Sensing satellites – Radarsat

Remote sensing is observing and measuring our environment from a distance. So, remote
sensing satellites are usually put into space to monitor resources important for humans. For example,
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remote sensing satellites might track animal migration, locate mineral deposits, watch agricultural crops
for weather damage, or see how fast the forests are being cut down.

All of these things can be done best from space because a satellite in orbit can normally take
photographs of large expanses of land all over the world. Since these satellites are able to take photographs
and observe areas all over the globe, the satellite is able to monitor areas in which the climate is very harsh,
or which are nearly impossible tor reach by land. Canada’s main remote sensing satellite, Radarsat, does
just that.

3.4.7 Search and Rescue satellites - Cospas-Sarsat
Sure satellites can transmit radio and television signals, but can they save lives too? Of course they

can! Search and rescue satellites are designed to provide a way for vessels at sea and in the air to
communicate from remote areas. These satellites can detect and locate emergency beacons carried by
ships, aircrafts, or individuals in remote or dangerous places.

The first rescue aided by spacecraft was in September of 1982 when a Soviet satellite, Cosmos-
1383, detected a distress beacon from a pair of small airplanes that had crashed. The satellite was able to
give rescuers the location of the two downed planes; they were the airplanes of a young man and the young
man’s father who had set out looking for his son’s plane crash site.

The idea of search and rescue satellites comes from weather satellite programmes. Meteosat, for example,
monitors weather patterns by direct observation, but it also analyzes signals sent out from buoys floating in
the ocean. Those buoys collect local weather information and transmit that to the satellite. The satellite then
uses the doppler effect to find out where that particular buoy is. This mechanism is similar to the technology
now used for search and rescue.

Satellites equipped with search and rescue equipment fly over a beacon that is releasing an emergency
signal. Using mathematical calculations involving the doppler effect, scientists can translate that signal into
coordinates, and determine the location of the distress signal within four kilometres.

In 1974, Canada made it law that all aircraft must carry a beacon called an Emergency Locator
Transmitter (ELT). After the ELT came the Emergency Position Indicating Radio Beacon (EPIRB). EPIRB’s
are automatic, self-powered, very portable, completely waterproof, and they float.The newest search and
rescue system is the Cospas-Sarsat system. It is an international search and rescue system made up of a
network of satellites in space, and control centres on Earth-ground stations, mission control centres, and
rescue coordination centres.

The Sarsat system was developed in a joint effort by the United States, Canada, and France. The
Cospas system was developed by the Soviet Union. These four nations banded together in 1979 to form
Cospas-Sarsat. In 1982, the first Cospas-Sarsat satellite was launched, and by 1984 the system was
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declared fully operational. From there, the Cospas-Sarsat organization continued to grow. The four original
member nations have now been joined by 25 other nations that operate 28 ground stations and 15 mission
control centres worldwide. In the eyes of the countries using this system, Cospas-Sarsat has very much
helped search and rescue efforts.
3.4.8 Space Exploration satellites – Galileo

Space exploration satellites are not really satellites at all; they are properly known as space probes.
A satellite is defined as something that’s orbiting something else, but space probes instead travel deep into
the solar system. However, they are similar to orbiting satellites in design and function.

On their journeys, space probes send back detailed pictures and other data of faraway planets
and other stellar phenomena. Space exploration satellites are responsible for many of astronomy’s most
important achievements. Jupiter’s rings, for example, were discovered by a space exploration satellite.

Space exploration satellites must be built to last because it takes so long for the satellites to
reach their destinations. Space exploration satellites are different from astronomy satellites because they
do not operate from Earth orbit; they are actually sent out into deep space on their own. An example of
a space exploration satellite is NASA’s Galileo.

3.4.9 Weather satellites - Meteosat
Because of weather satellite technology and communications satellite technology, one can find

out the weather anywhere in the world any time of the day. There are television stations that carry
weather information all day long. Meteorologists use weather satellites for many things, and they rely on
images from satellites. Here are a few examples of those uses:

• Radiation measurements from the earth’s surface and atmosphere give information on amounts of

heat and energy being released from the Earth and the Earth’s atmosphere.

• People who fish for a living can find out valuable information about the temperature of the sea from

measurements that satellites make.

• Satellites monitor the amount of snow in winter, the movement of ice fields in the Arctic and

Antarctic, and the depth of the ocean.

• Infrared sensors on satellites examine crop conditions, areas of deforestation and regions of drought.

• Some satellites have a water vapour sensor that can measure and describe how much water

vapour is in different parts of the atmosphere.

• Satellites can detect volcanic eruptions and the motion of ash clouds.

• During the winter, satellites monitor freezing air as it moves south towards Florida and Texas,

allowing weather forecasters to warn growers of upcoming low temperatures.
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• Satellites receive environmental information from remote data collection platforms on the surface

of the Earth. These include transmitters floating in the water called buoys, gauges of river levels

and conditions, automatic weather stations, stations that measure earthquake and tidal wave

conditions, and ships. This information, sent to the satellite from the ground, is then relayed from

the satellite to a central receiving station back on Earth.

There are two basic types of weather satellites: those in geostationary orbit and those in polar orbit. Orbiting
very high above the Earth, at an altitude of 35,800 kilometres (the orbital altitude), geostationary satellites
orbit the Earth in the same amount of time it takes the Earth to revolve once. From Earth, therefore, the
satellite appears to stay still, always above the same area of the Earth. This orbit allows the satellite to
monitor the same region all the time. Geostationary satellites usually measure in “real time”, meaning they
transmit photographs to the receiving system on the ground as soon as the camera takes the picture.

A series of photographs from these satellites can be displayed in sequence to produce a movie
showing cloud movement. This allows forecasters to watch the progress of large weather systems such as
fronts, storms, and hurricanes. Forecasters can also find out the wind direction and speed by monitoring
cloud movement.

The other basic type of weather satellite is polar orbiting. This type of satellite orbits in a path that
closely follows the Earth’s meridian lines, passing over the north and south poles once each revolution. As
the Earth rotates to the east beneath the satellite, each pass of the satellite monitors a narrow area running
from north to south, to the west of the previous pass. These ‘strips’ can be pieced together to produce a
picture of a larger area.

Polar satellites circle at a much lower altitude at about 850 km. This means that polar satellites can
photograph clouds from closer than the high altitude geostationary satellites. Polar satellites, therefore,
provide more detailed information about violent storms and cloud systems. To find out more about an
example of a weather satellite, Meteosat, 

3.5 The Benefits of Using Satellite
Communications satellites have distinct benefits over terrestrial alternatives:
3.5.1 Ubiquitous Coverag:

      A small group or constellation of satellites can cover virtually all of the inhabited Earth’s surface. Even
one satellite can cover a much vaster number of potential subscribers than any terrestrial network.
3.5.2 Consistent Quality of Service (QoS:

Essentially, satellites can deliver consistent quality of service to an almost infinite number of locations,
regardless of geography. Whereas terrestrial IP networks are often a mixture of different networks and
topologies, with different levels of congestion and latency, the predictability of satellite networks provides
a constant, uniform QoS. In a terrestrial packet network, variations in the level of congestion and latency
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can cause problems such as packet “jitter,” requiring large equipment buffers to avoid degradation of the
voice quality. On the other hand, the predictability of satellite latency levels provides a much more consistent

3.5.3 Infrastructure Building:
Satellite service can be offered in areas where there is no terrestrial infrastructure and the costs of

deploying a fiber or microwave network are prohibitive. It can also support services in areas where existing
infrastructure is outdated or insufficient.

3.5.4 Cost Predictability:
Satellite communication is distance insensitive, thus providing cost predictability.

3.5.5 Traffic Bypass:
Satellite can provide additional bandwidth to divert traffic from congested areas, to provide overflow

during peak usage periods and to provide redundancy in the case of terrestrial network outages. By being
wholly independent of a wireline infrastructure, satellite is the only “truly diverse” communication alternative.
3.5.6 Scalability and Reconfigurability:

Satellite connections and Earth Stations are extremely scalable. In contrast to terrestrial alternatives,
they can be deployed quickly and inexpensively, enabling rapid network build-out. You can easily reconfigure
satellite networks to match changing user demand. Satellite ground equipment also provides unparalleled
flexibility because you can install it on an interim basis, to test new markets or to keep communications going
in an emergency. As demand increases or an emergency stabilizes, you can re-deploy the equipment to
another area and, for a new market, replace the satellite network with a permanent terrestrial presence. As
an emergency stabilizes, you can re-deploy the equipment to another area.

3.5.7 Temporary Network Solutions:
 For temporary locations, or mobile applications, such as news gathering, homeland security or

military activities, satellite can often provide the only practical solution for getting necessary information out.

3.5.8 Total Network Management:

Satellite can provide a single-tier, end-to-end backbone infrastructure. Meanwhile, terrestrial facilities
may be managed by multiple organizations. From this perspective, satellites also provide a “truly private”
network, entirely under  the operator’s control.

3.5.9 A Long-Term Solution for the Last Mile:
The biggest problem with the last mile is getting the high-bandwidth capabilities available in the long-distance
networks to the residence or small business. Network  operators “over-built” the long-distance arena (a
relatively easy equipment task) without improving capacity for the access arena between central office and
home. By being independent of terrestrial equipment factors, satellite can provide cost-effective multipoint
access, either to the CO or directly to the home.
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3.5.10 Rapid Provisioning of New Services:

 Since satellite solutions can be set up quickly, you can be fast-tomarket with new services. For the
most part, you can re-point or expand services electronically without the customary “truck rolls” of traditional
terrestrial networks. As a result, you can decrease capital expenditures while realizing revenues earlier. Of
course, all communications satellite networks are not alike. To realize these general advantages, it is helpful
to know the elements of satellite architecture. While the structure of a communications satellite remains the
same, its capacity and frequency bands will vary according to your needs.

3.6 Indian Satellites in Brief
For the past four decades, ISRO has launched more than 65 satellites for various scientific and

technological applications like mobile communications, Direct-to-Home services, meteorological
observations, telemedicine, tele-education, disaster warning, radio networking, search and rescue
operations, remote sensing and scientific studies of the space. 

ISRO has established two major space systems, the Indian National Satellite System (INSAT)
series for communication, television broadcasting and meteorological services which isGeo-Stationary
Satellites, and Indian Remote Sensing Satellites (IRS) system for resources monitoring and management
which is Earth Observation Satellites.

ISRO has launched many Experimental Satellites which are generally small comparing to INSAT
or IRS and Space Missions to explore the space.

3.7 Indian Installed Satellites

Satellite Launch Date Launch Vehicle Type of Satellite

SARAL 25.02.2013 PSLV-C20 Earth Observation Satellite

GSAT-10 29.09.2012 Ariane-5VA-209 Geo-Stationary Satellite

RISAT-1 26.04.2012 PSLV-C19 Earth Observation Satellite

Jugnu 12.10.2011 PSLV-C18 Experimental / Small Satellite

SRMSat 12.10.2011 PSLV-C18 Experimental / Small Satellite

Megha-Tropiques 12.10.2011 PSLV-C18 Earth Observation Satellite

GSAT-12 15.07.2011 PSLV-C17 Geo-Stationary Satellite

 GSAT-8 21.05.2011 Ariane-5VA-202 Geo-Stationary Satellite
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RESOURCESAT-2 20.04.2011 PSLV-C16 Earth Observation Satellite

YOUTHSAT 20.04.2011 PSLV-C16 Experimental / Small Satellite

GSAT-5P 25.12.2010 GSLV-F06 Geo-Stationary Satellite

STUDSAT 12.07.2010 PSLV-C15 Experimental / Small Satellite

CARTOSAT-2B 12.07.2010 PSLV-C15 Earth Observation Satellite

GSAT-4 15.04.2010 GSLV-D3 Geo-Stationary Satellite

Oceansat-2 23.09.2009 PSLV-C14 Earth Observation Satellite

ANUSAT 20.04.2009 PSLV-C12 Experimental / Small Satellite

RISAT-2 20.04.2009 PSLV-C12 Earth Observation Satellite

Chandrayaan-1 22.10.2008 PSLV-C11 Space Mission

CARTOSAT - 2A 28.04.2008 PSLV-C9 Earth Observation Satellite

IMS-1 28.04.2008 PSLV-C9 Earth Observation Satellite

INSAT-4B 12.03.2007 Ariane-5ECA Geo-Stationary Satellite

CARTOSAT - 2 10.01.2007 PSLV-C7 Earth Observation Satellite

SRE - 1 10.01.2007 PSLV-C7 Experimental / Small Satellite

INSAT-4CR 02.09.2007 GSLV-F04 Geo-Stationary Satellite

INSAT-4C 10.07.2006 GSLV-F02 Geo-Stationary Satellite

INSAT-4A 22.12.2005 Ariane-5GS Geo-Stationary Satellite

HAMSAT 05.05.2005 PSLV-C6 Experimental / Small Satellite

CARTOSAT-1 05.05.2005 PSLV-C6 Earth Observation Satellite

EDUSAT (GSAT-3) 20.09.2004 GSLV-F01 Geo-Stationary Satellite
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Resourcesat-1(IRS-P6) 17.10.2003 PSLV-C5 Earth Observation Satellite

INSAT-3A 10.04.2003 Ariane-5G Geo-Stationary Satellite

INSAT-3E 28.09.2003 Ariane-5G Geo-Stationary Satellite

GSAT-2 08.05.2003 GSLV-D2 Geo-Stationary Satellite

KALPANA-1(METSAT) 12.09.2002 PSLV-C4 Geo-Stationary Satellite

INSAT-3C 24.01.2002 Ariane-42L H10-3 Geo-Stationary Satellite

Technology Experiment 22.10.2001 PSLV-C3Earth                                  Earth Observation Satellite

GSAT-1 18.04.2001 GSLV-D1 Geo-Stationary Satellite

INSAT-3B 22.03.2000 Ariane-5G Geo-Stationary Satellite

Oceansat(IRS-P4) 26.05.1999 PSLV-C2 Earth Observation Satellite

INSAT-2E 03.04.1999 Ariane-42P H10-3 Geo-Stationary Satellite

INSAT-2DT January 1998 Ariane-44L H10 Geo-Stationary Satellite

IRS-1D 29.09.1997 PSLV-C1 Earth Observation Satellite

INSAT-2D 04.06.1997 Ariane-44L H10-3 Geo-Stationary Satellite

IRS-P3 21.03.1996 PSLV-D3 Earth Observation Satellite

IRS-1C 28.12.1995 Molniya Earth Observation Satellite

INSAT-2C 07.12.1995 Ariane-44L H10-3 Geo-Stationary Satellite

IRS-P2 15.10.1994 PSLV-D2 Earth Observation Satellite

Stretched Rohini Satellite 04.05.1994 ASLV Space Mission

IRS-1E 20.09.1993 PSLV-D1 Earth Observation Satellite

Satellite(TES)

Series (SROSS-C2)
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INSAT-2B 23.07.1993 Ariane-44L H10+ Geo-Stationary Satellite

INSAT-2A 10.07.1992 Ariane-44L H10 Geo-Stationary Satellite

Stretched Rohini
 Satellite Series
(SROSS-C)

   20.05.1992 ASLV Space Mission

IRS-1B 29.08.1991     Vostok Earth Observation Satellite

INSAT-ID                                12.06.1990                     Delta 4925                                       Geo-Stationary Satellite

INSAT-1C 21.07.1988     Ariane-3 Geo-Stationary Satellite

Stretched Rohini
 Statellite Series
 (SROSS-2)                             13.07.1988        ASLV                                            Earth Observation Satellite

IRS-1A 17.03.1988       Vostok Earth Observation Satellite

Stretched Rohini
 Statellite Series
 (SROSS-1)                             24.03.1987        ASLV                                                Space Mission

INSAT-1B 30.08.1983 Shuttle [PAM-D] Geo-Stationary Satellite

INSAT-1A 10.04.1982 Delta 3910 PAM-D Geo-Stationary Satellite

Rohini (RS-D2) 17.04.1983 SLV-3 Earth Observation Satellite

Bhaskara-II 20.11.1981 C-1 Intercosmos                      Earth Observation

Satellite
Ariane Passenger
 Payload Experiment
 (APPLE) 19.06.1981 Ariane-1(V-3)            Geo-Stationary Satellite
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Rohini (RS-1) 18.07.1980 SLV-3 Experimental / Small Satellite

Rohini (RS-D1) 31.05.1981 SLV-3 Earth Observation Satellite

Experimental/SmallSatellite

Bhaskara-I 07.06.1979 C-1 Intercosmos Earth Observation Satellite

Aryabhata 19.04.1975 C-1 Intercosmos Experimental / Small Satellite

3.8 Self-Check Excerise

1. What is satellite?

2. Enumerate the types of satellite.

3. Discuss in brief about Indian Satellite.
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4.0 OBJECTIVES

After reading this Chapter, you will be able to:
• Understand the reprography technology;
• Basic reprographic methods;
• Use of reprographic;
• Types of printing process.
• E-Publishing-Advantages & Disadvantages
• E-Books & E-Journals

4.1 INTRODUCTION
Reprography, a very old concept in libraries and information centres, was originally intended to

cover document reproduction techniques by photography viz., microfilming, photostating, and contact
copying with silver halide papers. Presently this includes a very wide range of methods, materials, processes
and equipments used for document reproduction. Initially, micrography was used to save space and for
archival purposes, however, now its uses have increased manifold. Reprography is now an insparable part
of information centres and libraries as well as users and plays an important role in communicating the
recorded knowledge. Several photographic processes have been devised for producing copies. From the
advent of the written word, the desirability of copies for duplicates has spurred the efforts of man. It
includes the invention of photography (1849-Frenchman, L.G.M. Dagurre and an Englishman, W.H.F.
Talbold), Photostat (1900-France, Abbe Rena Graffin), and photocopying (1938, American, Chester F.
Carlson), Micrography (1939-59), Polygraphy (1804), Hawkins, typewriter, Silver halide diazomethod,
blue printing and brown printing, and electrofax (1954).

The advent of the new system of reprography came into being in 1950, with reproduction (producing
a fresh) and photograph, the technique to produce images (1-3). Reprography has evolved over the years
through the desire and need to document and distribute information. Sophisticated electromic techniques
led to the process of reprograpy in 1976, and the 1980-90s marked the advent for possible revoluntionary
changes during which digital Xeroxing with colour, zoom, sorting, stapling facilities had arrived. Reomte
browsing and tele-delivery of documents will be used in future.

4.2 Reprographic
A material is said to be reprographic if it has undergone the process of reproduction by photographic,

mechanical or electronic means. Some of these methods include scanning, photocopying, which is sometimes
referred to as xerography, photography and digital printing.

In addition to above meaning of reprographic there are few meanings of reprographics
are given below:

Reprographics generally refers to methods of copying or reproducing documents that include
xerography and scanning. The term applies to both soft and hard copy reproduction.

4.4.2
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Reprographics is a general term used to refer to multiple methods of reproducing content both
physical and digital which include xerography, photography, scanning and digital printing.

Reprographics is a main term that encompasses multiple methods of reproducing content, such as
photography, scanning and digital printing. It applies to both physical soft copy and hard copy
reproductions of documents and images.

Reprographics refers to a process of reproducing, reprinting or copying graphic material especially
by mechanical, photographic, or electronic means. It usually encompasses multiple methods of
reproducing content, such as scanning, photography, xerography and digital printing.

4.3 Basic Reprographic Methods

Some possible choices for reproduction will generally be available:

(1) carbon paper,

(2) automated typewriters,

(3) copiers,

(4) duplicators, and

4.3.1Carbon Paper

Although carbon paper or copying film is not as popular as it once was, estimated costs are less than
one-half that of photocopying machines. Carbon packs used in conjunction with text-editing typewriters are
especially useful because the machines play back (print) copy that has already been corrected.

Another timesaver is specially treated paper known as carbonless copy paper that imprints without
using a separate sheet of carbon paper. This type of copy paper is frequently used for multicopy forms, In
determining whether to use carbon paper, office professionals should weigh the costs of the time needed to
correct carbons against the slightly higher costs of copies from copying machines.

4.3.2 Automated Typewriters

Automated typewriters can automatically play back previously recorded copy that has been stored
in the form of machine memory, cassettes, paper, or magnetic cards and tapes. Depending on the speed of
the printing equipment used, originally typed documents can be turned out in seconds.

When evaluating the use of an automated typewriter, remember that the higher cost of typed copy must be
weighed against the benefits typed copy gives. In such applications as fund-raising campaigns or meetings,
the recipient of the letter will value the personalized touch that originally typed copy provides.

4.3.3 Copiers

Because a copier is a machine that reproduces copies directly from an original document, the copies
are commonly referred to as photocopies. While some machines must be fed (the copy must be inserted into
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the machine), other machines can copy such documents as pages from books when the original is laid on
top of the machine.

The copying process, like photography, is based on the sensitivity of a surface (either in the machine
or in the copying paper or master) to light or heat radiation. The light or heat in the machine reacts with
chemicals, either in the machine or in the paper or master, to produce an image.

Dry-process copiers operate with dry chemicals only, while wet-process copiers operate with
liquid chemicals. Most copy machines today use a dry process, such as an electrostatic process or
thermography; while some older machines use a wet process, such as diffusion transfer or stabilization. The
diazo process can be either dry or wet.

4.3.4 Electrostatic Processes 

There are two common electrostatic processes: the transfer process, also known as the xerographic
process, which is used in plain-paper copiers (PPCs), and the direct image process, also known as the
Electrofax process, which is used in coated-paper copiers (CPCs). A fine black powder, called toner,
forms the image on a copy made by either electrostatic process.

4.3.5 Duplicating Processes

         The “duplication” category of reproduction includes spirit, stencil, and offset processes. Although
spirit and stencil were the most popular processes of the fifties and sixties, the seventies saw copiers taking
over. Convenience copiers became favored for low-volume duplicating, and copier-duplicators gained as
the favored duplication processes for large jobs. Stencil and offset processes, however, continue to be
economical alternatives for high-quality copy especially with the introduction of convenient tabletop models.

4.3.5.1 Spirit Duplicating 
       The spirit duplication process is also referred to as the liquid or fluid process, hectograph, Azograph,
and “ditto.” The master can be prepared by thermography, typed, written, or drawn on. The master set
contains a carbonlike covered transfer sheet which is placed face up behind the master, creating a reverse
image of the material to be reproduced. When the master is run, the image is printed directly on paper that
has been moistened with alcohol (the spirit). The paper removes a portion of the dye from the reverse image
on the master to print the correct image. The reproduced copy is usually purple, though black, blue, red,
and green master sets are available.

    Spirit duplicating is rarely used in business offices today for three reasons:

1. The copy is not as clear as that of other processes.

2. “Ditto” copies cannot be easily reproduced by copying machines because the print is not dark or sharp
enough

.3. The process is messy—dye from the transfer sheet and master is easily rubbed off on typewriters,
hands, and furniture.
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    The process, however, is economical and is therefore used by some educational institutions that want to
provide faculty and staff with a fast, economical means of duplicating. Masters are easy to prepare, and the
machine is small and easy to operate. Business use would be restricted to internal memos that would not
need to be copied further.

4.3.5.2 Stencil Duplicating 

    The stencil process, also known as mimeographing, is more versatile than the spirit process. Typically,
the master for the stencil process-is-a -wax-covered-sheet-oil fibrous material, though it may also be plastic
or metal. The master may be prepared by using any of four different methods thermography, facsimile
stencil copying, embossed plate printing, or direct cutting.A thermal stencil master is prepared by using a
thermographic machine (in the same way that a thermal spirit master is made). The facsimile stencil imager
or scanner is a separate machine, which transfers the image from an original to the stencil. Embossed plate
printing is a commercial process, though some centralized reprographics departments have this capability.

   A directly prepared stencil master is typed with a disengaged ribbon by using the stencil setting on the
typewriter. A sharp, pointed instrument called a stylus can be used to make nontypewritten images on the
master. When the master is “cut,” wax fibers are separated or opened, leaving the fiber backing intact. The
ink then flows through the fiber backing onto the paper and prints each copy. The use of different colored
ink produces black or colored print. The ink is available either in liquid or paste form, and the paper has a
rougher, more absorbent surface than that used in the spirit process.

   Because of its more simplified, cleaner operations, businesses that used the spirit duplicating process in
the past are now using stencil duplicating. Stencil duplicating, which has always been less expensive than
offset, is now also competing in quality with the newer tabletop offset duplicators.

4.3.5.3 Offset Duplicating 

   Offset machines require a trained operator because the ink and water used in the process have to be
carefully mixed and because the machine must be cleaned regularly. For these reasons, offset equipment is
usually located in a centralized reprographics department. Although offset masters can be prepared in
various ways, the two major types are• Direct imaging: Typewriting or imprinting directly on the master•
Imaging on prcwn.iitive masters; Using aluminum-based or plastic paper sensitized with a coating that
accepts a photographic image.

4.4 Micrographic
The production, handling and use of microfilm and microfiche. Images are created by cameras or

by COM units that accept computer output directly. The documents are magnified for human viewing by
readers, some of which can automatically locate a page using indexing techniques.

4.5 The Analog Advantage
Microfiche and microfilm have always been an economical alternative for high-volume data and

picture storage. Although optical discs have superseded fiche and film for most archival storage, film is still
the only medium that can survive continual upgrading of electronic technologies. Storage devices generally
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remain compatible with only one or two generations of media. At some point, new drives cannot read older
cartridges. However, film is analog and can always be read by magnifying it.

In some cases, digital data are converted to microfilm so they can be preserved and accessed
decades into the future without regard to the changing digital formats that are bound to occur over time.

4.6 History of Printing Technology
Printing was invented by the Chinese in the 6th century. The oldest book still in existence is the

scripture of the Wu Zetian (dated at approximately 684 A.D.). Although revolutionary at the time, it was
produced using very basic woodblock printing techniques. 
There are reports of earlier print works, in the form of other religious Chinese scriptures, around half a
century before, but there aren’t any surviving examples of these. 
The most ancient printed book in existence is the Chinese ‘Diamond Sutra’ (dated approximately 868 A.D.).
It was produced using a new type of printing technology of the time known as block printing.

The Chinese were also the first country to print currency. In the 10th Century they used copperplate
technology to print the first printed notes. This was to commemorate the throne in 1023 of the Song Dynasty.
Many historians believe that European printing technology derived directly from the Chinese, however,
there’s little in the way of hard evidence to support this. A German inventor, Johann Gutenberg, was the first
to bring printing technology to Europe. In 1440, he invented what is known today as the Guttenberg press.
Its design was based on a rather rudimentary wine press that used oil-based inks.

The invention of the European printing press spurred the startup of many commercial printers, resulting
in mass newspaper and book production. This revolution in the printing industry was a turning point in global
communication and the spreading of the written word. 
The 18th century gave us some noteworthy advances in printing technology. The most important being ‘relief
etching’ (invented by William Blake in 1788), and ‘lithography’ (invented by Alois Senefelder in 1798). 

During the 19th Century we saw the invention of larger-scale more robust presses, which were far faster and
more reliable. The introduction of the personal computer in the 20th century gave birth to personal printing
and advanced print technologies, such as laser printers and ink-jet printers. Commercial printing during the
20th and 21st century evolved considerably. Print shops are now able to print huge runs very quickly, using
offset printing, or offset lithography as its otherwise known.

4.7 Types of Printing Process
There are now several ways of printing that publishers could choose from. Here are some of the well-known
printing processes.

4.7.1 Offset Lithography
Famously known as Offset printing this process is considered the most cost-effective that is why

many in the industry prefer this process. This also allows publishers to print high quantity of prints in faster
time because the printing machine is very quick and easy top set up as long as plates are already available.
Basically in offset printing, the roller plates are run through water and then ink. Ink adheres to areas with
images (including texts and designs) while water on the white spaces of the layout. It is then pressed to a
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rubber plate before pressing on a paper. One of the major drawbacks of this printing process is the plate.
Once a layout is already made into a plate, omissions cannot be easily changed.

4.7.2 Letterpress
This is the original process done by Gutenberg. Although it is clearly more advanced than the original

press, the process is still the same. The image being printed is higher than the surface of the plate which will
be pressed on the paper. With the technology becoming more advance, this process is becoming less
famous and obsolete.

4.7.3 Digital Printing
I you will be printing a layout full of images you might want your prints to be of high quality so that

the images won’t get blurry. The printing process that you should do is digital printing. This process is the
most favored today because of its high quality prints and quick printing process from computer directly
to the printer. Plates are not needed on digital printing so it needs lesser man power. This process however
is expensive because of the ink and paper used by the printer. The colors can also be difficult to adjust or
predict since the colors of the image to be printed might be different on the computer monitor.

4.7.4 Engraving
Most of company letterhead and stationery are still printed using this method. The images printed

on the paper are raised or engraved creating a more defined and attractive image. This however is only used
for corporate logos or formal party invitations because it is very expensive and strenuous process.

4.7.5 Electrostatic Printing
Just like the xerography process or dry photocopying invented by Chester Carlson, electrostatic

printing invented by Georg Christoph Lichtenberg in 1778, does not need ink or plates to print. In this
process, the paper is coated with zinc oxide which acts as insulator in the dark and conductor if exposed
to light. This process is mainly used for short run printing just like geographical maps and is becoming
famous because it is prints faster than inkjet printers.

4.8 E-Publishing
4.8.1 Introduction
4.8.2History of E-Publishing
4.8.3 Characteristics of Electronic Publishing
4.8.4 Advantages of E-Publishing
4 8.5 Disadvantages of E-Publishing
4 8.6 E-publishing Models
4 8.7 General Advantages of E-journals
4.8 .8 Traditional Model
4.8 .9 The Disadvantages of the Traditional Model
4 8.10 Emergence of the E-book
4 8 .11 E-publishing and the Web Economy
4 8 .12 Self-Check Exercise
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4.8.1 Introduction
Electronic publishing (also referred to as ePublishing or digital publishing) includes the digital

publication of e-books, EPUBs, Digital Magazines (also sometimes known aselectronic articles), and the
development of digital libraries and catalogues. Electronic publishing has become common in scientific
publishing where it has been argued that peer-reviewed scientific journals are in the process of being replaced
by electronic publishing. It is also becoming common to distribute books, magazines, and newspapers to
consumers through tablet reading devices, a market that is growing by millions each year generated by
online vendors such as Apple’s iTunes bookstore, Amazon’s bookstore for Kindle, and books in the Android
Market. Market research suggests that half of all magazine and newspaper circulation will be via digital
delivery by the end of 2015 and that half of all reading in the United States will be done without paper by
2015. Although distribution via the Internet (also known as online publishing or web publishing when in the
form of a website) is nowadays strongly associated with electronic publishing, there are many non network
electronic publications such as Encyclopedias on CD and DVD, as well as technical and reference publications
relied on by mobile users and others without reliable and high speed access to a network. Electronic
publishing is also being used in the field of test-preparation in developed as well as in developing economies
for student education (thus partly replacing conventional books) - for it enables content and analytics combined
- for the benefit of students. The use of electronic publishing for textbooks may become more prevalent
with iBooks from Apple Inc. and Apple’s negotiation with the three largest textbook suppliers in the U.S.

Electronic publishing is increasingly popular in works of fiction as well as with scientific articles.
Electronic publishers are able to provide quick gratification for late-night readers, books that customers
might not be able to find in standard book retailers (erotica is especially popular in eBook formatand books
by new authors that would be unlikely to be profitable for traditional publishers.
While the term “electronic publishing” is primarily used today to refer to the current offerings of online and
web-based publishers, the term has a history of being used to describe the development of new forms of
production, distribution, and user interaction in regard to computer-based production of text and other
interactive media.

4.8.2 History of E-Publishing
The history of electronic publishing (e-publishing) is very short if compared with traditional forms of

publishing, but full of important events. The very ûrst e-publication came in the 1980s in the form of plain
text e-mails. They were sent to the subscriber via a mailing list. Of course plain text was a rather poor style
of presentation and no ûgures or pictures were available. Also tables and formulas were rather complicated
and very diûcult to handle in a proper way. In addition, users (read mainly libraries) were committed to
archiving the issues locally, thus multiplying the eûorts on all sites. This distribution path was abandoned as
soon as new tools became available in the late 1980s and early 1990s.

Later CD-ROMs appeared to be a much more eûective medium for epublishing. Excellent quality,
pictures, ûgures, low-cost support, and long life. This kind of publication was rather successful for a number
of years and, for particular publications (encyclopaedias, dictionaries, atlases, handbooks,), is still in use.
The CD-ROM has a high reliability allowing the use of many diûerent formats. However, CD-ROMs soon
became unmanageable for libraries when each CD-ROM required the installation of a special client (software
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to read the CD-ROM) for each publication. Libraries invented various tools (CD-ROM LANs) to multiply
the access and to avoid the huge maintenance work involved in installing, maintaining up-to-date, and de-
installing the clients.

Then ûnally in the years 1994–95 appeared the very ûrst e-journals. The ûrst e-journal to be distributed
was Electronics Letters Online by IEE (Institution of Electrical Engineers). IEE distributed the journal via
OCLC. OCLC invented a client, called Guidon, to be installed on the reader’s station. Guidon was an
excellent tool, with a very rich functionality, unfortunately not Web-based. It became obsolete as soon as the
Web was chosen for the distribution of e-journals. Web distribution started in 1995–96 and was an immediate
success. It was possible to use the rich format PDF, Portable Data Format, to embed links in the text and to
start to use multimedia tools. Now e-publications are already prepared for downloading into PDAs, Personal
Digital Assistants; it is a sort of e-book device already present in our pockets for other uses. A long history
in a few years.

4.8.3 Characteristics of Electronic Publishing
The aims of those publishing electronically may be very much the same as those publishing in book form

- one needs only to scan the World Wide Web for a short time to discover this fact. We can find pages of
humour as well as pages of information, and, as already noted, the Web novel is not unknown. Electronic
publishing has very specific non-book characteristics that distinguishes it from print publication:

electronic publications can be produced and disseminated very rapidly - once a page of text has
been coded with HTML tags it can be published immediately - the book takes much longer to
produce and distribute;
if correction is necessary, an electronic text can be updated or corrected with the same immediacy,
whereas a book must either go through a second edition, or, if the error is caught in time, have an
erratum slip inserted;
electronic publication can be made collaborative and interactive, involving either several “authors”
or authors and readers;
electronic publications can be disseminated world-wide without the need for separate rights
negotiations for different countries and without the costs of distribution or reprinting;
where an electronic publication is charged for, the producer does not incur the costs associated with
retail bookselling, that is, there are no “middleman” costs;
through effective, electronic interaction with the buyer or user of an electronic publication, the producer
can collect valuable market-research datavery cheaply;

 But, on the other hand:
electronic publishing still reaches only a minority of potential users or customers - even though this
minority may constitute most of the market for some products (e.g., financial business information,
scholarly communications), and much of the majority is in the developing world, where usage is
likely to be slow to emerge;
electronic publishing demands access to relatively advanced technology on the part of both the
producer and the consumer of information or entertainment - even the base level of provision is still
expensive for the ordinary citizen;
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mobile computers, notebooks and smaller, are either too big or have screens that are too small, or
otherwise inadequate, for use across the full range of environments in which a book can be read;
the technology is still, to a significant degree, user-unfriendly to many people;
the technology consumes a greater amount of energy in its use than the book;

Advantages and Disadvantages of E-Publishing

4.8.4.Electronic Publishing has many advantages:
4.4.1 Products are easy to produce and edit

4.4.2 Products can be made available immediately on the Internet

4.4.3   Content can be very rich
a) Video
b) Audio
c) Animation
d) Text
e) Graphics
f) Simulations
g) Computer Programs
h) Can utilize resources on the Internet

4.4.4. Content is easy to navigate due to hyperlinks
4.4.5. Product can be used on many devices:

a) Computer
b) Smart Phone

      c)  Tablet media players (iPad, Kindle, etc)

4.8.5 Electronic Publishing has some disadvantages:
1. A computer or other electronic device is required for use
2. Electronic media is easier to steal
a)  Securing media is possible but more expensive
b)  Consumers are more likely to pirate media than traditionally published materials
3. Sales of electronic media are weaker than traditional forms
4.   Some consumers prefer traditionally published material
a)  Technological fears
b)  Difficulties in viewing content
5. Interoperability adds new challenges
4.8.6 E-publishing Models
We can recognise today three diûerent models for e-publishing: traditional, alternative, and subversive. All
the most important publishers like Elsevier, Springer, Kluwer, IOP, APS, etc. use the traditional model.
Publishers like HighWire, the European Journal of Comparative Law, JHEP Journal of High Energy Physics,
etc. use the alternative model. The subversive model is used by other publishing initiatives like arXiv (earlier
at Los Alamos National Laboratories, now at Cornell University), Australian Journal of Human Rights, the
European Legal Research Archive, etc.
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4.8.7 General Advantages of E-journals
Before discussing in length the characteristics of the three models, it is perhaps useful to summarise the
advantages of e-journals over their previous paper editions. In addition to the fundamental feature of the
electronic availability of the full-text, there are a number of other important features that generate added
value to the e-edition. Almost all publishers oûer to subscribers to their journal e-editions some or all of
these additional services:

ETOC, electronic table of content and abstracts.
A pointer direct to the latest issue.
An alerting mechanism set to receive messages via e-mail for new articles matching a predeûne
proûle.
A pointer to the list of papers accepted for publication in future issues.
A pointer to the list of articles currently in press.

The libraries’ OPACs, On Line Public Access Catalogues, exploit these new services making all the links
available to the readers. The maintenance of these links is a challenging new task for librarians.

4.8.8 Traditional Model
Almost all publishers currently have their journals available in an electronic edition (there are more than
11,000 titles registered including scholarly ejournals) in parallel, or not, to their paper edition. The preparation
of an e-edition is very close to that of a traditional paper edition. In fact most paper editions were already
prepared in electronic form for printing. The e-editions can be distributed basically in two ways: remotely
accessible on the publishers’ servers or sent (via ground mail (on CDs or tapes) or by electronic ûle
transfer) to the library site where it can be uploaded, stored, and used locally.

This form of e-publishing is in general very well accepted because of the existence of a parallel, well-
established paper edition supported by solid quality control, peer review, and legal deposit procedures. E-
publishing technology is now sophisticated enough to oûer an excellent level of readability even on the
screen. The e-edition tends not only to parallel the paper edition but can often add its own values (colour,
multimedia, dynamic links, software distribution, etc.) using the features oûered by the network technology.
When the two editions start to diverge one can even ask if the two editions are not actually two diûerent
publications.
Several publishers were, at the beginning, afraid of having their publications electronically available because
of the ease of transferring ûles from one place to another in identical copies. So they tried to make access
diûcult and in any case solidly connected to the paper edition subscription.

It was common practice to subscribe to an e-journal contract with a threeyear rolling window. The access
was guaranteed in e-form for three years and afterwords the reader had to rely on the paper edition.
Luckily, publishers eventually became more conûdent and abandoned the concept of the rolling window
moving, at a diûerent pace and in steps, towards the idea of a ‘permanent’ e-archive of their publications.
More recently, October 2001, Elsevier announced the full electronic availability of their retrospective
collection of 1200 journals for December 2002. A giant step towards a fully electronic reader environment.
APS and IOP, among others, already reached such a result some time ago. This is an extraordinary event
for the scientiûc information world.

   4.4.11 REPROGRAPHIC TECH. AND e-PUB...



(Centre for Distance Education) (Acharya Nagarjuna University)(           )
For the publishers not yet able to make all their retrospective publications electronically available, two
diûerent projects, JSTOR in the USA and DIEPER in Europe, are ready to create the conditions to make
electronic versions of selected journals. Currently the number of titles converted is not very large but it could
increase rather quickly. As all published articles become electronically available, there are new ways to
manage them. We can consider the articles as a large database and search them via their metadata and,
recently, also via their full-text. We can also imagine moving all the articles into a large unique pot and
transforming all the references into electronic links. The reader’s environment will be enhanced at a much
better access level. This expanded linking capability can be reached using new tools made available by the
CERN Library and also by the non-proût organisation CrossRef.

The above articles’ reorganisation is called the journals’ de-structuring. This is opposed to another new
possibility called re-structuring. Re-structuring is the possibility to select and reuse the published articles in
new journals with diûerent coverage. There are now new journals totally composed of articles already
published in other journals. The new journals,
generally freely available only in electronic edition, are called overlay (or virtual) journals. In this new category
there were several announcements made by APS/AIP (four new free titles) and IOP (one new free title) in
September 2001.

4.8.9 The Disadvantages of the Traditional Model

The main disadvantages of the publications using a traditional approach to the electronic edition are the
increased costs for the libraries. At the beginning (1995–98) the e-editions were sold with the addition of
three diûerent fees to the normal price of the paper edition. The electronic content fee was a percentage (5–
15%) of the paper edition price to account for the increased value of an electronic publication. The platform
fee was a lump sum depending on the size of the library’s reader community; this sum compensated the cost
of the use of the publisher’s server and electronic facilities.

• The attrition fee was the most diûcult to understand. It was a sort of penalty for libraries with multiple paper
subscriptions to the same journal. The fee was applicable to those libraries that, acquiring a licence for the e-
edition of that journal, dared to cancel the multiple subscriptions!
In addition, publishers are not easily inclined to make discounts for those few libraries willing to buy the e-
edition only. Of course all the above costs were rather unacceptable for libraries because they were charged
with additional costs without any increase in literature coverage while maintaining all the very resource-
consuming tasks (check-in, handling, claiming, shelving, binding, re-shelving, etc.) related to the paper editions
of their journal collections.
In the last period (2000 and onwards) we have observed a substantial simpliûcation with the e-edition
subscription contracts.

Platform and attrition fees tend to disappear merging into a unique electronic content fee. The model of
platform and attrition fees should evolve in a more objective measure: real usage. They will be completely
replaced when real usage statistics are standardised. The platform fee remains in the form of the recurrent
question: “How many professional users has your library?” The attrition fee remains visible when publishers
are not ready to accept
cancellations when a library joins a consortium.
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4.8.10 Emergence of the E-book

Another form of electronic publication is the electronic book or e-book. It is necessary to distinguish between
the e-book content and the e-book device. The e-book devices are a larger form of current PDAs with
extended reading features, both hardware and software. The e-book device is not yet available in convincing,
cheap, and practical conûgurations.
The e-book content can be delivered in various forms: via the Internet, via CD-ROM or via special dispensers
in bookshops and stores. For the moment the e-book content is rapidly progressing via the Web only. The
other forms are not yet really popular.

The combination of a suitable e-book device with e-book contents should be a very interesting application
for professional books like maintenance manuals (cars, aircraft, computers), handbooks in medicine,
encyclopaedias, dictionaries, even schoolbooks. Surprisingly publishers are rather pushing for the use of e-
book devices for novels where they do not add any advantage (except, perhaps, the weight) over the
traditional printed book.

4.8.11 E-publishing and the Web Economy

We believe that e-publishing is a very interesting facet of the Web economy;
it is certainly one of the few that continues to progress even after the disappointment of the Web economy in
general. E-publishing is in a healthy situation and there are still areas to be fully investigated and plenty of
room for further progress. The beneûts oûered by e-publishing over the Web are positive for readers,
authors, and publishers. The beneûts are also enhanced by the decreasing costs in the basic services related
to the Web economy: telecommunications,
computer processing power, disk storage space, large availability of free software tools, etc.

4.8.11.1 The main beneûts generated are:
• For readers: easier and greater access, quicker delivery, enormous navigational freedom
among linked documents;
• For libraries: reduced paper processing, shelving, re-shelving, binding,
storing, risk of damage and losses;
• For publishers: enlarged audience, simpliûed editorial tasks.
It is rather challenging to express conclusions in such a shifting environment. However, our day-to-day life
spent in scientiûc libraries in dealing more and more with e-publishing and its usage, leads us to say that there
will be more emphasis on the role of pre-publishing (grey literature self-archiving).There will be a dramatic
contraction of traditional scientiûc publications available in paper editions. In the future only a few weekly
widely diûused journals will remain available, in research environments, also in a paper edition.There will be
an exponential growth of non-commercial e-publications (ejournals, e-book contents,e-proceedings)
particularly where the authors are available (large research labs) and where the e-publishing technology is
already in use.
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4.9 Self-Check Excerise
1. What is Reprography?Discuss the various methods of reprography ?

2. Discuss about e-publishing.

3. Explain e-publishing models.

4. What are the advantages & disadvantages of e-publishing?
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1.0 OBJECTIVES
After reading this Chapter, you will be able to:

 Understand the application software;

 Common types of application software packages;

 Use of software packages;

 Types of software.
1.1 INTRODUCTION

Application software is all the computer software that causes a computer to perform useful tasks
(compare with Computer viruses) beyond the running of the computer itself. A specific instance of such
software is called a software application,application or app. The term is used to contrast such software
with system software, which manages and integrates a computer’s capabilities but does not directly perform
tasks that benefit the user. The system software serves the application, which in turn serves the user.

Examples include enterprise software, accounting software, office suites, graphics software and media
players. Many application programs deal principally with documents. Applications may be bundled with the
computer and its system software or published separately, and can be coded as university projects.  Application
software applies the power of a particular computing platform or system software to a particular purpose.
Some applications are available in versions for several different platforms; others have narrower requirements
and are thus called, for example, a Geography application for Windows or an Android application
for education or Linux gaming. Sometimes a new and popular application arises which only runs on one
platform, increasing the desirability of that platform. 

1.2 What is Application Software
Computer software is the set of instructions and data that tells a computer what to do and how to do

it. Software provides instructions to your computer’s hardware. Without it, your PC or Mac would be little
more than a large paperweight. But software actually comes in three main types:system software, programming
software and application software. System software includes all the stuff that make up a computer’s operating
system (OS), including device drivers, configuration files and other key system components. This is the
software that tells the computer’s hardware what to do and provides a foundation for the system. Programming
software, or middleware, works much like the plumbing in your home by invisibly keeping things running
behind the scenes.

Application software, however, is the most important type for computer users because it is used to achieve
many of the tasks that make us turn to our computers in the first place, such as word processing, Web
browsing and data crunching.
Application software applies the power of system software. This is why when downloading software, you
have to find a version that fits with your running operating system (OS). In essence, that software draws on
the OS to create a Word document, spreadsheet or PowerPoint presentation. 
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1.3 Basics  ofApplication Software
1.3.1 Definition

An application software system is a large program which is usually designed and developed for a
specific purpose with an easy to use interface. It is intended to perform a specific task.

1.3.2 The application software Interface
The interface is usually a set of menus in a graphical environment. See figures below. An application

software consists of several components. Each components realizes various functions. Each function performs
a specific task. The components and the functions are mirrored by the application menus through the different
options that are provided to the users. As can be seen below, each item in the bar menu or a drop-down
menu may constitute a component of the application software. Consequently, each item of a drop-down
menu reflects a function that performs a specific task. All the tasks (i.e., all functions given in below figure of
the various application software systems, it is observed that the interfaces share common design in look and
content.

1.3.3 Application software Distribution and Licensing

   Application software can be obtained or distributed in different forms:

 Commerical of the shelf (COTS) or packaged software
 Shareware
 Freeware
 Public-domain software
 Customized software

   The packaged software systems or COTS are the most widely usedLarger application software
can be built from a combination of the packaged or COTS software to serve the required objectives of the
user. This allows for the creation of a customized application to satisfy a given set of requirements. Packaged
software systems are mostly commercial. In commercial software, installation in number of computers is
specified by the software vendor. User only buys the license to use it. User does not buy the software. A user
may not be allowed to install software on more than one machine. A demo version of software may exist for
free but demo version does not include all the key components of the software. Related software programs
are sometimes sold bundled together. It is called a software suite. An example is MS Office. When you
purchages MS Office license you basically purchase the right to install and use MS Word, MS Excel, Power
Point and Front Page.

The shareware software is application software that is distributed free for a trial period. It is
considered as a marketing method to introduce the software to users. In shareware, the distribution license
of the software requires a payment.

Freeware is software that is made available for use for an unlimited time at no cost. It is copyrighted.
The software license may impose one or more restrictions on the type of use. For example, restricting its use
to personal use, non-commerical use, educational use etc.
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Public-domain software is free and can be used without restrictions. It can be used, studied, and

modified without restriction. It can also be copied and redistributed in modified or unmodified form either
without restrication, or with restrictions only to ensure that end users have the same freedoms as the original
aouthors. Programs in the public domain can be used without restriction as components of other programs.

Customized software systems are created by special modification of an existing software to support
certain functions or by writing the application from scratch using a programming tool.

Examples of free application software include: Open office.org suite, Mozilla and firefox web browsers,
the GIMP graphics editor, and typesetting and documents preparation systems TeX and LaTeX.

1.4 Understand How System Software Interacts With Application Software
System software consists of programs that control the operations of a computer and its devices.

System software serves as the interface between a user, the application software, and the computer’s hardware.
One type of system software is the operating system. Before application software can be run, the operating
system, which contains instructions that coordinate the activities among computer hardware devices, must be
loaded from the hard disk into the computer’s memory.

1.5 Identify The Role of The User Interface
The user interface controls how you enter data or instructions and how information displays on the

computer screen. Many of today’s software programs have a graphical user interface. A graphical user
interface (GUI) combines text, graphics, and other visual images to make software easier to use.

1.6 How To Start A Software Application
Both the Microsoft Windows and the Apple Macintosh operating systems use the concept of a

desktop. The desktop is an on-screen work area with common graphical elements such as icons, buttons,
menus, links, windows, and dialog boxes. A software application can be started by clicking its program name
on a menu, or list of commands. Clicking the program name instructs the operating system to transfer the
program’s instructions from a storage medium into memory. Once started, the application displays in a window
on the desktop. A window is a rectangular area of the screen that is used to show the program, data, and/or
information. At the top of the window is a title bar that contains the window’s name.

1.7 Identify The Widely Used Products And Explain The Key Features Of 
 Productivity/business software applications

 Graphic design/multimedia software applications

 Home/personal/educational software applications

 Communications software applications
People use productivity software to become more effective and efficient while performing daily

activities. Word processing software allows users to create and manipulate documents that contain text and
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graphics. With word processing software, you can insert  clip art into a document;
change margins; find and replace text; use a spelling checker to check spelling; place
a header and footer at the top and the bottom of a page; and vary font (character design), font size (character
scale), and font style (character appearance).

With spreadsheet software, data is organized in rows and columns, which collectively are called
a worksheet. The intersection of a row and column, called a cell, can contain a label (text), a value(number),
or a formula or function that performs calculations on the data and displays the result.

Database software allows you to create and manage a database. A database is a collection of
data organized to allow access, retrieval, and use of that data. A query is used to retrieve data according to
specified criteria, which are restrictions the data must meet.
Presentation graphics software is used to create presentations that communicate ideas, messages, and
other information to a group through a slide show. You can use a clip gallery to enhance your presentation
with clip art images, pictures, video clips, and audio clips.

A personal information manager (PIM) is software that includes an appointment calendar to
schedule activities, an address book to maintain names and addresses, and a notepad to record ideas,
reminders, and important information. A software suite is a collection of individual applications sold as a
single package.

Project management software allows you to plan, schedule, track, and analyze the progress of a
project. Accounting software helps companies record and report their financial transactions.

Power users often use software that allows them to work with graphics and multimedia. Computer-
aided design (CAD) software assists in creating engineering, architectural, and scientific designs. Desktop
publishing (DTP) software is used to design and produce sophisticated documents. DTP is developed
specifically to support page layout, which is the process of arranging text and graphics in a document.Paint
software is used to draw graphical images with various on-screen tools. Image editing software provides
the capability to modify existing images. Video editing software and audio editing software can be used
to modify video and audio segments.

Multimedia authoring software is used to create electronic interactive presentations that can include
text, images, video, audio, and animation. Web page authoring software is designed to create Web pages and
to organize, manage, and maintain Web sites.

Many software applications are designed specifically for use at home or for personal or educational
use. Integrated software combines several productivity software applications that share a similar interface
and common features into a single package. Personal finance software is an accounting program that helps
pay bills, balance a checkbook, track income and expenses, follow investments, and evaluate financial
plans. Legal software assists in the creation of legal documents and provides legal advice. Tax preparation
software guides users through the process of filing federal taxes. 

Personal DTP software helps develop conventional documents by asking questions, presenting
predefined layouts, and supplying standard text.Photo-editing software is used to edit digital photographs.
A clip art/image gallery is a collection of clip art and photographs that can be used in all types of
documents. Home design/landscaping software assists with planning or remodeling. Educational
software teaches a particular skill and exists for about any subject. Reference software provides valuable
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and thorough information for all individuals. Entertainment software includes interactive games, videos,
and other programs designed to support a hobby or provide amusement.One of the main reasons people use
computers is to communicate and share information. E-mail software is used to create, send, receive, forward,
store, print, and delete e-mail (electronic mail).

A Web browser is a software application used to access and view Web pages. A chat client is
software that allows you to connect to a chat room, which permits users to chat via the computer.
A newsreader is a software program used to participate in a newsgroup, which is an online area on the
Web where users conduct written discussion about a particular subject. An instant messenger is a software
program installed to use instant messaging (IM), a real-time communications service that notifies you
when one or more people are online and then allows you to exchange messages or files. 

Groupware is a software application that helps groups of people on a network work together and
share information. A videoconference is a meeting between two or more geographically separated people
who use a network or the Internet to transmit audio and video data.

1.8 Identify Various Products Available As Web Applications

A Web application is a software application that exists on a Web site. To access the Web application,
you visit the Web site that offers the program. Some Web applications are free; for others, you pay for use,
service, support, or when a certain action occurs. Web-based training (WBT) is a type of CBT (computer-
based training) that uses Internet technology. Many Web sites offer WBT to the general public. An application
service provider (ASP) is a third-party organization that manages and distributes software and services on
the Web.

1.9 Describe The Learning Aids Available With Many Software Applications

Many software applications and Web sites provide learning aids. Online Help is the electronic
equivalent of a user manual. Usually integrated into an application software package, online Help often is
context-sensitive, meaning that the Help information is related to the current task being attempted. Most
online Help also provide links to Web sites that have a FAQs page. FAQs (Frequently Asked Questions)
supply answers to common queries. Many books are available to help you learn to use the features of a
personal computer application package. A wizard is an automated assistant that helps complete a task by
asking questions and then performing actions based on the answers.

1. 10 Types of Application Software
1.10.1 Classification of Application Software

Appliation software are classified according to their application domains. Applications that are used
in business  or developed for specific business applications are termed, business software application. Examples
of such applications include banking software systems, financing software systems such as those that are used
to manage the stock market, word processing, account. Other application areas include communications,
multimedia and graphics, education, home and personal uses. Below gien table lists of examples of various
software applications  in different domains. There are several application software for each domain listed in
the table and many more.
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Business      Communication   Home Uses     Education           Multimedia           Personal Uses

Financial E-mail             Home design     Course                 Audio/Video       Database

Accounting Chatting Decoration Persenation          Web Authoring    Spreadsheet

Word ----.

Presentation Telnet  ----    Browsers

Spreadsheet News group  --- Tutorial ---    Web Publishing

Databases Messaging -- -- --    --

-- -- -- --   --

-- -- -- --    --

1.10.2 Installed software and Web-based Software
Software application can also be differentiated as installed software and web-based. Installed

software are those that you buy from the market or download from the Internet to your computer. The
software is physically installed in your computer and runs from your Hard Drive. Usually these kinds of
software come inside a CD case.

Examples are Microsoft Office. On the other hand, Web-based software are run from the Internet.
Examples are virus protection and some shareware software that you download from Internet.

Application Software :MS Office  5.1.7

   Editing

Graphics

& Graphics

Processing Desktop PublishingFTP     Computer Aided
  Instructions (CAI)

Banking         Web Browsers    Landscaping        Course            Painting    Word Processing

Desktop
Publishing

ComputerAied
Instructions (CAL)

Computer Aied
Design(CAD)

Personal info
Manager

Project
Management

 Management



(Centre for Distance Education) (Acharya Nagarjuna University)(           )  5.1.8

          Application Software                               popular Programs                                 Domains of Applications

Word Processing                Microsoft Office Word, Business, home, personal
                                                                   Corel WordPerfect

Spreadsheet               Microsoft Office Excel Business, home, personal
                                                                    Corel Quattro Pro

 Desktop Publishing               Adobe InDesign                                              Business,Home, personal
                                                                  Adobe PageMaker                                           Multimedia & graphics
                                                                  Corel Ventura

Multimedia authoring                            Click2learn.com, Business, home, personal
                                                                 Toolbook Instructor                                          Multimedia & graphics
                                                                 Macromedia Authorware
                                                                 Macromedia Director

Video and audio editing                       Adobe Audition                                                Business, home, personal
                                                                  Adobe Encore DVD                                          Multimedia & graphics
                                                                  Adobe Premiere Pro

             Macromedia Sound Edit

Presentation graphics              Microsoft Office Power Point Business, home, personal Corel
                                                                  Presentations

Databases                                               Microsoft Office Access  Business, home, personal
                                                                 SQL Server , Oracle,  DB2

Communication              Internet Explorer   Communication
                                                                  Mozilla Firefox, Safari,
                                                                 OperaNetscape

             Microsoft Outlook, e/POP

 Software                                                  Microsoft Office           Business,home,personal
                                                                   Openoffice.org

              Corel WordPerfect Office
              IBM Lotus SmartSuite

Paint/image editing                                 Adobe illustrator Business, home, personal
                                                                  Adobe Photoshop  Multimedia & graphics

             Corel Corel DRAW
            Macromedia Freehand
            Corel Painter

Web  page authoring             Adobe GoLive Business, home, personal
            Adobe LiveMotion
            Macromedia Dreamweaver
            Macromedia Fireworks
            Macromedia Flash
            Microsoft Front Page
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Project management                   Microsoft Office Project Business, home, personal
                 Primavera SureTrak Project Manager

Accounting                  Intuit QuickBooks Business, home, personal
                 Peachtree Complete Accounting

Personal information                 Lotus Organizer Business, Communication
manager (PIM)                  Microsoft Office Outlook

Computer-aided design                 Autodesk AutoCAD  Business, Engineering
               Quality Plans Chief Architect

PDA software                  Microsoft Pocket Word  Mobile Computing
                  Microsoft Pocket Excel
                 Microsoft Pocket Outlook
                 Ultrasoft Money Pocket Edition

Examples of Application Software

1.11 Common types of application software

1.11.1  Word Processing

Word Processing an office application that enables user to create, edit, format and print textual document.

Figure.1 Word Processing

1.11.2  Spreadsheet

A program that processes information in the form of tables.Tables cells can hold values or mathematical

formula.

Figure.2 Spreadsheet
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1.11.3  Presentation

An application software that allows a user to create visual aid for presentation to communicate ideas, messages

and other information to a group.

Figure.3 Presentation

1.11.4  Graphics Editing

Program that can edit digital representation or non-text information such as drawing, charts and photograph.

               Figure.4 Graphics Editing

1.12 Self-Check Excerise

1. What is software?

2. Explain common types of application software.

3. Write benefits of application software.
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2.5.7 Undo Changes
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2.0 OBJECTIVE

After reading this Chapter, you will be able to:

 Understand the MS-Word;
 Basic ideas about MS-Word;
 Use of MS-Word;

 How to work in MS-Word easily.
2.1 INTRODUCTION

Microsoft Word is a word processing software application that enables you do easily create both
simple and complex documents, such as memos or reports. Microsoft Word provides tools to enable you to
check spelling of your document, create merge letters and add graphics to enhance your written information.

2.2 Getting Started

1. Screen Layout

Menus

When you begin to explore Word 2007 you will notice a new look to the menu bar. You should remember

three features as you work within Word 2007:

 The Microsoft Office Button
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 The Quick Access Toolbar

 The Ribbon
     These three features contain many of the functions that were in the menu of previous versions of Word.
The functions of these three features given below.

2.2.1 Microsoft Office Button

The Microsoft Office button performs many of the functions that were located in the File menu of
older versions of Word. This button allows you to create a new document, open an existing document, save
or save as, print, send (through email or fax), publish or close.

2.2.2 The Ribbon (formerly toolbar)

The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, Insert, Page
Layout, References, Mailings, Review, and View that contain many new and existing features of Word. Each
tab is divided into groups. The groups are logical collections of features designed to perform functions that
you will utilize in developing or editing your Word document. Commonly used features are displayed on the
Ribbon, to view additional features within each group, click on the arrow at the bottom right of each group.
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Each of the tabs contains the following tools:
Home: Clipboard, Fonts, Paragraph, Styles, and Editing. Insert: Pages, Tables, Illustrations, Links, Header
& Footer, Text, and Symbols Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange
References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and Table of Authorities
Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish Review: Proofing, Comments,
Tracking, Changes, Compare, Protect View: Document Views, Show/Hide, Zoom, Window, Macros

2.2.3 Quick access Toolbar

The quick access toolbar is a customizable toolbar that contains commands that you may want to
use. You can place the quick access toolbar above or below the ribbon. To change the location of the quick
access toolbar, click on the arrow at the end of the toolbar and click on Show Below the Ribbon.

You can also add items to the quick access toolbar. Right click on any item in the Office Button or the
Ribbon and click on Add to Quick Access Toolbar and a shortcut will be added to the Quick Access
Toolbar.
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2.3 Working with Documents
2.3.1 Creating a New Document
        There are several ways to create new documents, open existing documents, and save documents in
Word:

ÀÛƒÜ Click the Microsoft Office Button and Click New or
ÀÛƒÜ Press CTRL+N (Depress the CTRL key while pressing the “N”) on the keyboard

You will notice that when you click on the Microsoft Office Button and Click New, you have many choices
about the types of documents you can create. If you wish to start from a blank document, click Blank. If you
wish to start from a template, you can browse through your choices on the left, see the choices on center
screen, and preview the selection on the right screen.

2.3.2 Opening an Existing Document

 Click the Microsoft Office Button and Click Open, or

 Press CTRL+O (Depress the CTRL key while pressing the “O”) on the keyboard, or

  If you have recently used the document you can click the Microsoft Office Button and click the name

of the document in the Recent Documents section of the window Insert picture of recent docs

2.3.3 Saving a Document
Click the Microsoft Office Button and Click Save or Save As (remember, if you’re sending the
document to someone who does not have Office 2007, you will need to click the Office Button, click Save
As, and Click Word 97-2003 Document), or

 Press CTRL+S (Depress the CTRL key while pressing the “S”) on the keyboard, or

 Click the File icon on the Quick Access Toolbar
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2.3.4 Save As or Renaming a Document
Renaming Documents To rename a Word document while using the program:

 Click the Office Button and find the file you want to rename.
 Right-click the document name with the mouse and select Rename from the shortcut menu.
 Type the new name for the file and press the ENTER key.

2.3.5 Working on Multiple Documents
Several documents can be opened simultaneously if you are typing or editing multiple documents at

once. All open documents will be listed in the View Tab of the Ribbon when you click on Switch Windows.
The current document has a checkmark beside the file name. Select another open document to view it.

2.3.6 Document Views

There are many ways to view a document in Word.

-Print Layout: This is a view of the document, as it would appear when printed. It includes all tables,
text, graphics, and images.

-Full Screen Reading: This is a full view length view of a document. Good for viewing two pages at a

time.

-Web Layout: This is a view of the document, as it would appear in a web browser.
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-Outline: This is an outline form of the document in the form of bullets.

-Draft: This view does not display pictures or layouts, just text.
To view a document in different forms, click the document views shortcuts at the bottom of the screen or:

-Click the View Tab on the Ribbon

-Click on the appropriate document view.

2.3.7 Close a Document
To close a document:

-Click the Office Button
-Click Close

2.4 Customize Word Environment
Word 2007 offers a wide range of customizable options that allow you to make Word work the

best for you. To access these customizable options:
-Click the Office Button
-Click Word Options

2.4.1 Popular
These features allow you to personalize your work environment with language, color schemes, user

name and allow you to access the Live Preview feature. The Live Preview feature allows you to preview the
results of applying design and formatting changes without actually applying it.
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2.4.2 Display

This feature allows you to modify how the document content is displayed on the screen and when printed.
You can opt to show or hide certain page elements.

2.4.3 Proofing

This feature allows you personalize how word corrects and formats your text. You can customize auto correction

settings and have word ignore certain words or errors in a document.
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2.4.4 Save
This feature allows you personalize how your document is saved. You can specify how often you

want auto save to run and where you want the documents saved.
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2.4.5 Advanced
This feature allows you to specify options for editing, copying, pasting, displaying, printing and saving.

2.4.6 Customize
Customize allows you to add features to the Quick Access Toolbar. If there are tools that you are utilizing

frequently, you may want to add these to the Quick Access Toolbar.
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2.5 Editing a Document

2.5.1 Typhing & Inserting Text
To enter text just start typing! The text will appear where the blinking cursor is located. Move the

cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the left button. The
keyboard shortcuts listed below are also helpful when moving through the text of a document:

2.5.2 Selecting Text
To change any attributes of text it must be highlighted first. Select the text by dragging the mouse over

the desired text while keeping the left mouse button depressed, or hold down the SHIFT key on the keyboard
while using the arrow buttons to highlight the text. The following table contains shortcuts for selecting a
portion of the text:

Deselect the text by clicking anywhere outside of the selection on the page or press an arrow key
on the keyboard.

2.5.3 Inserting Additional Text
Text can be inserted in a document at any point using any of the following methods:

 Type Text: Put your cursor where you want to add the text and begin typing

 Copy and Paste Text: Highlight the text you wish to copy and right click and click Copy, put your

cursor where you want the text in the document and right click and click Paste.

 Cut and Paste Text: Highlight the text you wish to copy, right click, and click Cut, put your cursor

where you want the text in the document, right click, and click Paste.

 Drag Text: Highlight the text you wish to move, click on it and drag it to the place where you want

the text in the document.

You will notice that you can also use the Clipboard group on the Ribbon.
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2.5.4 Rearranging Blocks of Text
To rearrange text within a document, you can utilize the Clipboard Group on the Home Tab of the Ribbon.

Insert picture of clipboard group labeled

 Move text: Cut and Paste or Drag as shown above

 Copy Text: Copy and Paste as above or use the Clipboard group on the Ribbon

 Paste Text: Ctrl + V (hold down the CTRL and the “V” key at the same time) or use the Clipboard

group to Paste, Paste Special, or Paste as Hyperlink

2.5.5 Deleting Blocks of Text
Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to the
left of the cursor and Delete will erase text to the right. To delete a large selection of text, highlight it using any
of the methods outlined above and press the DELETE key.

2.5.6 Search & Replace Text
To find a particular word or phrase in a document:

 Click Find on the Editing Group on the Ribbon

 To find and replace a word or phrase in the document, click Replace on the Editing Group of the

Ribbon.
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2.5.7 Undo Changes
To undo changes:
 Click the Undo Button on the Quick Access Toolbar

2.6 Formatting Text
2.6.1 Styles

A style is a format-enhancing tool that includes font typefaces, font size, effects (bold, italics, underline,
etc.), colors and more. You will notice that on the Home Tab of the Ribbon, that you have several areas that
will control the style of your document: Font, Paragraph, and Styles.

2.6.2 Changing Fonts & Size
 Click the arrow next to the font name and choose a font.

 Remember that you can preview how the new font will look by highlighting the text, and hovering

over the new font typeface.

  5.2.15 Microsoft-Word Processing



(Centre for Distance Education) (Acharya Nagarjuna University)(           )
To change the font size:

 Click the arrow next to the font size and choose the appropriate size, or

 Click the increase or decrease font size buttons.

2.6.3 Font Styles & Effects
Font styles are predefined formatting options that are used to emphasize text. They include: Bold, Italic, and
Underline. To add these to text:
 Select the text and click the Font Styles included on the Font Group of the Ribbon, or

 Select the text and right click to display the font tools

Change Text Color To change the text color:

 Select the text and click the Colors button included on the Font Group of the Ribbon, or

 Highlight the text, right click, and choose the colors tool.

 Select the color by clicking the down arrow next to the font color button.

2.6.4 Highlight Text
Highlighting text allows you to use emphasize text as you would if you had a marker. To highlight text:
 Select the text

 Click the Highlight Button on the Font Group of the Ribbon, or

 Select the text and right click and select the highlight tool
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 To change the color of the highlighter click on down arrow next to the highlight button.

2.6.5 Copy Formatting
If you have already formatted text the way you want it and would like another portion of the document

to have the same formatting, you can copy the formatting. To copy the formatting, do the following:

 Select the text with the formatting you want to copy.
 Copy the format of the text selected by clicking the Format Painter button on the Clipboard Group

of the Home Tab
 Apply the copied format by selecting the text and clicking on it.

2.6.6 Clear Formatting
To clear text formatting:

Select the text you wish to clear the formatting
Click the Styles dialogue box on the Styles Group on the Home Tab

Click Clear All
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2.7 Formatting Paragraphs
Formatting paragraphs allows you to change the look of the overall document. You can access many

of the tools of paragraph formatting by clicking the Page Layout Tab of the Ribbon or the Paragraph Group
on the Home Tab of the Ribbon.
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2.7.1 Change Paragraph Alignment
Change Paragraph Alignment The paragraph alignment allows you to set how you want text to appear. To

change the alignment:

 Click the Home Tab

Choose the appropriate button for alignment on the Paragraph Group.

 Align Left: the text is aligned with your left margin

 Center: The text is centered within your margins

 Align Right: Aligns text with the right margin

 Justify: Aligns text to both the left and right margins.

2.7.2 Indent Paragraph
Indenting paragraphs allows you set text within a paragraph at different margins. There are several

options for indenting:
 First Line: Controls the left boundary for the first line of a paragraph
 Hanging: Controls the left boundary of every line in a paragraph except the first one
 Left: Controls the left boundary for every line in a paragraph
 Right: Controls the right boundary for every line in a paragraph

To indent paragraphs, you can do the following:
 Click the Indent buttons to control the indent.
 Click the Indent button repeated times to increase the size of the indent.

 Click the dialog box of the Paragraph Group
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 Click the Indents and Spacing Tab

 Select your indents

2.7.3 Add Boarders & Shading
You can add borders and shading to paragraphs and entire pages. To create a border around a

paragraph or paragraphs:
 Select the area of text where you want the border or shading.
 Click the Borders Button on the Paragraph Group on the Home Tab
 Choose the Border and Shading
 Choose the appropriate options

2.7.4 Apply Style
Styles are a present collection of formatting that you can apply to text. To utilize Quick Styles:
 Select the text you wish to format.
 Click the dialog box next to the Styles Group on the Home Tab.
 Click the style you wish to apply.
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2.7.5 Create Links
Creating links in a word document allows you to put in a URL that readers can click on to visit a web page.

To insert a link:

 Click the Hyperlink Button on the Links Group of the Insert Tab.
 Type in the text in the “Text to Display” box and the web address in the “Address” box.

2.7.6 Change Spacing Between Lines & paragraphs
You can change the space between lines and paragraphs by doing the following:
 Select the paragraph or paragraphs you wish to change.
 On the Home Tab, Click the Paragraph Dialog Box
 Click the Indents and Spacing Tab
 In the Spacing section, adjust your spacing accordingly
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2.8 Styles
The use of Styles in Word will allow you to quickly format a document with a consistent and professional

look. Styles can be saved for use in many documents.

2.8.1 Apply a Style
There are many styles that are already in Word ready for you to use. To view the available styles click

the Styles dialog box on the Styles Group in the Home Tab. To apply a style:
 Select the text
 Click the Styles Dialog Box
 Click the Style you choose

2.8.2 Create New Styles
You can create styles for formatting that you use regularly. There are two ways to do this: New

Styles or New Quick Styles.
New Styles To create a new style:
 Click the Styles Dialog Box

 Click the New Style Button

 Complete the New Style dialog box.
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 At the bottom of that dialog box, you can choose to add this to the Quick Style List or to make it

available only in this document.

New Quick Style To create a style easily:
 Insert your cursor anywhere in the chosen style

 Click the Styles dialog box

 Click Save Selection as New Quick Style

2.8.3 Style Inspector
To determine the style of a particular section of a document:
 Insert cursor anywhere in the text that you want to explain the style
 Click the Styles Drop Down Menu
 Click the Style Inspector Button
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2.9 Adding Tables
Tables are used to display data in a table format.

2.9.1 Create a New Table
To create a table:
Place the cursor on the page where you want the new table
 Click the Insert Tab of the Ribbon
 Click the Tables Button on the Tables Group. You can create a table one of four ways:
 Highlight the number of row and columns
 Click Insert Table and enter the number of rows and columns
 Click the Draw Table, create your table by clicking and entering the rows and columns
 Click Quick Tables and choose a table

2.9.2 Enter Data in Table
Place the cursor in the cell where you wish to enter the information. Begin typing.
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2.9.3 Modify Table Structure
To modify the structure of a table:
 Click the table and notice that you have two new tabs on the Ribbon: Design and Layout.

These pertain to the table design and layout.

On the Design Tab, you can choose:
 Table Style Options
 Table Styles
 Draw Borders

2.9.4 Format a Table
To format a table, click the table and then click the Layout Tab on the Ribbon. This Layout tab allows you
to:
 View Gridlines and Properties (from the Table Group)
 Insert Rows and Columns (from the Rows & Columns Group)
 Delete the Table, Rows and/or Columns (from the Rows & Columns Group)
 Merge or Split Cells (from the Merge Group)
 Increase and Decrease cell size (Cell Size Group)
 Align text within the cells and change text directions (Alignment Group)

2.10 Graphics
Word 2007 allows you to insert special characters, symbols, pictures, illustrations, and watermarks.
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2.10.1 Symbols & Characters
Special characters are punctuation, spacing, or typographical characters that are not generally available on
the standard keyboard. To insert symbols and special characters:
 Place your cursor in the document where you want the symbol
 Click the Insert Tab on the Ribbon
 Click the Symbol button on the Symbols Group
 Choose the appropriate symbol.

2.10.2 Equations
Word 2007 also allows you to insert mathematical equations. To access the mathematical equations

tool:
 Place your cursor in the document where you want the symbol
 Click the Insert Tab on the Ribbon
 Click the Equation Button on the Symbols Group
 Choose the appropriate equation and structure or click Insert New Equation

 To edit the equation click the equation and the Design Tab will be available in the Ribbon
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2.10.3 Illustrations, Pictures & Smart Art

Word 2007 allows you to insert illustrations and pictures into a document. To insert illustrations:
 Place your cursor in the document where you want the illustration/picture
 Click the Insert Tab on the Ribbon
 Click the Clip Art Button
 The dialog box will open on the screen and you can search for clip art.
 Choose the illustration you wish to include

To insert a picture:
 Place your cursor in the document where you want the illustration/picture
 Click the Insert Tab on the Ribbon
 Click the Picture Button
 Browse to the picture you wish to include
 Click the Picture
 Click Insert
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Smart Art is a collection of graphics you can utilize to organize information within your document. It includes
timelines, processes, or workflow. To insert Smart Art
 Place your cursor in the document where you want the illustration/picture
 Click the Insert Tab on the Ribbon
 Click the Smart Art button
 Click the Smart Art you wish to include in your document
 Click the arrow on the left side of the graphic to insert text or type the text in the graphic.

Resize Graphics
All graphics can be resized by clicking the image and clicking one corner of the image and dragging the cursor
to the size you want the picture.

2.10.4 Watermarks
A watermark is a translucent image that appears behind the primary text in a document. To insert a watermark:
 Click the Page Layout Tab in the Ribbon
 Click the Watermark Button in the Page Background Group
 Click the Watermark you want for the document or click Custom Watermark and create your

own watermark
 To remove a watermark, follow the steps above, but click Remove Watermark
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2.11 Proofing a Document
There are many features to help you proofread your document. These include: Spelling and Grammar,

Thesaurus, AutoCorrect, Default Dictionary, and Word Count.
2.11.1 Spelling & Grammar
To check the spelling and grammar of a document
 Place the cursor at the beginning of the document or the beginning of the section that you want to

check
 Click the Review Tab on the Ribbon
 Click Spelling & Grammar on the Proofing Group.

 Any errors will display a dialog box that allows you to choose a more appropriate spelling or phrasing
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If you wish to check the spelling of an individual word, you can right click any word that has been

underlined by Word and choose a substitution.

2.11.2 Thesaurus
The Thesaurus allows you to view synonyms. To use the thesaurus:
 Click the Review Tab of the Ribbon
 Click the Thesaurus Button on the Proofing Group.
 The thesaurus tool will appear on the right side of the screen and you can view word options.

You can also access the thesaurus by right-clicking any word and choosing Synonyms on the menu.
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2.11.3 Customize AutoCorrect
You can set up the AutoCorrect tool in Word to retain certain text the way it is. To customize AutoCorrect:
 Click the Microsoft Office button
 Click the Word Options Button
 Click the Proofing tab
 Click AutoCorrect Options button

 On the AutoCorrect Tab, you can specify words you want to replace as you type

2.11.4 Create New Default Dictionary
Often you will have business or educational jargon that may not be recognized by the spelling and/or grammar
check in Word. You can customize the dictionary to recognize these words.
 Click the Microsoft Office button
 Click the Word Options Button
 Click the Proofing tab
 Click the When Correcting Spelling tab
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 Click Custom Dictionaries

 Click Edit Word List
 Type in any words that you may use that are not recognized by the current dictionary.

2.11.5 Check Word Count
To check the word count in Word 2007 look at the bottom left corner of the screen. It will give you a total
word count or if you have text highlighted it will tell you how many words are highlighted out of the total.
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2.12 Page Formatting
The page margins can be modified through the following steps:

-Click the Page Layout Tab on the Ribbon
-On the Page Setup Group, Click Margins
-Click a Default Margin, or
-Click Custom Margins and complete the dialog box.

2.12.1 Page Margins & Orientation
To change the Orientation, Size of the Page, or Columns:

-Click the Page Layout Tab on the Ribbon
-On the Page Setup Group, Click the Orientation, Size, or Columns drop down menus
-Click the appropriate choice

2.12.2 Apply Page Boarder & Color
To apply a page border or color:

-Click the Page Layout Tab on the Ribbon
-On the Page Background Group, click the Page Colors or Page Borders drop down menus
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2.12.3 Insert Headers & Footers

To insert Header and Footer information such as page numbers, date, or title, first, decide if you want
the information in the header (at the top of the page) or in the Footer (at the bottom of the page), then:

-Click the Insert Tab on the Ribbon
-Click Header or Footer
-Choose a style

-The Header/Footer Design Tab will display on the Ribbon
-Choose the information that you would like to have in the header or footer (date, time, page numbers,

etc.) or type in the information you would like to have in the header or footer

2.12.4 Create Page Break
To insert a page break:

-Click the Page Layout Tab on the Ribbon
-On the Page Setup Group, click the Breaks Drop Down Menu
-Click Page Break

2.12.5 Insert a Cover Page

To insert a cover page:
-Click the Insert Tab on the Ribbon
-Click the Cover Page Button on the Pages Group
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-Choose a style for the cover page

2.12.6 Insert Blank Page
  To insert a blank page:

-Click the Insert Tab on the Ribbon
-Click the Blank Page Button on the Page Group

2.13 Macros
Macros are advanced features that can speed up editing or formatting you may perform often in a

Word document. They record sequences of menu selections that you choose so that a series of actions can be
completed in one-step.

2.13.1 Recording a Macro
To record a Macro:

-Click the View Tab on the Ribbon
-Click Macros
-Click Record Macro
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2.13.2 Running a Macro
Running a macro depends on whether it has been added to the Quick Access Toolbar or if it has been given
a Keyboard Shortcut.

  - To run a Macro from the Quick Access Toolbar, simply click the Macro Icon
   - To run a Macro from the Keyboard shortcut, simply press the keys that you have programmed to

run the Macro.

2.14 Table of Contents
The easiest way to create a Table of Contents is to utilize the Heading Styles that you want to

include in the Table of Contents. For example: Heading 1, Heading 2, etc. based on the content of your
document. When you add or delete headings from your document, Word updates your Table of Contents.
Word also updates the page number in the table of contents when information in the document is added or
deleted. When you create a Table of Contents, the first thing you want to do is mark the entries in your
document. The Table of Contents is formatted based on levels of headings. Level 1 will include any text
identified with the style Heading 1.

2.14.1 Mark TOC Entries
You can mark the Table of Contents entries in one of two ways: by using built-in heading styles or by

marking individual text entries.

To Use Built-In Heading Styles
- Select the text that you wish to be the heading
- Click the Home Tab
- In the Styles Group, click Heading 1 (or the appropriate heading)
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- If you don’t see the style you want, click the arrow to expand the Quick Styles Gallery
- If the style you want does not appear click Save Selection as New Quick Style

To Mark Individual Entries:
- Select the text you wish to make a heading
- Click the References Tab
- Click Add Text in the Table of Contents Group

     - Click the Level that you want to label your selection

2.14.2 Create a Table of Contents
To create the table of contents:

- Put your cursor in the document where you want the Table of Contents
-Ü Click the References Tab
- Click the Table of Contents button
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2.14.3 Update a Table of Contents
If you have added or removed headings or other table of contents entries you can update by:

- Apply headings or mark individual entries as directed above
- Click the References Tab in the Ribbon
- Click Update Table

2.14.4 Delete a Table of Contents
To delete a table of contents:

- Click the References Tab on the Ribbon
- Click Table of Contents
- Click Remove Table of Contents
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2.15 Creating a Web Page
Simple web pages can be created in Word using the Save as Feature. In a web document, you can

insert pictures and hyperlinks. To view the document as you would a web page:
- Click the View Tab on the Ribbon
- Click the Web Layout Button in the Document Views Group

2.15.1 Entering Text
To enter text into the document, simply begin typing. If you want to adjust the layout of the page and

text, you should use tables to format the page properly.

2.15.2 Hyperlinks
Hyperlinks, or links, allow the reader to click on text and go to another web site. To create a hyperlink:

- Select the text that will be the link
- Click the Insert Tab of the Ribbon
- Click the Hyperlink Button on the Links Group
- Type in the web address, or URL, of the link
- Click OK
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2.15.3 Saving Web Pages
To save a web page:

- Click the Office Button
- Move the cursor over Save As
  Click Other Formats

 Under Save as Type, click Web Page
 Type in the name of the document (without spaces)

2.16 Lists
Lists allow you to format and organize text with numbers, bullets, or in an outline.

2.16.1 Bulleted & Numbered Lists
Bulleted lists have bullet points, numbered lists have numbers, and outline lists combine numbers and

letters depending on the organization of the list.
To add a list to existing text:

- Select the text you wish to make a list
- From the Paragraph Group on the Home Tab, Click the Bulleted or Numbered Lists button
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To create a new list:
- Place your cursor where you want the list in the document
- Click the Bulleted or Numbered Lists button
- Begin typing

2.16.2 Nested Lists
A nested list is list with several levels of indented text. To create a nested list:

- Create your list following the directions above
- Click the Increase or Decrease Indent button

2.16.3 Formatting Lists
  The bullet image and numbering format can be changed by using the Bullets or Numbering dialog box.

- Select the entire list to change all the bullets or numbers, or Place the cursor on one line within the list to
change a single bullet

- Right click
- Click the arrow next to the bulleted or numbered list and choose a bullet or numbering style.

2.17 Track Changes
Track Changes is a great feature of Word that allows you to see what changes have been made to a

document. The tools for track changes are found on the Reviewing tab of the Ribbon.

   5.2.41 Microsoft-Word Processing



(Centre for Distance Education) (Acharya Nagarjuna University)(           )

2.17.1 Begin Track Changes
To keep track of the changes you will be making to a document, you must click on Track Changes

icon. To start Tracking Changes:
- Click Review Tab on the Ribbon
- Click Track Changes
- Make the changes to your document and you will see any changes you have made.

2.17.2 Document View
  There are four ways to view a document after you have tracked changes:

- Final Showing Markup: This shows the document with the changes displayed
- Final: This shows the changed document, without the changes displayed
- Original Showing Markup: The original document with the changes displayed
- Original: The original document without any changes.

 To change the view, click the appropriate choice in the Tracking Group of the Review Tab on the Ribbon.

The Show Markup feature allows you to view different items (comments, formatting, etc.) and
choose to view different authors’ comments.
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2.17.3 Accept or Reject Changes
When you view the changes in a document you can choose to either accept or reject the changes.

This allows you to review the document by each change to accept or reject each change.

2.17.4 Comments
The New Comments icon also lets you add comments to the document. To add a new comment, put your
cursor where you would like to add the comment and click on New Comment.

2.18   Self-Check Exercise
1. Crate a word document.

2.19  REFERENCES
1. http://www.microsft.com

2. http://it.hms.harvard.edu/pg.asp?pn=software_word
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3.0 OBJECTIVES
After reading this Chapter, you will be able to:
 Understand the MS-Excel;
 Basic ideas about Excel;
 Use of Excel;
 Preparing quick & effective Calcultion by using excel.

3.1 INTRODUCTION
Microsoft Excel is one of the most popular spreadsheet applications that helps you manage data,

create visually persuasive charts, and thought provoking graphs. Excel is supported by both Mac and PC
platforms. Microsoft Excel can also be used to balance a checkbook, create an expense report, build formulas,
and edit them.

3.2 Creating a New Document

Opening microsoft excel on a pc
To begin Microsoft Excel, Go to Start > All Programs > Applications > Microsoft Office >

Microsoft Excel (Figure 1). When opened a new spreadsheet will pop up on the screen, if this does not
happen click on the Office Icon > New. From here a dialog box with various different templates will appear
on the screen that you can choose from. Once a template is chosen, click Create.
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3.3 Saving your Documents
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3.3.1 Saving Later
After you have initially saved your blank document under a new name, you canbegin your project.

However, you will still want to periodically save your work asinsurance against a computer freeze or a power
outage. To save, just click on thefloppy disk, or for a shortcut press CTRL + S.

3.4 Toolbars
In Microsoft Excel 2007 for a PC, the toolbars are automatically placed as tabs at thetop of the

screen. Within these tabs you will find all of your options to change text,data, page layout, and more. To be
able access all of the certain toolbars you need toclick on a certain tab that is located towards the top of the
screen.

3.4.1 Three commonly used tabs
The Home Tab: This is one of the most common tabs used in Excel. Youare able to format the text in

your document, cut, copy, and paste information.Change the alignment of your data, insert, delete, and
format cells. The Home Tabalso allows you to change the number of your data (i.e. currency, time, date).

The Insert Tab: This tab is mainly used for inserting visuals and graphicsinto your document. There
are various different things that can be inserted fromthis tab such as pictures, clip art, charts, links, headers
and footers, and word art.
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The Page Layout Tab: Here you are able to add margins, themes to yourdocument, change the

orientation, page breaks, and titles. The scale fit of yourdocument is also included as a feature within this tab,
if needed.

3.5 Formatting
3.5.1 Working with cells

Cells are an important part of any project being used in Microsoft Excel. Cells holdall of the data
that is being used to create the spreadsheet or workbook. To enterdata into a cell you simply click once inside
of the desired cell, a black border willappear around the cell.  This border indicates that it is a selected cell.
Youmay then begin typing in the data for that cell.Entering Data.

3.5.2 Changing an entry within a cell
You may change an entry within a cell two different ways:

-Click the cell one time and begin typing. The new information will replaceany information
that was previously entered.
-Double click the cell and a cursor will appear inside. This allows you to editcertain pieces of
information within the cells instead of replacing all of thedata.

3.5.3 Cut, copy, and paste
You can use the Cut, Copy and Paste features of Excel to change the data withinyour spreadsheet,

to move data from other spreadsheets into new spreadsheets, andto save yourself the time of re entering
information in a spreadsheet. Cutwillactually remove the selection from the original location and allow it to be
placedsomewhere else. Copy allows you to leave the original selection where it is andinsert a copy elsewhere.
Paste is used to insert data that has been cut or copied.

3.5.4 To Cut or Copy:
Highlight the data or text by selecting the cells that they are held within.Go to the Home Tab > Copy

(CTRL + C) or Home Tab > Cut (CTRL + X).Click the location where the information should be placed.Go
to Home Tab > Paste (CTRL + V) to be able to paste your information.

3.5.5 Formatting cells
There are various different options that can be changed to format the spreadsheetscells differently. When
changing the format within cells you must select the cellsthat you wish to format.
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To get to the Format Cells dialog box select the cells you wish to change then go toome Tab >
Format > Format Cells. A box will appear on the screen with sixdifferent tab options. Explanations of the
basic options in the formatdialog box are bulleted below.

Number: Allows you to change the measurement in which your data is used. (Ifyour data is concerned with
money the number that you would use is currency)Alignment: This allows you to change the horizontal and
vertical alignment of yourtext within each cell. You can also change the orientation of the text within the
cellsand the control of the text within the cells as well.

Font: Gives the option to change the size, style, color, and effects.
Border: Gives the option to change the design of the border around or through thecells.

3.5.6 Formatting rows and columns
When formatting rows and columns you can change the height, choose for yourinformation to autofit

to the cells, hide information within a row or column, unhidethe information. To format a row or column go to
Home Tab > Row Height (orColumn Height), then choose which height you are going to use. The cellor
cells that are going to be formatted need to be selected before doing this. Whenchanging the row or column
visibility (hidden, unhidden) or autofit, you will go tothe Home Tab and click Format. The drop down menu
will show these options.
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3.5.7 Adding rows and columns
When adding a row or column you are inserting a blank row or column next to youralready entered data.
Before you can add a Row you are going to have to select therow that you wish for your new row to be
placed. (Rows are on the left hand side ofthe spreadsheet) once the row is selected it is going to highlight the
entire row thatyou chose. To insert the row you have to go to Home Tab > Insert > Insert SheetRows.
The row will automatically be placed on the spreadsheet and anydata that was selected in the original row will
be moved down below the new row.
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Before you can add a Column you are going to have to select a column on thespreadsheet that is
located in the area that you want to enter the new column.(Columns are on the top part of the spreadsheet.)
Once the column is selected it isgoing to highlight the entire row that you chose. To insert a column you have
to goto Home Tab > Insert > Insert Sheet Column. The column willautomatically be place on the
spreadsheet and any data to the right of the newcolumn will be moved more to the right.

3.5.8 Working with charts
Charts are an important part to being able to create a visual for spreadsheet data. Inorder to create

a chart within Excel the data that is going to be used for it needs tobe entered already into the spreadsheet
document. Once the data is entered, thecells that are going to be used for the chart need to be highlighted so
that thesoftware knows what to include. Next, click on the Insert Tab that is located at thetop of the screen.

You may choose the chart that is desired by clicking the category of the chart youwill use. Once the
category is chosen the charts will appear as small graphics withina drop down menu. To choose a particular
chart just click on its icon and it will beplaced within the spreadsheet you are working on.

To move the chart to a page of itsown, select the border of the chart and Right Click. This will bring
up a drop downmenu, navigate to the option that says Move Chart. This will bring up a dialog boxthat says
Chart Location. From here you will need to select the circle next to As ANew Sheet and name the sheet
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that will hold your chart. The chart will pop uplarger in a separate sheet, but in the same workbook as your
entereddata.

3.5.9 Chart design

There are various different features that you can change to make your chart moreappealing. To be
able to make these changes you will need to have the chart selectedor be viewing the chart page that is within
your workbook. Once you have done thatthe Design Tab will appear highlighted with various different
options to formatyour graphic.
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3.5.10 Chart Options:
Titles: To add titles to a chart of graphic you have to click on the Insert Tab. Onceyou have done

this, click on the Text Box Icon. This will insert a text box that you cantype the title and place anywhere you
wish on the chart.

Change Chart Type:You can change your chart easily by selecting this icon andnavigating to a more desirable
chart. This feature is very convenient for someonewho chose the wrong chart and doesn’t wish to reselect all
their data and go throughthe process a second time.

Format Chart Area:This allows for changes to be made to the chards border, style,fill, shadows, and more.
To get this option you will need to right click on the chartsborder and navigate to the Format Chart Area
option. Once this is clicked a dialogbox will appear.

Chart Style:
Here you are able to change the color of the bars that are within your chart.

3.6 Inserting Smart Art Grahpics

3.6.1 Insert Pictures
To insert Pictures:

Go to the Insert Tab> Picture, a dialog box will appear and then you can select thedesired picture
from the location that is it stored. The picture will beinserted directly onto your document, where you can
change the size of it as desired.
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3.6.2 Inserting Clipart:
To insert Clip Art you will need to go to the Insert Tab > Clip Art. A navigationpane will appear

on the left hand side of the screen where you can search for wordsthat pertain to the picture you are
looking for.

3.6.3 Creating Functions
When creating a function in Excel you must first have the data that you wish toperform the function

with selected. Select the cell that you wish for the calculation to be entered in (i.e.: if I wantto know the sum
of B1:B5 I will highlight cell B6 for my sum to be entered into).
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Choosing calculation cell

 Once you have done this you will need to select the Formulas Tab located atthe top of the screen.

 A list of Most Recently Used, Financial, Logical, Text, Date and Time,Math and Trig formulas
will appear. To choose one of the formulas click theicon that holds the formula you are looking for.

 Once you have clicked your formula this will display a dialog box on yourscreen.

      In this screen it lists the cells that are being calculated, the values within the cells,and the end result.
 To accept that calculation you can press OK and the result will show up in theselected cell.

3.7 Printing
It is important to always save your document before you print!

3.7.1 Printing
To print your document, go to the Office Icon > Print, select your desired settings,and then click

OK. You can also do this by using the shortcut CTRL + PTo be able to change the orientation of your page
for printing you can click on theProperties button under the option to Print then click the Layout Tab.
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3.8 Other Helpful Functions
Undo and Redo

In order to undo an action, you can click on the blue arrow icon that is pointing tothe left at the top of
the screen. To redo an action, you can click on the blue arrowicon pointing to the right. It is important to note
that not all actions are undoable,thus it is important to save before you make any major changes in your
document soyou can revert back to your saved document.
Quitting

Before you quit, it’s a good idea to save your document one final time. You will needto choose the
Office Icon and choose Exit Excel. This is better than just closing thewindow, as it insures your document
quits correctly.

3.9 Self-Check Exercise
1. Crate a excel document.

3.10 REFERENCES

1.  http://www.microsft.com
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4.0 OBJECTIVES

After reading this Chapter, you will be able to:
 Understand the MS-Power Point;
 Basic ideas about Presentation;
 Use of Power Point;
 Preparing quick & effective presentation.

4.1 INTRODUCTION TO POWERPOINT 2007
PowerPoint is a presentation software package. PowerPoint presentation consists of a number

of individual pages or “slides.” Slides may contain text, graphics, tables, movies, etc. The presentation can be
printed, displayed on a computer, and can be projected using a video projector. PowerPoint can add animation
to your texts, graphics, tables, movies, and other objects through Custom Animations. You can also add
transition (movement) between your slides.
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powerPoint 2007 has a new, intuitive user interface called the Microsoft Office Fluent User
Interface, which helps you create better presentations quicker. Additionally, PowerPoint 2007 offers new
and improved effects, themes, and layouts.

4.2  Microsoft Office Button & Quick Access Toolbar

In the upper left corner is the Microsoft Office button. When you click the button, a menu appears.
You can use the menu to create a new file, open your existing file, save a file, and print a file.

Next to the Microsoft Office button is the Quick Access toolbar. The quick access toolbar is a
customizable toolbar that contains commands.
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4.3 The Ribbon

You can use the commands to tell PowerPoint what to do. The Ribbon is located at the top of the
Powerpoint Window. At the top of the Ribbon there are several tables; clicking a table displaces serveral
replated group commands. You can click on the command buttons to issue commands or to access menus.

4.4 PowerPoint Window

Appears at the bottom of the window. The status bar displays the slide number that is currently
displayed and also the total number of slides.
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STATUS BAR

    Displays the text contained in your presentation. The slides tab displays a thumbnail of all your slides.

OUTLINE/SLIDES TABS
Splits your screen into three major sections: slides/outline tabs, the slide pane, and the note area.

The outline and slides tab are on your left side of your window. They allow you to shift between different
ways of viewing your slides.

NORMAL VIEW

    This view shows you the thumbnails of all your slides and allows you to easily add, delete, or change the
order of your slides.

SLIDE SORTER VIEW
Use the slide show view when you want to view your slides as they will look in your final presentation.

SLIDE SHOW

4.5 Saving Your Work
Saving for the First Time (Save your work frequently by saving it to a flash drive, e mail it to

yourself, or use FTP to save a copy of your PowerPoint Presentation).
-Click Microsoft Office Button
-Click Save

Renaming and Saving as an Earlier Version of PowerPoint
-Click Microsoft Office Button
-Click Save As
-Type in a Name for your presentation
-In the Save as Type box, choose PowerPoint 97 2003.
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4.6 Blank Presentation
- Click the Microsoft Office Button
-Click New
-Click Blank Presentation

4.7 Add Slide
Office Themes

-Select the slide immediately before where you want the new slide.
-Click the New Slide button on the Home tab.
-Click the slide choice that fits your material.

Duplicate Selected Slides
-Select the slide to duplicate.
-Click the New Slide button on the Home tab.
-Click Duplicate Selected Slides.
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4.8 Theme
Themes are designed that can be applied to an entire presentation that allows for consistency

throughout the presentation. You can also apply new colors to a theme.

Themes
  Click the Design tab.
 Choose one of thedisplayed Themes.

Apply Colors Themes
 Click the Colors dropdown arrow.
 Choose a color set orclick Create NewTheme Color.

Background Theme
 Click the BackgroundStyles button on the
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4.9 Adding Pictures

4.10 Adding Video and Audio
Adding video clips

-Click the Movies button on the Insert tab.
-Choose Movies from File or Movie from Clip Organizer.

Adding Audio
-Click the Audio button on the Insert tab.
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 Choose Sound from File, Sound from Clip Organizer, Play CD Audio Tract, or Record

Sound.

To add a picture:
-Click on the Insert tab.
-Click on the Picture button.
-Browse to the picture from your files
-Select the picture you want to insert in PowerPoint
-Click Insert.
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4.11 Adding Clip Art
To add clip art:
 -Click the Insert Tab.
 -Click the Clip Art button.
 -Search for the clip art using the search Clips Art dialog box.
 -Select the graphic you would like to add.
 -To move the graphic, click it and drag it to where you want it.

4.12 Adding Shape
To add Shapes:
 -Click the Insert tab.
 -Click the Shapes button.
 -Click the shape you choose.

How to Format the Shapes:
 -Click on your shape (object).
 -Click the Format tab.
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4.13  Adding SmartArt
To add SmartArt:
 -Click The Insert tab.
 -Click the SmartArt button.
 -Click the StartArt you choose.
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 -Drag it to the desired location in the slide

4.14 Create A Table
To create a table:
 -Place the cursor on the page where you want the new table.
 -Click on the Insert tab of the ribbon.
 -Click on Tables, and enter the number of rows and columns.
 -Place the cursor in the cell where you wish to enter information and begin typing.
 -Click on your table and then the Design tab to customize your tables.

4.15 Create A Chart
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To insert a chart:
 Click the Insert tab.
 Click the type of Chart you want to create.
 Insert the Data and Labels.

Edit Chart Data:
 Click on the chart
 Click Edit Data on the Design tab.
 Edit data in the spreadsheet.
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4.16 Slide Transitions

Slide Transitions are effects that are in place when you switch from one slide to the next.

To add slide transitions:
 Select the slide that you want to transition.
 Click the Animations tab.
Choose the appropriate animation or click Transition dialog box.

To add Transition Sound:
Add sound by clicking the arrow next to Transition Sound.

  5.4.14



   (Information Technology:Theory) (          )       (                                                      )

To modify transition speed:
Modify the transition speed by clicking the arrow next to Transition Speed.

4.17 Slide Animation
Slide animations are special effects that you can add to objects on a slide.

To apply animation effects:
 -Select the object you want to animate.
 -Click the Animation tab on the Ribbon.
 -Click Add Effect.
 -Choose the effect you want on your object.

To preview the animation on a slide:
 -Click the Preview button on the Animation tab.

Slide Show Options:
 -Preview the slide show from the beginning.
 -Preview the slide show from current slide.
 -Set up slide show.
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4.18 Printing
To print:
 -Click Microsoft Office Button.
 -Click Print

4.19 For More Help
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For More Help:
 -Click on the Microsoft Office PowerPoint Help button.
 -A new window will appear.
 -You can ask a question then click on search or choose one of the topics from the Browse
PowerPoint Help window.

4.20 Self-Check Exercise
1. Create a power point presentation.

References
1. http://www.microsoft.com
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